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Copyrights
The Motorola products described in this document may include copyrighted Motorola computer programs. Laws
in the United States and other countries preserve for Motorola certain exclusive rights for copyrighted computer
programs. Accordingly, any copyrighted Motorola computer programs contained in the Motorola products described
in this document may not be copied or reproduced in any manner without the express written permission of Motorola.

© 2013 Motorola Solutions, Inc. All Rights Reserved.

No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated into any language
or computer language, in any form or by any means, without the prior written permission of Motorola Solutions, Inc.

Furthermore, the purchase of Motorola products shall not be deemed to grant either directly or by implication,
estoppel or otherwise, any license under the copyrights, patents or patent applications of Motorola, except for the
normal nonexclusive, royalty-free license to use that arises by operation of law in the sale of a product.

Disclaimer

Please note that certain features, facilities, and capabilities described in this document may not be applicable to
or licensed for use on a particular system, or may be dependent upon the characteristics of a particular mobile
subscriber unit or configuration of certain parameters. Please refer to your Motorola contact for further information.

Trademarks

MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or registered
trademarks of Motorola Trademark Holdings, LLC and are used under license. All other trademarks are the property
of their respective owners.

European Union (EU) Waste of Electrical and Electronic Equipment
(WEEE) directive

The European Union's WEEE directive requires that products sold into EU countries must have the crossed out
trashbin label on the product (or the package in some cases).

As defined by the WEEE directive, this cross-out trashbin label means that customers and end-users in EU countries
should not dispose of electronic and electrical equipment or accessories in household waste.

Customers or end-users in EU countries should contact their local equipment supplier representative or service
centre for information about the waste collection system in their country.
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Service Information — EMEA
This topic contains contact details to service centers in Europe, Middle East, and Africa.

EMEA Systems Support Center (ESSC)
ESSC provides a remote Technical Support Service to help customers resolve technical issues and quickly restore
their systems. This team of highly skilled professionals is available to the customers that have current ESSC service
agreements in place. For further information and to verify if your current service agreement entitles you to benefit
from this service, contact your local customer support.

To contact ESSC, use the following EMEA Integrated Call Center details:

E-mail: ESCC.Admin@motorolasolutions.com.

Service Information — Telephone Numbers to EMEA Integrated Call Center

Country Telephone Number

Austria 01206091087

Denmark 043682114

France 0157323434

Germany 06950070204

Italy 0291483230

Lithuania 880030828

Netherlands 0202061404

Norway 24159815

Portugal 0217616160

Russia 810800228 41044 (Alternative 8108001201011)

Saudi Arabia 8008445345

South Africa 0800981900

Spain 0912754787

United Kingdom 02030277499

Other Countries +44 2030277499

EMEA Systems Component Center (ESCC)
ESCC provides a repair service for infrastructure equipment. Customers requiring a repair service should contact the
Customer Information Desk and obtain a Return Material Authorization number. Unless advised otherwise, the
equipment should then be shipped to the following address:

Motorola GmbH, European Systems Component Center, Am Borsigturm 130, 13507 Berlin, Germany

E-mail: ESCC.Admin@motorolasolutions.com.

Telephone: +49 30 66861555

Fax: +49 30 66861426
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Mon—Fri 08:00 am—06:00 pm (CET)

Parts Identification and Ordering

To get help in identification of non-referenced spare parts, contact Customer Care Organization of Motorola local
area representation.

To request replacement parts, kits and assemblies, place orders directly on Motorola local distribution organization
or through http://emeaonline.motorola.com.

EMEA Test Equipment Support

For information related to support and service of Motorola Test Equipment, contact Customer Care Organization of
Motorola local area representation or see http://emeaonline.motorola.com.

For customers in Germany, contact the Equipment Service Group in Germany:

Telephone: +49 (0) 6128 702179

Fax: +49 (0) 6128 951046

Latest Versions of Manuals

To download the latest versions of technical manuals, go to http://emeaonline.motorola.com.

Submit Your Comments

If you have any comments or would like to report a problem regarding Motorola publications, send an e-mail to
ESCC.Admin@motorolasolutions.com.
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Service Information — APAC

This topic contains contact details to service centers in Asia and Pacific region.

Technical Support

Technical support is available to assist the dealer/distributor in resolving any malfunction which may be encountered.
Initial contact should be by telephone wherever possible. When contacting Motorola Technical Support, be prepared
to provide the product model number and the serial number.

Further Assistance from Motorola

You can also contact the Customer Help Desk through the website: http://www.motorolasolutions.com/tetra. If a unit
requires further complete testing, knowledge and/or details of component level troubleshooting or service than is
customarily performed at the basic level, send the radio to a Motorola Service Center as listed in the following table:

Service Information — Telephone Numbers and Addresses of the Asia and Pacific Motorola
Centers

Country Telephone Number Address

Singapore +65-6352-6383 Motorola Solutions Singapore Pte. Ltd,

c/o Azure Engineering,

49 Jalan Pemimpin,

#03-11 APS Industrial Building,

Singapore 577203

Contact: Mareen Phua

E-mail: mareen@azure.com.sg

Enquiry: Tay Yong Hock

E-mail: yonghock.tay@motorolasolutions.com

Malaysia +603-7809-0000 Motorola Solutions Sdn. Bhd.

Level 14, Persoft Tower,

No. 68, Pesiaran Tropicana,

47410 Petaling Jaya,

Selangor Darul Ehsan,

Malaysia

Contact: Koh Tiong Eng

E-mail: A21001@motorolasolutions.com

xv
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Service Information — Telephone Numbers and Addresses of the Asia and Pacific Motorola
Centers (cont'd.)

Indonesia +62-21-3043-5239 PT. Motorola Solutions Indonesia

30th Floor, Gedung BRI II, Suite 3001,

Jl. Jend. Sudirman Kav. 44-46,

Jakarta 10210,

Indonesia

Contact: Eko Haryanto

E-mail: Eko.Haryanto@motorolasolutions.com

Thailand Tel: +662-653-220

Fax: +668-254-5922

Motorola Solutions (Thailand) Ltd.

142 Two Pacific Place Suite 2201,

3220 Sukhumvit Road,

Klongtoey,

Bangkok 10110

Contact: Nitas Vatanasupapon

E-mail: Nitas@motorolasolutions.com

India +91-9844218850 Motorola Solutions India Pvt. Ltd.

C/o Communication Test Design India Private Limited,

#4, 5 Maruthi Industrial Estate,

Rajapalya, Hoodi Village,

Bangalore - 560048,

India

Contact: K. Umamaheswari

E-mail: umamaheshwari@motorolasolutions.com

China +86-10-8473-5128 Motorola Solutions (China) Co. Ltd.

No. 1 Wang Jing East Road,

Chao Yang District,

Beijing, 100102,

P.R. China

Contact: Sophy Wang

E-mail: C18170@motorolasolutions.com
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Service Information — APAC

Service Information — Telephone Numbers and Addresses of the Asia and Pacific Motorola
Centers (cont'd.)

(Hong Kong) 852-2966-4823 Motorola Solutions Asia Pacific Ltd.

Unit 1807-1812, 18/F, Two Harbourfront,

22 Tak Fung Street,

Hunghom, Kowloon,

Hong Kong

Contact: Judy Leung

E-mail: Judy.Leung@motorolasolutions.com

Philippines Tel: +632 858-7500

Fax: +632 841-0681

Motorola Communications Philippines, Inc.

Unit 2102, One Global Place Building,

5th Ave., Bonifacio Global City,

Taguig, Philippines 1634.

Contact: Arthur Nieves

E-mail: Arthur.Nieves@motorolasolutions.com

Korea +822-3497-3649 Motorola Solutions Korea, Inc.

9th Floor, Hibrand Building,

215, Yangjae-Dong, Seocho-Gu,

Seoul, 137-924,

Korea.

Contact: KS Kwak

E-mail: r45321@motorolasolutions.com

Taiwan +886-2-8729 8000 Motorola Solutions Taiwan, Ltd.

8F, No. 9, Songgao Rd.,

Taipei 110,

Taiwan (R.O.C.)

Contact: Michael Chou

E-mail: ftpe239@motorolasolutions.com

Australia +613-9847-7725 Motorola Solutions Australia Pty. Ltd.

10 Wesley Court,

Tally Ho Business Park,

East Burwood Victoria 3151,

Australia.

Contact: Adrian Connor, E-mail: c19183@motorolaso-
lutions.com
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Piece Parts

Some replacement parts, spare parts, and/or product information can be ordered directly. If a complete Motorola part
number is assigned to the part, it is available from Motorola Radio Aftermarket and Accessory Division (AAD). If
no part number is assigned, the part is not normally available from Motorola. If a list of parts is not included, that
means that no user-serviceable parts are available for that kit or assembly.

Customer Programming Software has no capability to tune the radio. Tuning the radio can only be performed
at the factory or at the appropriate Motorola Repair Center. Component replacement can affect the radio
tuning and must only be performed by the appropriate Motorola Repair Center.

All orders for parts/information should include the complete Motorola identification number. All part orders should
be directed to your local AAD office. See your latest price pages.

Parts Identification and Ordering

Request for help in identification of non-referenced spare parts should be directed to the Customer Care Organization
of Motorola local area representation. Orders for replacement parts, kits, and assemblies should be placed directly
on Motorola local distribution organization or via Motorola Online (Extranet).
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Service Information — LACR
This topic contains contact details to service centers in Latin America and Caribbean region.

Technical Support

To request technical support, go to https://businessonline.motorola.com, Contact Us.

Some replacement parts, spare parts, and/or product information can be ordered directly. If a complete Motorola part
number is assigned to the part, it is available from Motorola. If no part number is assigned, the part is not normally
available from Motorola. If the part number is appended with an asterisk, the part is serviceable by Motorola Depot
only. If a list of parts is not included, that means that no user-serviceable parts are available for that kit or assembly.

Warranty and Repairs

Service Information— Telephone Numbers and Addresses of Latin America Radio Support Centers

Country Telephone Number Address

Colombia 571- 376-6990 MOTOROLA DE COLOMBIA SERVICE CENTRE
Torre Banco Ganadero
Carrera 7 No. 71-52
Torre B piso 13
Oficina 1301
Bogota

Mexico 5252576700 MOTOROLA DE MEXICO SERVICE CENTRE
Bosques de Alisos #125
Col. Bosques de las Lomas CP
05120 Mexico DF

Piece Parts

To order parts in Latin America and the Caribbean contact your local Motorola CGISS representative.

Service Information — Telephone Numbers and Addresses of Latin America Motorola Centers

Country Telephone Number Address

Argentina 5411-4317-5300 MOTOROLA DE ARGENTINA
Ave. del Libertador 1855
B1638BGE, Vicente Lopez
Buenos Aires

Brasil 5511-3847-668 MOTOROLA DO BRASIL LTDA.
Av. Chedid Jafet
222 Bloco D Conjuntos 11,12,21,22 E 41
Condominio Millennium Office Park
04551-065- Vila Olimpia, Sao Paulo
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Service Information — Telephone Numbers and Addresses of Latin America Motorola Centers
(cont'd.)

Country Telephone Number Address

Chile 562-338-9000 MOTOROLA CHILE Ave.
Nueva Tajamar 481
Edif. World Trade Center
Of. 1702, Torre Norte
Las Condes Santiago

Colombia 571-376-6990 MOTOROLA DE COLOMBIA, LTDA.
Carrera 7 #71-52
Torre A, Oficina 1301
Bogotá

Costa Rica 506-201-1480 MOTOROLA DE COSTA RICA
Parque Empresarial Plaza Roble
Edificio El Portico, 1er Piso
Centro de Negocios Internacional
Guachepelin, Escazu
San Jose

Ecuador 5932-264-1627 MOTOROLA DEL ECUADOR
Autopist Gral. Rumiñahui, Puente
2 Conjunto Puerta del Sol Este-Ciudad Jardin
Pasa E, Casa 65
Quito

Mexico 52-555-257-6700 MOTOROLA DE MEXICO, S.A.
Calle Bosques de Alisos #125
Col. Bosques de Las Lomas
05120 México D.F.

Peru 511-211-0700 MOTOROLA DEL PERU, S.A.
Ave. República de Panama 3535
Piso 11, San Isidro
Lima 27

USA 954-723-8959 MOTOROLA SOLUTIONS, INC.
Latin American Countries Region
789 International Parkway
Sunrise, FL 33325

Venezuela 58212-901-4600 MOTOROLA DE LOS ANDES C.A.
Ave. Francisco de Miranda
Centro Lido, Torre A
Piso 15, El Rosal
Caracas, 1060

xx



1 Product Overview

1.1 MTM800 Enhanced Overview
Discerning professionals demand high-quality voice communications with fast access to mobile applications. The
MTM800 Enhanced delivers on both, with SDS, Multi-Slot Packet Data and WAP options.

Figure 1-1 MTM800 Enhanced

Developed for organizations where rugged and versatile mobile terminals are essential, Motorola MTM800 Enhanced
is ideal for use where the application, location and/or circumstances demand fast, reliable, no-nonsense solutions.

• Ease-of-operation in the most demanding situations – unsurpassed audio quality, intuitive keypad, and
high-definition, color display combined with a sleek yet durable design.

• Dust and water resistant to IP 54. rain, salt, fog, and dust protection tested to MIL 810 C/D/E/F for the
standard control head.

• Motorcycle control head rated IP67 for dust and water resistance

The MTM800 Enhanced also supports the full suite of TETRA security functions, including air interface encryption,
and End-to-End encryption. Users can request assistance by simply hitting the emergency button, which not only
alerts colleagues to critical situations, but also sends an update dispatch on the user location. The radio is able to
switch to covert mode at a press of a button. The radio has an integrated GPS receiver that enables users to locate
their mobiles, and provides location-based services and mapping capabilities.

The radio offers various installation possibilities from typical Dashboard installation to Dual Control Head
installation using an additional junction box. Currently the following options are supported:

• Trunnion Installation

• Dashboard Installation

• Desktop Installation

• Remote Mount Installation

• Motorcycle Installation

• Dual Control Head Installation

• Data Box Radio Installation
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1.1.1 Specification
Table 1-1 General Technical Specification

Parameter Value
Dimensions HxWxD mm 125 x 50 x 37.5 (radio only)

60 x 185 x 175 (with Next Generation Control Head)

Weight g 1350 radio only

1470 with Next Generation Control Head

Talkgroups - TMO 4000 Entries (up to 2048 entries in one folder)

2048 Unique entries

Talkgroups - DMO 1024 Entries

Folders - TMO 256

Folders - DMO 128

Favorite Groups 384 (3 Favorite Groups folders containing up to 128 entries each)

Contact List 1000 Contacts

up to six entries (numbers) per contact

Max. 2000 entries

Text Message List 100 Short and 20 Long Messages for Outbox

100 Short and 10 Long Messages for Inbox

Status List 400 Entries

Country Code/Network Code List 100 Entries

Scan List 40 Lists of 20 Groups

Operating Temperature °C -30 to +60

Storage Temperature °C -40 to +85

Humidity ETS 300 019-1-5 Class 5.1 and 5.2, up to 95% R.H.@50 0C EIA/TIA
603 (95%) MIL810 95% RH 50 deg.

Dust & Water IP54 (dust - cat. 1) for Next Generation Control Head

IP67 (dust - cat. 1) for Motorcycle Next Generation Control Head

Shock (Mechanical), Drop &
Vibration

ETS 300019-1-5 class 5M2 and class 5M3

MIL 810 C - F

Thermal Shock °C -40 to +80

SB9000 Support No
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1.1.1 Specification

Table 1-2 RF Specification

Parameter Value
Frequency Bands MHz 260–275 MHz

350–390 MHz

380–430 MHz

410–470 MHz

806–870 MHz

RF Channel Bandwidth kHz 25

Switching Bandwidth TMO MHz 6 (260–275 MHz)

40 (350–390 MHz)

50 (380–430 MHz)

60 (410–470 MHz)

19 (806–870 MHz)

Switching Bandwidth DMO MHz 6 (260–275 MHz)

40 (350–390 MHz)

50 (380–430 MHz)

60 (410–470 MHz)

19 (806–870 MHz)

Transmitter/Receiver Separation MHz 9 (260–275 MHz)

10 (350–390 MHz)

10 (380–430 MHz)

10 (410–470 MHz)

45 (806–870 MHz)

Transmitter RF Output Power W 3 (Class 3)

RF Power Control 4 Steps of 5 dB

RF Power Level Accuracy +/-dB 2

Receiver Class A and B

Receiver Static Sensitivity dBm -112 minimum (-114 typical)

Receiver Dynamic Sensitivity dBm -103 minimum (-105 typical)

Table 1-3 GPS Specification

Parameter Value
Simultaneous Satellites 12

Mode of Operation Autonomous or Assisted (A-GPS)

GPS Antenna Supports an active antenna (5 V, 25 mA supply) through
an FME male connector
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Table 1-3 GPS Specification (cont'd.)

Parameter Value
Sensitivity -152 dBm / -182 dBW

Accuracy (Measured at -137 dBm) 5 meters - 50% probable

10 meters - 95% probable

This specification may be subject to change without further notice. All product features are subject to
infrastructure support. Selected features are subject to optional software upgrade.

1.2 Radio and Features Ordering Options
TETRA terminals are only available to Accredited Channel Partners who are advised of the discount structure
applied to these products.

Software options can be ordered and enabled in three ways:

• You can order by dongle.

• You can enable at DC — visit Order Management Electronic Catalog (OM-eCAT) Volume Descriptions

• If you have iTM, you can enable them with license.

1.3 Radio Ordering
Procedure Steps

1 Order the main radio model.

2 Order options from each of the categories:

• Software Selling Features

• Customer Programming Software

• Integrated Terminal Management

• Accessories

Export controls apply when ordering encryption.
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1.4 Models, Options, Accessories

1.4 Models, Options, Accessories
The up-to-date list of models, available options, and accessories is available through Order Management Electronic
Catalog (OM-eCAT) Volume Descriptions.

1.5 Software Enablement Kits
Each software enablement kit ordered provides one dongle for the customer with a specific number of counters set
according to the amount of software options ordered. This kit number is applicable to both new orders or existing
fielded terminals which require software enablement.

The features are enabled at the same time the customer programs the radio. The enablement for all the selected
features is performed in one operation.

1.6 Golden Codeplug
The Golden Codeplug covers all standard codeplug fields and required optimal settings. In a Golden Codeplug, field
parameters are pre-configured and fine-tuned for high quality and to get better performance from your new radio.

1.7 Ordering Software Enablement Kit
Procedure Steps

1 Order the main kit.

2 Add a software feature option.

You can select more than one feature for each main kit.

3 Order quantity equaling number of models requiring an option.

Example:
The following order is placed:

• 20 terminals
• 10 GPS software enables
• 20 GPS feature software enables

To accompany the terminals (ordered as per price pages, see Order Management Electronic Catalog (OM-eCAT)
Volume Descriptions), the following Software Enhancement Kit should be ordered:

• 1 dongle (1 x GM0193)
• 10 GPS (10 x QA00177)
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• 20 GPS feature (20 x QA03185AA)

1.8 Software Feature Options
Table 1-4 Main Kit Number

Radio Main Kit Number
MTM800 Enhanced GM0127

Table 1-5 Feature Options and Availability

Feature Option MTM800 Enhanced
QA00177AA GPS Yes

The GPS Feature is a hardware option. If
GPS is required select the appropriate radio
configuration while ordering. The radio is
then shipped with the hardware required to
enable the feature.

QA00175AA WAP Yes

QA00176AA MSPD Yes

QA00771AA Enhanced Security Yes

QA00772AA Permanent Disable (Kill) Yes

QA01003AA Kill/Unkill (Permanent Disable v2) Yes

QA01089AA Call Out Yes

QA01090AA RUI/RUA Yes

QA01261AA Secondary Control Channel (SCCH) Yes

QA01275AA Dual Control Head Yes

The Dual Control Head Feature requires
selecting the hardware option GA00311AA
while ordering. The radio is then shipped with
the hardware required to enable the feature.

QA01276AA Air Interface Migration Yes

QA01628AA RMS/FMS Yes

QA01629AA SDS Remote Control Yes

QA01652AA Cell Select by Talkgroup Yes

QA01746AA WAP Push Yes
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1.8 Software Feature Options

Table 1-5 Feature Options and Availability (cont'd.)

Feature Option MTM800 Enhanced
QA01847AA SDS E2EE Yes

QA01848AA Immediate Text Message Yes

QA02765AA Local Site Trunking Ignoring Yes

QA02766AA Sticking to Home Cell Yes

To enable WAP Push on the radio, WAP feature is required.

Depending on the way you order software options (order by dongle or enabled at DC) visit Order
Management Electronic Catalog (OM-eCAT) Volume Descriptions to verify your numbers.
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2 Services and Features

2.1 Features Overview
Trunk Mode Operation (TMO)

• Air Interface Encryption - SCK, CCK, DCK, GCK
• Air Interface Migration
• Ambience Listening
• Announced Type 2 handover
• AT commands
• Broadcast Call
• BUP and RL
• Call-Out
• Congested Cell Handling
• DGNA (Individually and group addressed)
• Duplex private call
• Dynamic Key Encryption
• Emergency group call
• Group call
• Hot Mic and Alternating Hot Mic
• Multi-Network Operation
• Mutual Authentication
• OTAR (Over The Air Re-keying)
• Packet Data (Multi-Slot)
• Preemptive Priority Call
• PTT Double Push
• Radio Messaging System
• RUA/RUI
• SDS Remote Control
• SDS Store and Forward
• Secondary Control Channel
• Short Data Services (Status, Text Message)
• Simplex private call
• SwMI Initiated Authentication
• Talkgroup and Priority monitor
• Targeted SDS Status (to SSI)
• Telephone call (PSTN /PABX)

- 2-1



TETRA Radio Product Information Manual

• Temporary/Permanently Enable/Disable
• TNP1
• Transmit Inhibit (RF Sensitive Area Mode)
• WAP Push

Direct Mode Operation (DMO)

• AT commands
• DMO Group Call
• DMO Group Emergency Call
• DMO Inter-MNI (including open group and open MNI)
• DMO Private Call
• DMO Repeater Compatibility
• DMO Static Key Encryption (DMO SCK)
• DMO/TMO Emergency Switching
• PTT Double Push
• Short Data Services (Status, Text Message)
• Targeted SDS Status (to SSI)
• Transmit Inhibit (RF Sensitive Area Mode)

Platform Specific Features

• 4-way navigation key
• Built-in GPS receiver
• Data Box Radio operation
• Dual Control Head operation
• Dual-function rotary (volume, list selection) with the push button
• Energy Economy
• Flashing via USB
• GPS over Multi-Slot Packet Data
• High-resolution color display

General Features

• Covert Mode
• Favorite talkgroups
• Flexible size talkgroup folders
• GPS location reports and display
• High Assurance Boot (HAB) memory access protection
• Super groups of scan groups
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2.2 System Support

Features Not Supported in Dimetra

• Background scanning

• Call modifications

• CCK per LA

• DCK Forwarding

• Emergency Private call

• SDS via PSTN Gateway (SDS to PABX is not possible)

• SwMI controlled groups

• SwMI initiated attachments

2.2 System Support
The radio operates on the Dimetra IP 5.x, 6.x, and 7.x releases and Dimetra IP Compact. It also operates on
previous versions of Dimetra — from Release 3.8 and on.

The radio is designed to operate optimally on the Dimetra IP system. The radio operates properly on all SwMIs
that comply with the following IOP TIP documents:

• TIP-Core TTR 001-01, TIP — Part 1: Core.

• TIP Auth TTR 001-04 TIP — Part 4: Authentication.

• TIP-SS-AL TTR 001-09 TIP — Part 9: Ambience Listening.

• TIP AIE TTR 001-11 TIP — Part 11: Air Interface Encryption.

• TIP Disable TTR 001-13 TIP — Part 13 - Enable/Disable.

2.3 Trunked Mode Operation
Trunked Mode Operation requires the switching and management infrastructure. This operation mode enables
various voice and data communication types (for example, group calls, short data service messages) and access to
the infrastructure-related features (for example, packet data).
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Figure 2-1 Trunked Mode Operation

2.4 Direct Mode Operation
Direct Mode Operation is a mode of simplex operation where radios communicate directly.

Figure 2-2 Direct Mode Operation

2.5 Numbering and Addressing
Each radio has a TETRA ITSI used for addressing the radio over the air interface. However, it is undesirable to
require you to enter a long number to address another radio. To this end, a set of short number schemes can be used.

Alternatively, the radio can be provisioned to treat a short number as an SSI. This scheme can be refined to allow
short dialing within a fleet by combining the ID entered with the radio own SSI.
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2.6 Dialing Methods

If the radio is provisioned to treat a short number as a TETRA Short Subscriber Identity (SSI), and the number
entered is less than seven digits, the radio own identity is combined with the number entered to produce the actual
ISSI. Using this scheme, an ISSI can be comprised of a fleet number part and a member part.

The radio own ISSI is used for determining the leading digits for the digits omitted as in the following scenario:

1. The radio has the following ID: 1234567
2. You enter: 890
3. The SSI sent is: 1234890

The following services can use the short SSI for identification for both the called and the calling party:

• Duplex private call
• Simplex private call
• Group call
• Mobile status
• Short data bearer service
• Text message service

Regardless of the short addressing scheme used, if you are provisioned with the capability of entering a real TETRA
ISSI and you enter an ID of seven digits, the number is interpreted as a real TETRA ISSI.

2.6 Dialing Methods
The radio supports multiple methods for selecting a number for an outgoing call.

The direct dialing provides the radio user with a possibility to dial a number before entering the mode (modeless
operation for all types of calls). To start dialing from the idle display activate the private number dialing editor by
pressing and holding an assigned key. The default call type is suggested with the possibility to change the call type.

Scrolling keys are used to scroll back and forth through the contact list or talkgroup/folder names.

2.6.1 Talkgroup Dialing
The talkgroup dialing by index allows calling from a radio to a talkgroup by using the talkgroup speed dial number
(in other words the Talkgroup ID or Index). By default, you scroll through a list of talkgroups to find the one and
call. With the talkgroup dialing by index option enabled, you can use the keypad and enter the talkgroup speed
dial number followed by the * key. For example, to call a talkgroup which ID is 19, a radio user enters 1, 9, and
* from the keypad and then presses the PTT button.

2.6.2 Individual Dialing
If the One-Touch Button method is provisioned, you can call an individual by pressing and holding down one of the
programmable buttons.

The Phone/PABX feature allows you to dial Phone/PABX by a shortened number of up to three digits instead of the
full number. The Phone/PABX Speed # number is assigned when the dialed number is added in the contact list.

You can re-dial numbers from the call history stack.
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The private ID number is a number with up to 16 digits. If you enter less than 16 digits, the Individual Short
Subscriber Identity (ISSI) part is padded to full Individual TETRA Subscriber Identity (ITSI) with leading zeros.
The private ID number consists of MCC (Mobile Country Code), MNC (Mobile Network Code) and ISSI.

Table 2-1 Dialing Scheme

MCC MNC ISSI
16–14 13–9 8–1

For the MNC of a private ID (digits 13-9) values from 00000 to 16383 are accepted.

Two options are given to the user:

• Fixed — provide up to 16 digits which include the MCC, MNC, and ISSI numbers. If you enter less than 16
digits, then the rest is filled with the digits that are set in the codeplug.

• Automatic — provide up to eight digits. If you provide more, it switches to fixed mode. If you enter less
than 16 digits, the radio fills the rest of the number with its own ITSI.

If you try to enter more than 16 digits, you receive a prompt informing about an incorrect input.

2.7 Unified Address Book
The radio offers an address book facility, where multiple numbers are associated with a single name tag. This
facility presents an interface to the address book and provides a natural way to call an individual who can be
contacted in different ways.

Each individual can have up to six associated numbers:

• Private (a TETRA ISSI).

• Home (phone number).

• Mobile (phone number).

• Work (phone number).

• PABX (local short number).

• Other (phone number).

The Contact List has a maximum capacity of 1000 Contacts, with up to 1000 associated Private and up to 1000
associated either Phone or PABX numbers distributed among the contacts.

The radio provides editing capabilities to the address book to allow adding or deleting entries.

The radio provides with the possibility to view the number of used and free address book entries.

The address book is also accessible through PEI. Using the PEI enables you to read, write, and modify contact
list entries using AT commands.
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2.8 Call History

2.8 Call History
A call history stack is provided which consists of the following:

• Last dialed numbers
• Missed call numbers
• Answered (Received) call numbers

Additionally for the recent calls the time when a call was established and the call duration is available.

The Call History stack holds private TETRA IDs as well as phone and PABX numbers.

Numbers from the stack may be viewed, selected, and called. However, outgoing duplex calls from Recent Calls list
display in DMO are not allowed. When you scroll through the lists, the entries appear in the opposite order (the
most recent shown first).

When a call is made to a number that exists in the last dialed list, this number is not duplicated in the list and is moved
to the beginning of the list. However, a missed call and received entries are duplicated in the corresponding call list.

The call history lists are available after next power-up.

You can save a number from the call history stack to the address book.

2.9 Group Call
The group call service enables the radio to communicate with a group of other TETRA radios using point to
multi-point operation. This service is available in both TMO and DMO. You can initiate a new group call to the
selected talkgroup or talk back to the existing group call by pressing the PTT button.

2.9.1 Programmable Talkgroups
The radio offers a talkgroup list facility. Each talkgroup entry contains a TETRA group address and may be
associated with a name tag. The talkgroups can be defined in the codeplug as per the radio capabilities. Talkgroups
are configured separately for TMO and DMO modes. To program a talkgroup in TMO define its name and GSSI.
To program a talkgroup in DMO define its name, GTSI and frequency. The radio operator can select a talkgroup
which has an associated TMO or DMO frequency depending on the mode selected. When switching between the
TMO and DMO modes the last active talkgroup is selected. However the required talkgroup can be mapped in
CPS. In such a case a corresponding talkgroup is automatically selected during mode switching, irregardless of the
previously selected talkgroup.

Neither the group name nor the corresponding group address can be edited using the radio MMI.

2.9.2 Talkgroup Folders
The talkgroups are organized in folders. You can select a talkgroup by first choosing a folder and then the talkgroup
in the folder. Use the rotary knob or the Option button to select the talkgroup, for detail procedure see the Feature
User Guide.The size of each folder is flexible and can be defined through provisioning.
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The talkgroup folders are organized in a tree-structure:

• Level 1 Folders

– Placed at the root of the folder structure.
– Can contain both level 2 folders and talkgroups at the same time.
– Can contain any number of level 2 folders.

• Level 2 Folders

– Placed in level 1 folders.
– Any given level 2 folder can only be subfolder to one level 1 folder.

• Level 3 Folders

– Placed in level 2 folders.
– Any given level 3 folder can only be subfolder to level 2 folder.

Figure 2-3 Talkgroup Tree

The maximum of 256 folders is allowed, regardless of their level.

The folder definitions cannot be changed using the radio MMI. Any talkgroup folder or subfolder which is
either empty or does not contain any programmed talkgroups shall be hidden in the MMI.

2.9.3 Talkgroup Selection
Talkgroup selection from the stored talkgroups list in the idle mode can be performed by scrolling through the list
using the scroll keys, or the rotary knob.

Talkgroup scrolling can be provisioned to scroll in a folder only, or continuously through the folders acting as
one continuous list of groups.
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2.9.4 Favorite Talkgroups

The radio does not allow directly dialing a group SSI.

2.9.4 Favorite Talkgroups
This feature allows a quick access to frequently used talkgroups by including the groups in up to three favorite
talkgroups ranges. These ranges are separately stored in the data storage.

The favorite talkgroups feature operates in both TMO and DMO modes. The favorite talkgroups ranges are shared
for TMO and DMO talkgroups. You can select, view, and editMy Groups ranges. Once a group from theMy
Groups range is selected, you can select any of the favorite talkgroups in that range using normal procedure.

A favorite talkgroup range name replaces a talkgroup range name on the radio display whenever a favorite talkgroup
is selected, or is in use for appropriate operation. The ranges of favorite talkgroups with their talkgroup assignments
are kept through the radio power cycle.

2.9.5 Talkgroup Blind Operation
The radio can be provisioned with a virtual rotary end-stop option for use in blind operation. When you have scrolled
to the beginning or the end of the list, the first or the last talkgroup is displayed even if you continue to scroll. To
change this setting for the rotary knob you can select “Wrap around Rotary Knob Group Scrolling” option in the CPS.

2.9.6 Receive-only Talkgroups
Talkgroups can be provisioned as receive-only talkgroups. This setting depends on the settings of the folder the
talkgroup is in. Any talkgroup from the receive-only folder can be selected. The radio allows to receive calls,
however, no call can be initiated to this talkgroup.

2.9.7 Non-Selectable Talkgroups
A talkgroup can be provisioned as a non-selectable talkgroup. Such talkgroups are not visible when scrolling through
the talkgroup list, and thus cannot be selected. The group name is displayed only upon receiving a call for the group,
for instance, if it is an announcement talkgroup associated with the selected group, or if it is a scanned one.

2.9.8 Talk Time Limit
The radio limits the time you can continuously talk in a group call without interruption, according to a provisioned
value. You are warned a short time before the talk time expires. The timer is provisioned per talkgroup folder.

2.9.9 Receiving a Group Call
In most situations, the radio receives group calls without any intervention. When the radio receives an incoming
group call, you may be alerted with a short alert tone. Depending on the configuration the tone may be disabled.
Then the speech follows.

To clear a call ended by the call owner (normally the SwMI), you do not need to do anything. However, you can leave
a group call. Then the call continues for other radios, however, your radio does not participate in the call anymore.
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2.9.10 Talkgroup Scanning
Talkgroup scanning allows the radio to monitor signaling of a number of talkgroups at the same time. In addition to
monitoring signaling addressed to the selected talkgroup, the radio can monitor signaling addressed to multiple
talkgroups.

To use the multiple group monitoring, define a scan list — the user-activated scan list. This list holds up to 20
talkgroups, which you monitor in addition to the selected group.

You can choose only one user-activated scan list at a time. When this list is activated, the radio begins to monitor
traffic for these groups in addition to the traffic for the selected group. The radio can allow creating and editing the
scan list using MMI. Up to 40 scan lists can be defined.

If the SwMI instructs a radio to detach one of the scanned groups, the radio stops monitoring the group, but the
group remains in the scan list. Subsequent attachment of a group by the SwMI causes the radio to begin monitoring
the group again.

The SwMI may also instruct a radio to attach groups from out of the scan list. If the group attachment is accepted,
the radio monitors the group.

The radio may passively monitor the following talkgroups if they have been attached or are always attached:

• Selected talkgroup.
• ATG associated with the selected talkgroup (if this talkgroup is not set as Permanently detach).
• Talkgroups associated with the selected ATG (if this talkgroup is not set as Permanently detach).
• Talkgroups in the user-activated scan list (if scanning is enabled and the SwMI-initiated detachment has
not been performed on these groups).

• Talkgroups in the SwMI-controlled scan list (if scanning is enabled).
• Talkgroups with the class of usage set to Always Scanned (if supported).
• Supergroup of the selected talkgroup.
• Supergroups of the scanned talkgroup.

2.9.11 Priority Monitor
While the radio is active in a group call, it may receive a group call setup for a different group. The radio decides
whether to ignore the new call or accept it basing on the call priority. If the new call has the higher priority than the
current one, the new call may be joined and the current call is dropped.

The following priority types are applicable to calls:

• Call priority indicated in the call setup signaling.
• Priority of the group indicated by the Class of Usage (CoU) negotiated upon attachment.

If the old call and new call have different call priorities, the radio follows the call with the higher call priority. If the
calls have the same call priority, the CoU priority of the group decides.

If a radio is in a group call, but is not currently the talking party, and detects a call setup for a different group with
the same priority, it joins the call if a CoU priority is higher.

The radio can be set up not to immediately join the new higher priority call but to present the new call to the user
before joining it. If so provisioned, you are given a choice of following the new higher priority call or staying
with the present call.

The radio can be set up to treat a selected group call as a higher priority than a scan group call. This behavior occurs
regardless of the priority of the calls or the groups.
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2.9.12 Announcement Talkgroup
The radio supports the concept of a group hierarchy. A special group, an announcement talkgroup (ATG), in addition
to being a group, logically contains up to 20 subgroups.

When you select an ATG as the selected group, the radio monitors traffic received for the announcement group as
well as the traffic received for any of the associated subgroups. However, the radio does not monitor the active scan
list groups when an announcement group is selected.

When you select one of the subgroups of the ATG, the traffic for the subgroup is monitored as well as the traffic for
its announcement group, not other subgroups though.

Each normal talkgroup may be associated with only one ATG. An ATG cannot be associated with another ATG.

Depending on the codeplug settings, you may be prohibited from initiating ATG calls. In such case, you are still
permitted to initiate an emergency call to an ATG group.

2.9.13 Broadcast Call Initiated by User
This feature allows you to make a Broadcast Call from the radio initiated on the predefined talkgroup. The alias
(message) displayed during Broadcast Call, as well as the call priority and destination address (talkgroup), can be
configured in codeplug. This feature can only be used in TMO mode.

During Broadcast Call, other features are impacted:

• No other services except emergency are allowed (same as in emergency mode)

• Hot Mic functionality cannot be used.

• When Broadcast Call begins, any other ongoing services are terminated.

If the type of the encryption is defined by the BSI feature (radio with a SIM Card), the Broadcast Call is
always clear. Otherwise if the radio uses other encryption service the type of the encryption used for that
Call is up to the encryption settings of that service.

Not all infrastructures support this feature. Consult with your service provider before enabling this feature.

2.9.14 Timed Talkgroup Change
This feature allows switching between the original and the predefined talkgroup (TMO or DMO) by using .

The radio attaches to the selected, predefined talkgroup only for a specified amount of time (Functional Timer).
After the timer expires, the radio returns to the previously attached, original talkgroup. Returning to the original
talkgroup can also be assigned to the second press action of the button.

Example:
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A campus university combines four buildings: A, B, C, and D. A security procedure is to raise an internal alarm
for the building and then notify the entire campus. The staff in each campus building configures radios with
three types of talkgroups.

1. Internal Communication Talkgroups – regular talkgroups for the entire campus and individual buildings to
communicate between staff members.

2. Internal Alarm Talkgroups – emergency talkgroups, individual for each building.

3. External Alarm Talkgroup – an emergency talkgroup to alert the entire campus.

The staff in individual buildings uses the dedicated Internal Communication Talkgroups for daily routines and
the Internal Alarm Talkgroup for safety procedures. The campus staff in every building also scans the External
Alarm Talkgroup.

The campus IT administrator assigned in CPS the Timed TG Change function to a One-Touch Button to switch
between the original Internal Communication Talkgroup, and the Internal Alarm Talkgroup. This way the radio
users can immediately switch to the emergency talkgroup and start an internal emergency call.

One of the staff members in building A is in an emergency situation. The person presses the One Touch Button to
switch to the Internal Alarm Talkgroup and starts the emergency call. The other staff members in building A hear
the voice communication on the Internal Alarm Talkgroup. It turns out that the emergency is serious and one of the
building administrators starts the global alarm for all campus buildings.

2.9.15 Broadcast Call
This kind of call enables dispatcher to transmit to all radios in the specific area.

The radio joins calls received with a communication type broadcast and displays a notification that this call is a
broadcast call.

Typically, this call type is addressed to the broadcast address (ISSI).

A broadcast call takes precedence over any other call that has the same or lower call priority.

The radio cannot initiate a broadcast call, however, the radio is able to initiate the "broadcast-type" call
restricted to the particular talkgroup using the Announcement Call feature.

2.9.16 Announcement Call
This feature allows you to make a Broadcast Call from the radio initiated on the predefined talkgroup. The alias
(message) displayed during Broadcast Call, as well as the call priority and destination address (talkgroup), can be
configured in codeplug. This feature can only be used in TMO mode.

During Announcement Call, other features are impacted:

• No other services except emergency are allowed (same as in emergency mode)

• Hot Mic functionality cannot be used.

• When Announcement Call begins, any other ongoing services are terminated.
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2.9.17 PTT Double Push
The PTT double push (D-PTT) feature enables to generate a specific tone sent to radios in the talkgroup. You can
send the tone by pressing PTT twice. After the D-PTT tone is played, you can press and hold the PTT once again
to get the permission to talk. Otherwise if you press the PTT while the D-PTT tone is played, it is ignored. After
D-PTT tone is sent keeping PTT pressed results in permission to talk. D-PTT tone is not audible on sending radio.

To send the tone (when the feature is enabled), you press the PTT twice in a period defined in CPS. The D-PTT is
triggered only when the radio is in idle or group call mode. The D-PTT tone is not played on the sending radio.

If the PTT is kept pressed after second press and the radio finishes sending the D-PTT tone it allows starting group
call. You are notified of the behavior by the permission to talk tone after D-PTT tone ends. If PTT is released
after the second press, only the D-PTT tone is sent.

The D-PTT tone is sent as voice, hence the receiving radio plays the sound no matter whether the feature
is enabled on it.

You can adjust the D-PTT tone volume level in the speaker/earpiece of the sourcing radio. Disabling all the tones
does not affect the sent tone volume. From the MMI you can change the D-PTT tone to be single, double, or triple.
The tone type can also be changed in the codeplug.

2.9.18 PTT Queue
This feature allows you to configure the response to releasing PTT of the call originating radio. This determines how
to cancel waiting for the call when the infrastructure is busy and your call is queued.

2.9.19 Talking Party Identification
The PDUs and facility elements for these TETRA Supplementary Services are not supported. However, identification
presentation functionality is supported in most cases using the information found in the call setup messages.

2.9.20 Call Ownership
The radio can be given the call ownership of a talkgroup call. When the radio is the call owner, it sends an
appropriate TETRA signaling to end the call.

The SwMI decides about the ownership of a call.
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2.9.21 Transmission During Group Call
While talking in an ongoing group call, and the PTT during received Group Call is enabled, you may request
to transmit by pressing and holding the PTT. The system registers this action and informs you that the request
has been queued.

If you release the PTT, the radio sends a message to the system withdrawing the request.

2.9.22 Call Restoration
If the radio roams to a new cell during a call, it attempts to continue the call on the new cell. Cell reselection and call
restoration procedures are employed for this attempt.

If the radio roams while being the transmitting party in the call, an announced cell reselection, if possible, is
carried out in the new cell.

If the radio is not the transmitting party, an unannounced cell reselection is employed, followed by call restoration
procedures.

2.9.23 Temporary Group Address
The radio supports the temporary group address assigned by the SwMI. The address is valid only for the lifetime
of the call.

The radio monitors signaling addressed to the temporary group, when the radio initiates a group call on the selected
group, and the SwMI assigns the call to a temporary group.

The radio supports assignment of an incoming group call to a temporary group address.

2.9.24 Late Entry
The user can join the groupcall even if not participating in it from the beginning. This is possible for example, if a
user turns on their TETRA terminal, in such a case the control channel automatically diverts the user's terminal
to a talkgroup call, if a call is already in progress. Similarly, if the user's terminal has been outside of the radio
coverage, for example in a tunnel, the control channel will also divert the user's terminal to a talkgroup call
assuming a call is already in progress.

This feature must be configured on SwMI. Acknowledged late entry, and late entry paging are not
supported.

2.9.25 User Initiated Group Attachment
To enable a radio to use a group, the radio should attach the group. The radio initiates a group attachment request to
the SwMI after the RCU initialization. The attachment occurs whenever you initiate a group change and when the
radio registers on a new site. When you change the selected talkgroup, the radio initiates an attachment to the SwMI,
detaching the old group and attaching the new one.
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All group attachments sent by the radio are sent with attachment mode of Amendment or Detach all... depending
on which form causes sending less bits over the air interface.

When you turn on scanning and then select the scan list, the radio sends a group attachment request to attach the scan
groups in addition to the selected group. Similarly, when you select an ATG, the radio sends an attachment of the
ATG as the selected group along with the attachment of the associated groups as scan groups. If a group associated
with an ATG is selected, the radio sends an attachment of the ATG as the selected group and as a scan group.

The TETRA TIP provides a facility by which the radio can send a status message to the SwMI to turn scanning
off and on to save air interface signaling.

If the radio is provisioned with this option, when you turn scanning off, the radio sends an appropriate TETRA
signaling. In this state, the radio does not monitor any groups other than the selected group. If you then turn
scanning on, the radio sends an appropriate TETRA signaling and begins monitoring all scanned groups again.

If the radio is not provisioned with this option, you only have an option to deselect the active scan list. However, you
cannot turn off the scanning. Deselection of the user scan list causes a group detachment of the scan list groups sent
to the SwMI. However, the radio continues to scan all other groups (such as ATG associations).

2.9.26 SwMI Initiated Group Attach/Detach
The SwMI can send a talkgroup attachment to the radio. The radio will attach to it, even if this talkgroup had not
been programmed in the codeplug.

If the radio receives a SwMI initiated attachment for the group already currently selected, the radio accepts the
attachment, and keeps the group selected.

If the radio receives a SwMI initiated attachment for a group in the currently active scan list, the attachment is
accepted. If it is for a group that is not in the current active scan list, the attachment is rejected.

If the detachment is for the selected group, the display indicates that no group is currently selected. If the detachment
is for a group that is in the scan list, the group remains in the list. However, it is not monitored. If the detachment is
for a group that is in the SwMI controlled list, it is removed from that list.

2.10 Private Call
The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other
radio can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.
• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

From your radio, an Private Call can be started using one of the following methods:

• Dialing ISSI number on the idle screen
• By selecting contact from the address book
• By selecting ISSI number from the recent call list
• Using Remote Control feature
• By pressing predefined One Touch Button
• Other

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The
radios are identified using its radio numbers.
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Interaction with the accessories:

• Fist Microphone — during the Private Call, if you hang the microphone into the clip the call ends or the
audio switches to the speakers (if connected). Exact behavior depends on CPS configuration.

• Telephone Style Handset — during the Private Call, if you hand the handset into the holder, the call ends or
the audio switches to the speakers (if connected). Exact behavior depends on CPS configuration.

Take the Fist Microphone or Telephone Style Handset off the hook. If the Handset is off the hook, the radio’s
external speaker mutes and the Handset’s internal speaker activates. If you are using the fist microphone or
telephone style handset, replace it firmly on it's clip or holder when done. Both fist microphone and handsets can be
equipped with Hook functionality. You can answer the call by taking the fist microphone or the telephone style
handset off-hook. If the handset is off-hook, the radio’s external speaker mutes and the handset’s internal speaker
activates. In case of accessories connected directly to the radio the microphone follows PTT (accessories connected
to the Control Head). In case of accessories connected through the junction box, the active microphone depends on
accessory hook state. If the accessory is on the hook, the visor microphone is the active one. If it is off the hook,
the microphone of the accessory connected to the TELCO connector is the active one. So, in case of accessories
connected to the junction box, active microphone does not depend on which PTT is pressed (accessory or external).
The microphone is selected based on hook setting.

2.10.1 Simplex Private Call
The radio is able to make and receive private calls to and from other TETRA radios with simplex speech capability.
This call type uses TETRA individual call signaling.

All private calls are initiated using the on-off hook method. For incoming calls, the radio accepts both direct and
on-off hook setup.

2.10.2 Duplex Private Call
The radio allows making and receiving private calls to and from other TETRA radios with duplex speech capability.
Depending on the configuration, the radio may prohibit you from initiating duplex private calls.

The radio always initiates duplex private calls using on-off hook signaling with the traffic channel allocated by
the SwMI only after the called party has answered the call. Therefore, the radio generates all progress tones
during the call setup. In addition, the radio allows the SwMI to modify the call setup to direct. This modification
enables the infrastructure to generate the progress tones.

2.10.3 Talk Time Limit
In a simplex call, the radio limits the time you can continuously talk in a group call without interruption, according
to a provisioned value. You are warned a short time before the talk time expires. The timer is provisioned per
talkgroup folder.

2.10.4 Call Restoration in Private Call
If the radio roams while you are the transmitting party in a private call, the announced cell reselection is employed
(if possible). Call restoration procedures are performed in the new cell.

If you are not the transmitting party, the unannounced cell reselection is employed, followed by call restoration
procedures.
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2.10.5 Call Modification
Call Modification is a feature that allows your service provider to modify the call in order to optimize it and
adjust to a current situation.

Modification can cover:

• Call priority — modified during call setup.

• Call type — modified during call setup.

• Call encryption — modified during an ongoing call (but not in the transmission phase).

When the call is modified, your radio displays Call Modified message.

When a recently modified call requires the PTT button to transmit, your radio displays Call ModifiedUse PTT.

All modifications are made by your service provider and the radio only follows them. You have no influence
on ongoing call modifications.

When call priority is changed to emergency:

• The display indicates that an Emergency Group Call has been received.

• The radio plays a special audio alert.

If a Group Call is modified into an Emergency Group Call, no emergency related features are triggered.

If call modification requested by your service provider cannot be followed by the radio (due to its settings), the radio
rejects it and displays Service Not Available message.

2.10.6 Assistance Call
Assistance Call feature helps you to call for assistance during normal and non-critical situations. Starting an
Assistance Call means starting a private call on a configured ISSI number. Assistance Call destination address and
priority can be configured in the codeplug. This feature is only supported in TMO mode.

Assistance Call can be a simplex or duplex call depending upon your service provider settings. An Assistance Call is
full-duplex when you start the call using radio menu. When you type the number and press PTT, then your radio
starts a half-duplex call, but if you type the number and press SEND, then the call is duplex.

2.10.7 DMO Individual Call Presence Check
If the other party is listening, the Presence Check feature allows the user making a DMO private call to have a
confirmation. This is important in situations where it is crucial that the message gets through. A radio with Presence
Check enabled displays the “Party not available” message if the other party does not answer. To use this feature,
both radios need to support it.

In addition, radios can be configured to Accept DMO Individual Calls with Presence Check. If enabled, the radio
accepts incoming calls with or without the presence check. If disabled, the radio only accepts private calls without
the presence check.
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2.10.8 DMO Individual Only Talkgroups
It is possible to configure some or all DMO talkgroups to allow only individual calls. This helps optimize frequency
allocation in Direct Mode Operation.

2.11 Phone Call
The phone call service enables a radio in TMO to communicate in a one-on-one simplex or duplex conversation with
a phone (for example, a phone calls-enabled TETRA radio or landline number) using a telephone switch. The radio
supports individual call service to an external identity.

Two phone call types are available:

• PSTN (a full phone number) is addressed to the defined PSTN gateway address.

• PABX phone number, for internal calls, numbers dialed are addressed to the defined PABX gateway address.

The PSTN phone call is supported when PSTN/PABX feature is enabled in the codeplug and the SwMI
supports this functionality. The PSTN/PABX gateway must be configured properly.

No more than one PSTN/PABX gateway ID and one PABX/PABX gateway ID are available in the radio.

2.11.1 Initiating a Phone Call
The radio is able to initiate phone calls to a PSTN/PABX with duplex speech capability. This call type uses TETRA
individual call signaling using single stage dialing and hook setup for outgoing calls.

Using the hook signaling for phone calls, implies that until a traffic channel is allocated, the radio generates all
feedback tones internally. In addition, the radio accepts SwMI modification of the call setup to direct, enabling the
infrastructure to generate the progress tones.

Phone calls can also be made between TETRA radios using the MS-ISDN number as the called party number.
MS-ISDN calls share the same gateway as phone calls, that is, PSTN gateway configured in the codeplug. If an
MS-ISDN call is placed, two radios can have a simplex or duplex call based on assigned ISDN number.

The Dimetra Infrastructure does not support private calls and SDS through MS-ISDN.

2.11.2 Receiving a Phone Call
Incoming phone calls (land gateway to mobile) use on-off hook signaling. The radio extracts the gateway ID
from the call setup signaling, to determine whether to start phone or PABX call. That means you need to answer
the call e.g. by pressing the SEND button.
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2.11.3 Call Restoration in Phone Call
If the radio roams while being in an active phone call, and the announced cell reselection is possible, then the
announced cell reselection is employed. Also the call restoration procedures are performed.

2.12 Emergency Operations
Emergency Operations are used in critical situations.

Pressing the EMERGENCY button or entering Emergency number and pressing SEND key, activates one or
more services (depends on the service provider setting):

• Sending Emergency Alarm
• Sending SDS Status
• Starting Silent Emergency
• Starting Hot Microphone operation
• Starting Emergency Individual Call (Private or MS-ISDN)

It is possible to power up the radio by pressing the Emergency Button. Depending on the service provider
settings the radio can start Emergency Operations automatically. If the radio was PIN-protected (except
SIM PIN), Emergency Operations will bypass the PIN lock for the duration of the Emergency Operations.

During Emergency Operations, the radio automatically rejects phone, PABX and private calls, and does not monitor
the talkgroups in the selected scan list. However, if an ATG is the selected group, the radio monitors the sub-groups
associated with the ATG.

When entering Emergency Operation, any ongoing voice call is aborted or cleared down. Any packet data transfer in
progress is aborted. However, the session is kept open.

2.12.1 Emergency Group Call
The Emergency Group Call has the highest communication priority that means it is the pre-emptive call. Emergency
Group Call is available in both TMO and DMO modes. During Emergency Operations, Emergency Group Call can
be started by pressing PTT. The MS may also support Hot Microphone operation, which allows the Emergency
Call to be conducted without pressing PTT.

If a radio receives an incoming group call with emergency priority, the display shows that an emergency call
has been received, and a special audio alert is played.

An emergency group call can be configured as non-tactical or tactical:

• A non-tactical call is initiated on a talkgroup designated by the codeplug setting. When in non-tactical
emergency mode, you cannot switch talkgroups.

• A tactical call is initiated on the currently selected talkgroup

In TMO, if the radio enters emergency operations while the emergency broadcast call is active the radio continues
on the call without initiating any calls and sends an emergency alarm.
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2.12.2 Non-Tactical Emergency
In Non-Tactical Emergency the radio switches to a designated Emergency talkgroup when starting Emergency
Operations. This talkgroup is used for the complete duration of the Emergency Operations (you cannot change the
talkgroup).

In TMO, it is possible to configure the radio to make Emergency Non-Tactical Group Calls without sending
attachment. If this is set, the radio assumes implicit attachment after receiving a temporary address.

In DMO, the Non-Tactical Emergency proceeds on the same frequency as the previously selected talkgroup.
The service provider can designate any ITSI address to be used for Emergency Operations, (this can be an Open
Group – broadcast address).

After exiting from Non-Tactical Emergency, the radio goes back to the previously selected talkgroup.

2.12.3 Emergency Individual Calls (Private or MS-ISDN)
The Emergency Individual Calls are Simplex or Duplex Calls with emergency priority. On pressing the
EMERGENCY button, the radio initiates an Individual Call to the provisioned address (private or MS-ISDN).
During this kind of call all user indications are unavailable and all other services are rejected. Emergency Operation
ends as soon as the Emergency Individual Call is ended.

2.12.4 Emergency Alarm
The emergency alarm is a special status message sent to the infrastructure while starting the Emergency Operations.
The radio may wait for infrastructure acknowledgment for this alarm and attempts retries.

Each time the radio enters the Emergency operation, it sends an emergency alarm. When an emergency alarm is
sent successfully, the respective audible tone sounds.

In addition, once the radio is in the Emergency Operation on pressing the EMERGENCY button, an additional
emergency alarm is sent. (Exception: during Hot Microphone transmission).

The message can be dispatched both in TMO and DMO.

2.12.5 Emergency SDS Status
Radio sends a status message with a preprogrammed value to the destination address set up in the codeplug.
Emergency SDS Status is available in TMO only. If no status acknowledgment or negative acknowledgment is
received, the radio retries sending the message. Status is not resend if Emergency Alarm or Hot Microphone is
configured.

2.12.6 Emergency Hot Microphone
The Hot Microphone allows you to talk without pressing the PTT button during Emergency Operations. The
transmission continues for a provisioned amount of time. Pressing the PTT button before the Hot Microphone time
expires ends the Hot Microphone operation. Then normal PTT operation in Emergency group call takes over (that is,
the transmission is ongoing for the time the PTT button is held).

Subsequent EMERGENCY button presses during the Emergency Operation restarts the Hot Microphone
transmission.
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If a talk permit is granted to another member of the group, the Emergency Call received tone is played. If configured,
the radio automatically attempts to get talk permit again.

Pressing EndSOFT key or END key ends the Hot Microphone operation.

2.12.7 Alternating Hot Microphone
The Alternating Hot Microphone is an enhancement of the Hot Microphone feature. It allows you to have the Hot
Microphone switched on and off alternately.

If this feature is enabled, you can initiate the Alternating Hot Microphone by pressing the EMERGENCY button.

The Alternating Hot Microphone terminates when one of the following conditions is met:

• The radio exits the Emergency Mode.
• The Alternating Hot Microphone timer expires.
• The PTT button is pressed.
• The right SOFT key is pressed (only during the transmission timeslot).

To skip your transmission timeslot and jump to a receiving timeslot, press END key.

When the radio goes out of the service, it enters the receiving mode and the Alternating Hot Microphone
is on hold. When the radio is back to the service, the Hot Microphone transmission and the Alternating
Hot Microphone resume.

When the user is in the Emergency Mode, pressing EMERGENCY button restarts the Alternating Hot
Microphone.

2.12.8 Silent Emergency Mode
The Silent Emergency Mode is a type of emergency services that provides no audible indications and no keypad
tones at the entrance. All the display indications are as in the idle mode. However, the radio cannot use any
services except for:

• Receiving Ambience Listening
• Sending Silent Emergency Alarms
• Sending GPS location reports

If you try to activate any other feature, it is blocked.

If the Silent Emergency feature is enabled, the radio enters Silent Emergency Mode on pressing the EMERGENCY
button. After entering this Mode the radio stays in TMO or switches to it, depending on the actual state. Once in
TMO, the radio sends Silent Emergency Alarm.
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If the radio is in a private or group call, the radio waits until the call ends and then enters the Silent
Emergency Mode.

The radio keeps re-sending the alarm until successful sending is confirmed. After the alarm is successfully delivered,
the radio stays in Silent Emergency Mode and waits for the Ambience Listening.

Your radio exits the Silent Emergency Mode, under the following conditions:

• Press MENU and then # key within 3 seconds.
• Press MENU simultaneously with right NAVIGATION key.
• Press both SOFT keys simultaneously.
• No success in sending the Silent Emergency Alarm and the maximum number of retries has been reached.
• The control room terminates the Silent Ambience Listening.
• The Ambience Listening is disconnected due to another reason.

If you turn off the radio in the Silent Emergency Mode, the radio switches to pseudo power off state. In this state, the
radio appears to be turned off. However, the radio is still on and in the Silent Emergency Mode. On turning the radio
on during the pseudo power off state, the radio acts as during turning on and still is in the Silent Emergency Mode.

2.12.9 Invisible Emergency
It is possible for the service provider to disable visual and audible indications of performing Emergency Operations
on the radio. The purpose of this feature is to hide the fact of using Emergency Operations in a critical situation
(e.g. direct attack on the user) and thus to provide additional layer of safety.

2.12.10 Disaster Alert
Disaster Alert call is a broadcast emergency call initiated by the radio, with emergency pre-emptive priority that
everyone in a broadcast area can hear. This feature is specifically designed for catastrophic situations, such as
earthquakes, and has the highest priority over other calls. All radios under Disaster Alert display emergency
notification on their screens. The alert message, its duration and destination talkgroup can be configured in
the codeplug.

In order to initiate Disaster Alert, switch the radio to Disaster Alert mode and press PTT button. When the call ends,
the radio will exit the Disaster Alert state.

During Disaster Alert, other functionality is impacted:

• When Disaster Alert begins, any other ongoing services are terminated.
• No other services can interrupt this type of call.
• Hot Mic functionality cannot be used.
• Speech can only be in Clear mode, even if any of the encryption services are enabled.

Not all infrastructures support this feature. Please consult with your service provider before enabling
this feature.
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2.13 DMO Gateway and Repeater Communication
The radio provides the capability of communicating in DMOmode with a TMO group via the IOP certified gateways.

A DMO repeater re-transmits information received from one DMO radio to other DMO radios over the DMO
air interface.

For each DMO talkgroup, the radio allows operating in one of the following modes:

Radio to radio only The radio initiates calls only on a talkgroup directly and not through a gateway
or repeater.

Specific gateway The radio can initiate calls on a talkgroup directly or through a specific gateway
address that is specified for a talkgroup. The gateway address can be edited
through the radio MMI.

Auto gateway The radio can initiate calls on the selected talkgroup directly with another radio
or through any available gateway that is detected as present.

Repeater The talkgroup links to a DMO repeater.

Specific gateway and repeater The radio uses only the gateway with the specified gateway address for the
talkgroup and/or a DMO repeater.

Automatic gateway and
repeater

The radio uses the first available gateway for a talkgroup and/or a DMO
repeater. If either specific gateway or auto gateway mode is chosen, and a
suitable gateway is found, all outgoing calls are placed through the gateway.
If a suitable gateway is not found, or a call setup through the gateway fails,
the radio shall attempt to set up the call directly.

2.13.1 Communication through Repeater
Radios that are out of range and cannot communicate directly one with another in DMO Mode can do it through
the repeater. The repeater is a radio that repeats all communication on a chosen channel, and as a result increases
radios’ DMO range.

DMODMO
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When the radio connects to a repeater, it plays a tone, displays the Repeater available message, and shows an
appropriate icon. When the radio looses connection with the repeater, it plays a tone, displays the Repeater not
available message, and the repeater icon is blinking. Messages and sounds are configured by the service provider.

2.13.2 Communication through Gateway
Gateway provides connectivity between radios operating in DMO Mode and the TETRA network, so that the
DMO radios can communicate with the TMO radios.

DMO

TMO

TMO

When the radio connects to a gateway, it plays a tone, displays the Gateway available message and shows an
appropriate icon. When the radio looses connection with the gateway, it plays a tone, displays the Gateway not
available message, and the gateway icon is blinking. Messages and sounds are configured by the service provider.

2.14 Short Data Services
The radio supports the following Short Data Service (SDS) message types:

• SDS Status.
• SDS User Defined Data Types 1, 2, 3.
• SDS User Defined Data Type 4 with or without SDS Transport Layer (SDS-TL).

The feature supports the following addressing modes:

• Radio to radio.
• Radio to talkgroup.
• Radio to external subscriber number (gateway address).

For SDS-TL, the message can be sent through the service center.

The radio provides a short data bearer service for both internal and external applications.
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2.14.1 Status Messages

The radio supports SDS-TL services which provide end-to-end acknowledgments, delivery report requests, and
message numbering for SDS user-defined data type 4 messages. The TL also provides SDS access for applications
that do not request these transport layer services, however, use a Protocol Identifier (PI). The radio can send the
delivery report by using an appropriate TETRA signaling, even if the originator requested a short report. The radio
can support the old SDS-TL standard for operation on legacy systems, or for operation on other SwMIs.

An externally connected device may access the SDS services in the radio using AT commands and TNP1 protocol.
An external application may use this service to send and receive SDS statuses, SDS user-defined data types 1,
2, 3, and 4.

Downlink SDS messages type 4 are presumed to contain a PI for identifying the target application. If an external
application has registered with the radio for that PI, the radio delivers the message to the target application. The
radio may receive downlink SDS messages that are successive retransmissions of a message already received and
acknowledged by the radio. The radio does not display these messages, nor store in them in the inbox, nor send
them to an external application.

2.14.1 Status Messages
You can select from a list of up to 100 pre-programmed alphanumeric aliases each of which corresponds to a
status value. The valid range of uplink status values is a set of provisioned parameters. If the radio is not enabled
with targeted status, the status value is sent over the air interface to the address of the selected group. The radio
recognizes the general status acknowledgment sent from the SwMI, as well as the negative acknowledgment. In
TMO, if no status acknowledgment or negative acknowledgment is received, the radio retries sending the message.
The number of retries and time to wait before retrying are provisioned parameters. You are notified of the delivery
status. As there is no acknowledgment for DMO status messages, you are notified only of sending the status
message. The radio does not initiate sending of status messages on a traffic channel.

If the radio is provisioned with the targeted status, the status value is sent over the air interface by default to the
last sent target. You have also an option to specify a different individual or group to send the message to. In other
words, you can send an SDS status message to a directly entered ID (for example, ISSI, GSSI, MS-ISDN). If
the radio is not provisioned with the targeted status and you want to send an SDS status message, the following
possible actions apply.

• When the default address type of targeted SDS status is set to Private or Phone, the default address is
used as ISSI or ISDN, depending on configuration.

• When the default address type of targeted SDS status is set to group, the selected talkgroup address is used.

The radio accepts status messages from addresses it is monitoring. The radio can be preprogrammed with an
appropriate text associated with each status value. The radio notifies when a new status message has been received.
Upon receiving an incoming status message, the stored text corresponding to the status value is extracted and placed
in the text message buffer as a text message. Receiving a status causes the radio to display the message mail screen,
allowing the user quick access to read the message. A received status can be stored in the radio text message buffer.

The PEI provides access for external applications to send and receive status messages.

2.14.2 Text Messages
The radio supports an internal text messaging application using the TETRA SDS Transport Layer. The radio can
send and receive up to 140 bytes of payload data (which can be up to 160 characters, if a 7-bit encoding is used).

Depending on radio settings, for each message in the Inbox , the following options are available:

• Store— used to save the message as a template.
• Delete— used to remove the message from the list.
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• Delete All— used to remove all the messages from the list.
• Reply— used to send a reply to the message originator with the option to edit the text (where available).
• Forward— used to send the current message to another recipient with the option to edit the text.
• Refresh— used to reorder the messages list and see the newest at the top. When you are in the Inbox and
the new message comes, refresh the list to see the new message.

The radio provides an edit facility for composing and editing a text message. The message can be sent to a target
TETRA radio using SSI addressing, and is sent with a request for a received delivery report.

All the outgoing text messages (short or long) are stored in Outbox, when the store and forward mechanism is
not in place. When the store and forward feature is enabled and the messages go through the store and forward
server, the short messages are stored regardless the delivery status. Whereas, long messages are stored only if
delivered (even if only to the store and forward server). Depending on radio settings, for each Outbox message the
following options are available.

• Store— used to save the message as a template.
• Delete— used to remove the message from the list.
• Delete All— used to remove all the messages from the list.
• Resend— used to send the message again to the same recipients with the option to edit the text.
• Forward— used to send the message to the other recipient with the option to edit the text.
• Refresh— used to reorder the messages list and see the newest at the top.
• Delivery Status— used to check the time and the date when a message was sent, delivered, read, expired, or
not delivered. Every status change is communicated.

Delivery report is saved in the Inbox and in the associated message in Outbox. However, the report is deleted
from the Inbox after viewing it.

Outbox and Inbox share memory area, hence their capacity depends on the combination of stored short and long
messages in each of these folders. If Inbox is empty, Outbox may store up to 100 short messages or at least 20 full
size long messages. If Outbox is empty, Inbox may store up to 100 short messages or at least 10 full size long
messages. When you enterMessages submenu, the number on the right side of Inbox and Outbox is indicating the
number of the messages stored. If the Outbox is empty, then the radio displaysNo Messages notification.

Upon receiving a text message, the radio places the text into a circular buffer. You are notified when a new text
message is received and a quick access to read the message is provided. If a delivery report is requested, the radio
sends it upon receipt of the message by SDSTL. If a consumed report is requested, the radio sends it when you
read the message.

If you read the message when the radio is out of service, the report may not be sent.

You can save incoming or edited (outgoing) text messages. These messages can be edited and sent.

For each message, you can verify its timestamp. The timestamp displayed is extracted from the SDS TL PDU. The
timestamp is generated and inserted to the message by the SwMI.

2.14.2.1 SDS Messages Concatenation
This feature allows sending long text messages up to 1000 characters. All the messages that are longer than 140
characters are divided and sent separately one after another. When a recipient receives all the parts of the message, it
displays as one on the screen.
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2.14.3 Immediate Text Messages

When the radio receives an SDS message and the Inbox/Outbox is full, the radio acts according to the Buffer Full,
Overwrite Policy codeplug field settings.

When the text or status message is received and accepted, the radio retrieves actual time information from its
internal clock.

The radio can reconstruct a long text message consisting of up to ten short messages. The maximum length of the
message is 141-1000, what can be defined in the codeplug. The radio recombines the text segments independently of
the order they have been received to the correct order of the original message. The message can be combined only if
all their message reference number are correct and the segmented receiver timer is still valid.

You can send long text messages to an individual destination. However, sending long text messages to groups is
not possible:

• Receiving the message during group/broadcast call — radio allows receipt of the text message during
ongoing group call and broadcast call. The group/broadcast call is displayed with the New mail arrived icon
and tone for mail reis played.

• Emergency Mode — you can receive SDS messages. To read the SDS messages the radio have to leave the
emergency mode. Sending the SDS messages in the emergency mode is prohibited.

2.14.3 Immediate Text Messages
Immediate Text Messaging is a selling feature which enables displaying the text message immediately on the radio
display. This feature is used for sending high important information from the console to radios.

When the radio has the feature enabled and receives an immediate text message, then:

• the immediate text message is stored in the Inbox.

• the content of the immediate text message is displayed.

• the relevant audio tone is played.

• additionally if the periodic alert feature is enabled, the periodic alerting is active until the immediate text
message is skipped or closed.

When the feature is disabled in the radio, then immediate text messages are processed as normal text
messages.

When you reply or forwards an immediate text message, the message is sent as a normal text message.

When the radio receives more than one immediate text message, then just the latest received immediate message is
displayed. All the previous immediate messages in the Inbox are not prompted.

2.14.4 Home Display Text Message
Your radio is provided with a feature that allows your service provider to send special text messages to the display.
The message stays on the home screen until a new message is received. Power cycle your radio to replace the
Home Display message to the predefined one.
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2.14.5 Predefined Templates (ATS Entry Prompt)
This feature assists the radio in sending formatted messages with a predefined destination address (MS-ISDN, SSI or
TSI) for computer applications.

You can select a predefined entry prompt which defines a message format to assist in the construction of an SDS
message. The prompt definition is set in the codeplug. The definition sets areas that are read-only, areas that can be
edited, and the type of characters that can be entered (numeric, alpha-numeric or phone digits). Along with the
message definition, the address to send the message is provided.

When you send the message, it is sent using SDS-TL with the PI that is provisioned in the codeplug. A receipt
report is requested.

2.14.6 SDS Air Interface Aspects
The radio can be provisioned to send a short-form SDS-TL receive report when the originator of the message allows
short-form report. The short form report uses specially designated SDS status values instead of SDS-REPORT.

The radio supports SwMIs that employ store and forward service as indicated in the cell broadcast information.
The radio supports use of a service center, which address is set in the radio. The store and forward operation is
supported. However, the radio notifies you only on successful sending of the message. The radio does not wait for
the report from the service center.

Downlink SDS messages types 1, 2, and 3 are always routed to the PEI when an AT application is registered. If no
external application is registered, the message is discarded.

The DMO SDS do not support type 1,2, and 3 user-defined short messages.

2.14.7 SDS Encryption
Short data messages stored in a radio are protected against any unauthorized access. The stored data includes
messages in the Inbox, Outbox, and stored call out messages.

The required protection against any unauthorized access through the MMI, PEI, or unintentional access by other
means is carried out through the special mechanisms. The encryption of stored messages preventing from accessing
the memory directly and the user authentication protect SDS messages. Protected messages cannot be read on the
radio MMI unless valid authentication occurs. For the user authentication, the existing radio PIN is used.

SDS messages received by the radio are encrypted before being stored in the Inbox. Store and Forward messages are
encrypted before being saved in the Outbox.

If the feature is enabled, then the radio prompts you to enter the PIN if any of the following menu items are
selected from the MMI.

• Messages → Inbox.
• Messages → Outbox.

Following successful PIN entry and access to the required messages, the radio does not require further PIN entries
to access messages unless one of the following conditions has been met.

• Exiting from the radio menu.
• Turning off the radio.
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2.14.8 Store and Forward

• Changing the PIN from the MMI.

If you disable the PIN lock through the MMI or change the PIN, the protected messages are deleted. Before deleting
the messages, you are prompted to ensure that the operation should proceed. If the PIN lock is changed through
the PEI, all the protected messages stored in the Inbox, Outbox are deleted. On enabling the radio permanent
disable, the access to the protected messages is lost.

2.14.8 Store and Forward
This feature allows communicating with each other without being available at the same time. If the destination
is not reachable, the message is stored in the system (if supported) until it is available or the expiration time is
exceeded. The system is configured to delete the message after a preconfigured time and this time cannot be
configured using the radio.

You can send the store and forward messages to an individual address or a group. Depending on the codeplug
settings, if you choose to send it to the group, the message status is switched from Store and Forward to Immediate.

When the Sending group message to Store and Forward Server is enabled, an SDS message sent to group is
conveyed with assistance of the store and forward service. The radio does not request a delivery report, thus
you are not notified of the delivery status.

Verify whether the infrastructure system supports this functionality.

2.15 Security Services
The radio provides TETRA security features as described in the TETRA Security ETS 300 392-7 standard, TTR
001-11 TIP, and TTR 001-13 TIP.

2.15.1 Terminal Equipment Identity
The Terminal Equipment Identity (TEI) is unique identification number programmed in the radio at the factory and
cannot be later modified.

2.15.2 PIN/PUK User Authentication
In order to authenticate yourself, the radio supports a Personal Identification Number (PIN) and PIN Unblocking
Key (PUK) mechanisms. These mechanisms prevent from an unauthorized access to the radio. The PIN/PUK
operations are available from both MMI and PEI (using AT commands).

For the authentication purpose the radio prompts you to enter a valid 4-digit PIN, before the radio allows to access
all the available services. The PIN is defined in the codeplug.

If the maximum number of consecutive failed attempts is reached, the radio is blocked and remains in this state until
unblocking. The permissible number of consecutive failed attempts is defined in the codeplug. The blocked status is
sustained regardless of turning off or battery removal.
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When the radio is PIN locked, you have no or limited access to the radio services. The PIN is defined in the
codeplug. The radio is unblocked either by entering the PUK or by using the CPS. The PUK can be entered through
the MMI or through the PEI. The PUK is defined in the codeplug.

2.15.3 Authentication
Authentication establishes a level of a trust between a radio and SwMI. It is a challenge-response result protocol
between two parties based on their common knowledge of a secret key (K) to verify each others identity.

The SwMI authentication centre (AuC) provides a single K for authentication, which is shared only with the
radio. Authentication is always initiated by the SwMI, the radio can also authenticate the SwMI (if set by the
service provider).

2.15.4 Air Interface Encryption
The radio supports TETRA Air Interface Encryption (AIE) using the standard TETRA public encryption algorithms,
as defined in TETRA Security ETS 300 392-7, TEA1, TEA2 and TEA3. The focus of cryptography in TETRA is
the encryption key. TETRA AIE provides 12 000 000 000 000 000 000 000 000 key combinations.

TETRA TMO has three classes of encryption:

• Class 1 — clear (none).

• Class 2 — static key encryption (SCK).

• Class 3 — derived key encryption (DCK, sometimes called the dynamic key), the Common Cipher Key
(CCK), and the Group Cipher Key (GCK).

TETRA DMO has two classes of encryption: Class 1 and Class 2.

The security features supported in the radio depend on the security mode.

Table 2-2 Security Features Required Per Security Class

Mode
Security Feature

Security Class 1 Security Class 2 Security Class 3 Security Class
3G

Radio Initiated
Authentication

Not Allowed Not Allowed Not Allowed Not Allowed

SwMI Initiated
Authentication

Optional Optional Mandatory Mandatory

Mutual
Authentication

Optional Optional Optional Optional

OTAR N/A Optional Mandatory Mandatory

SCK AIE N/A Mandatory N/A N/A

DCK AIE N/A N/A Mandatory Mandatory

GCK AIE N/A N/A N/A Mandatory
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2.15.4.1 Clear Radios (Class 1)

In the current release the radio does not support the following security features:

• Radio initiated authentication

• Support for TEA4

• Explicit authentication during DGNA

2.15.4.1 Clear Radios (Class 1)
A radio can be configured as a clear radio. In such case the radio identifies itself in registration as a Security Class
1 radio and does not support encryption. A Security Class 1 radio does not contain any encryption algorithms in
its software.

2.15.4.2 Static Cipher Key Encryption (Class 2)
The radio supports static AIE using a set of up to 32 static cipher keys (SCK) shared by the SwMI and all authorized
radios. The radio then determines which static keys to use based on the SCK Number (SCKN) and SCK version
number (SCK-VN) broadcast by the SwMI.

A radio can be configured to support static key encryption. In such case it identifies itself in registration as a
Security Class 2 radio, and attempts to negotiate Security Class 2 encryption. Each radio then uses either the
TEA1 or the TEA2 (TEA 3 — for Asia and Pacific) Key Stream Generator (KSG) algorithm. Each radio contains
only one of those algorithms in its software.

When Security Class 2 Encryption has been negotiated, encrypted PDUs are encrypted using SCK.

In DMO, the system manager may choose the SCK and the key may be distributed from the TMO SwMI using the
OTAR mechanism or provided manually using KVL.

2.15.4.3 Derived Cipher Key and Common Cipher Keys Encryption
(Class 3)

DCK/CCK are required to prevent over-exposure of key material. Existing encryption systems use Static Cipher
Keys (SCK), where one key is used for all radios and all calls. Key material is often exposed and SCK logistics of
changing keys consist in programming all radios and base stations.

DCK is used for individually addressed TM-SDU (Service Data Unit). DCK/CCK encryption provides Derived
Cipher Key (DCK) for uplink (from the radio to the BTS) communication and Common Cipher Key (CCK) for
downlink (from the BTS to the radios) group communication. The DCK is derived from either the one way or
mutual authentication process and the CCK is received during registry.

The radios supporting the dynamic key encryption identify themselves to the system as Class 3 radios during registry
and attempt to negotiate Class 3 encryption. A Class 3 radio supports group addressed signaling and group call
traffic encryption using CCKs. The radios support Over-the-Air-Rekeying (OTAR) of the CCK by the system.

A clear radio can set up calls to and receive calls from encrypted radios. The system informs the encrypted radios
that the call is with a clear radio and they switch to clear operation. Class 2 and 3 radios can only act as described if
they are allowed to operate in a lower class.
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2.15.4.4 Group Cipher Keys Encryption (Class 3G)
For the Security Class 3G the system allows grouping addressed signaling and dedicated group call traffic encryption
using GCKs to cryptographically isolate talkgroups. The downlink signaling is encrypted using MGCK that is
cryptographically derived from the CCK associated with the serving cell and the GCK associated with a given
talkgroup. The SwMI does not change GCK and CCK simultaneously. Whenever a GCK change occurs, CCK
changes are frozen for this time period.

The DCK is derived from either the one way or mutual authentication process and the CCK is received during
registry, whereas the GCK is received through OTAR mechanism only.

The radio supports over-the-air and manual provisioning of key associations that link a GCK to one or more TMO
talkgroups, and manual provisioning of KAG to one or more DMO talkgroups.

The system can provide the ability for the operator to group contiguous ranges of TMO SSI. This case occurs
where any talkgroup residing within the address range is assigned using the same GCK association. These ranges,
referred to as Key Association Ranges (KAR), are used to convey the TMO talkgroup and GCK relationships to the
relevant SwMI and radios responsible for GCK functions.

2.15.4.5 Over-the-Air-Rekeying
TETRA systems support GCK encryption for specific talkgroups:

• Group Over-the-Air-Rekeying (OTAR) of GCK.
• Group OTAR of fallback TM-SCK.
• Group OTAR of DM-SCK, including management of the cryptographic schedule of DM-SCKs.

The group OTAR mechanisms require a use of the group session key for OTAR (GSKO). The GSKO is delivered to
the radio only by using individual OTAR and the session key for OTAR (KSO).

For the systems utilizing group OTAR, the fundamental system operation (with respect to SCK/GCK OTAR) relies
on the sites regular transmission. In other words, the sites are regularly broadcasting information regarding which
security class and associated keys are in use. The sites transmit future versions of the respective keys to groups
of radios belonging to the same cryptographic management group (CMG). The radios acquire the keys before the
SwMI activates them. Then the air interface encryption service uses the keys. The sites also broadcast the current
key that is in use which can be sent using OTAR mechanism to the radio on request.

When a radio has not received a new key before activation by the SwMI, the radio requests the missing
keys.

Some systems adopt only individual OTAR methods for delivery of SCK and GCK to the radio. In such cases
GSKO is not used. Some systems employ a mix of individual and group OTAR methods. The radio supports the
complement to functionality required for supporting the superset of different SwMI behaviors, for example:

• Individual OTAR (using KSO) of SCK and GCK.
• Group OTAR (using GSKO) of SCK and GCK.
• Individual OTAR (using KSO) of GSKO.
• Secure DMO Key Management (via SwMI).
• Crypto Management Group.
• Storage of 10 KAG (equivalent to 30 DM-SCK).
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2.15.4.6 Encryption Mobility

• Storage of 16 GCK (includes current/future versions).

• Storage of 2 TM-SCK.

• Storage of Group Association attribute per Talkgroup.

• GCK Air Interface Encryption.

• Seamless key changes of GCK.

• Seamless security class changes to SC3G.

The SwMI can support the group OTAR feature. Where supported, the SwMI groups radios that share the same set
of cryptographic key material into a specific crypto management group (CMG). Any radio belonging to the same
CMG is addressed using a CMG GTSI. The primary purpose of the addressing is to transmit group OTAR messages
conveying TM-SCK, DM-SCK and/or GCK. Any radio that supports TM-SCK group OTAR, DM-SCK group
OTAR or GCK group OTAR is assigned to a specific CMG.

Each CMG has a designated specific GSKO. The system deploys over the air a CMG GSKO (and CMG GTSI) to
each radio belonging to the CMG. The GSKO is used as the sealing key for TM-SCK, DM-SCK, and GCK, when
sent across the air interface. The SwMI can perform scheduled transmissions of the future TM-SCK addressed to
each CMG. The radio requesting a TM-SCK triggers the site to schedule additional transmissions of the requested
TM-SCKs. These transmissions are addressed to either the CMG GTSI that the radio belongs to or its ITSI.

The SwMI can perform scheduled background transmissions of the future GCKs addressed to each CMG. The
radio requesting for a given GCK triggers the site to schedule additional transmissions of the current and the
future versions associated of the requested GCK. These transmissions are addressed to either the CMG GTSI that
the radio belongs to or its ITSI.

The SwMI can perform scheduled background transmissions of the current and the future DM-SCK addressed
to each CMG. The radio requesting for a DM-SCK triggers the site to schedule additional transmissions of the
requested DM-SCK. These transmissions are addressed to either the CMG GTSI that the radio belongs to or its ITSI.

2.15.4.6 Encryption Mobility
A Class 2 or Class 3 radio can operate on a lower class SwMI (depending on configuration). A radio that is
provisioned not to allow operation on a lower class SwMI, does not register on such a cell.

A Class 2 or Class 3 radio moves to a cell that supports an SCK/CCK/GCK that the radio possesses, applies AIE to
the registration PDU. If no acknowledgment is received, the radio sends the registration in clear.

2.15.4.7 Encryption MMI
A Class 2 or Class 3 radio that is involved in a clear call provides a visual and an audible indication informing that
the call is not encrypted (if enabled by the service provider).

2.15.4.8 AIE Key Storage
The radio stores all the keys, SCK/CCK/DCK/GCK, in a sealed manner in non-volatile memory of the radio.
However, they are not stored in the codeplug.

The radio supports loading of the SCK keys manually using the Key Variable Loader (KVL).

By using a special key combination, you can delete the cipher keys in the radio. Depending on configuration, you
may erase either all keys or only the short-term keys.
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2.15.4.9 Deleting User Keys
Prerequisites:
The user key deletion is enabled in the codeplug.

Procedure Steps

1 Verify that the radio is turned on.

2

The key deletion takes up to 30 seconds.

Result:
Encryption and/or Authentication keys are deleted. The radio enters Temporary Disable state and must be manually
restored by the service provider.

2.15.5 Secure DMO
The Secure DMO feature guarantees key ciphered transmission in the DMO.

When DM-SCKs are provided by OTAR, you are informed in case the radio does not contain the complete set of
SDMO keys. Whenever the radio enters DMO and the radio does not possess past and present DM-SCKs for all
provisioned KAG and/or it has not yet successfully received SCK Subset Grouping Type, SCK Subset Number and
SCK-VN information from the SwMI, then the radio:

• plays a special reject tone.
• prompts a message indicating OTAR incomplete.

The radio provides SDMO status information to the user via the MMI DMOSCK Validity submenu inside the
Security menu (present only when configured in the codeplug):

• DMO SCK is Valid—DMO SCK OTAR is disabled and all DM-SCKs are provided using the KVL.
• DMO SCK is Valid—DMO SCK OTAR is enabled and the radio knows the current SCK information and
has all the corresponding past and present DM-SCKs.

• DMO SCK is Invalid in all other cases.

The radio supports system management of SDMO keys. The radio using system managed SDMO requires the
structure of DM-SCKs used for SDMO, the current active SCK Subset Number, and Version Number information to
coordinate key schedules. The radio considers the last received variant of this information PDU as the most accurate
indication of SDMO key configuration.

DMO SCK can only be used if Enhanced Security feature is purchased.

2.15.6 End-to-End Encryption
The TETRA standard supports air encryption. The radio creates the PDU (Protocol Data Unit) and the PDU is
encrypted before transmission. The base station receives this PDU and must decrypt it, to know what to do with it
and where to send it. Thus, if a PDU contains voice information, the voice part of the message has been decrypted
and is now unprotected, until it is transmitted out to the caller.
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2.15.7 Radio Disable/Enable

Figure 2-4 Voice and Data End to End Encryption
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The End-to-End Encryption (E2EE) feature resolves this issue by encrypting the voice information before it is
packed into the PDU. This message is also encrypted according to the over-the-air encryption of the TETRA
standard. Thus, when the base station decrypts the PDU containing voice information, the voice part remains
protected by encryption until the called radio receives the voice and decrypts it.

In the end-to-end encryption feature, the radio notifies and informs whether the call, being made or received,
is voice-encrypted.

This feature is relevant for group calls in TMO and DMO.

2.15.7 Radio Disable/Enable
On reception of an appropriate TETRA signaling for subscription disable with the correct SSI and MNI of the
radio, the radio becomes disabled.

When disabled, the radio does not participate in any voice call and ignores all supplementary services sent on the
downlink. All visible and audible indications are disabled, and the radio appears to be turned off. All user inputs
(key presses, knob operation) are ignored, and the PEI interface is closed.

The radio continues to perform mobility management functions, such as roaming, to facilitate subsequent enabling
(or further disabling).

The radio stores the disabled/enabled state in the codeplug, so the unit remains in that state after turning on.

If the radio is in the disabled state, and receives an appropriate TETRA signaling for subscription enablement with
the correct SSI and MNI, it restores to its normal operative state.

The TEI Query feature provides TEI information to the infrastructure during registration. This allows to disable
the radio by sending an appropriate TETRA signaling for equipment disable with the correct TEI for this radio.
Replacing the SIM card does not activate the radio.

If the radio is in the equipment disabled state, and receives an appropriate TETRA signaling with the correct TEI,
the radio restores to its normal operative state (if the subscription is also in the enabled state).
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2.15.8 Radio Permanent Disable
Permanent disabling is intended to protect a network from attack from a compromised or faulty radio. It can be
used when the radio has been compromised, or has been suspected of compromise for a long time. It is a one-way
function and no equivalent enable is available. Then the radio should be recovered and reprogrammed before
being used again by the service provider.

When the radio is permanently disabled, it becomes inoperable.

• All its MMI interfaces on the radio are disabled.
• All its security key material, that is GCK, GSKO, DMO SCKs, Ks, DCK, CCK, TMO SCKs are deleted.
• All its codeplug is deleted.
• All its software is deleted.

The permanent disable should be invoked when it has been determined that a radio is unrecoverable. When a radio
has been lost or stolen, the first step always is to stun the radio (using the temporary disable).

The permanent disable should be used with the deletion of the user radio record in the User Configuration Server
and the deletion of the K-REF association of the disabled radio in the Provisioning Centre and the Authentication
Centre. This deletion ensures that subscriber information is not downloaded into the Home Location Register if a
restore of the UCS is performed.

The system operator has to also ensure that the radio K-REF association is also removed from the other
Authentication Centres in the network, in cases where the K-REF pairs are duplicated across the network.

If this association is not removed, the radio could be assigned a new home zone that lies in a cluster where the
K-REF association has not been deleted.

Radio Permanent Disable and Radio Permanent Disable v2 are mutually exclusive selling features.

2.15.9 Radio Permanent Disable v2
Similarly to the permanent disable, once the radio is disabled using the permanent disable v2, it cannot be recovered
over the air. When the radio accepts the permanent disable command, and if the permanent disable v2 flag is enabled
in the codeplug, the radio appears to be inoperable.

• All its MMI interfaces on the radio appear to be disabled.
• All its security key material; GCK, GSKO, DMO SCKs, Ks, DCK, CCK, TMO SCKs, and End-to-End
key material are deleted.

• The radio automatically turns off on powering attempts without any audible/visible indications to the end
users.

• The permanent disable flag is set in the codeplug.

Unlike in the permanent disable, a permanent disabled v2 radio can be re-enabled using the software selling dongle.
If you have the software selling dongle, you can read the codeplug and clear the permanent disable flag.

When a radio has been disabled using the permanent disable v2, entering programming mode procedure
is different. For the details, see TETRA Terminals CPS Start-up User Guide (Motorola Part Number:
6802974C10).

Radio Permanent Disable and Radio Permanent Disable v2 are mutually exclusive selling features.
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2.15.10 SIM Security
The SIM security consists of the following security functionality groups:

• Voice E2EE and related key management.
• Network access parameters and authentication.
• Key management for AIE.
• OPTA, modification, encryption, and transfer.
• AES for E2EE of SIM Interface and SIM-Terminal Authentication.

The SIM is an integrated circuit card, which holds a file system and an application. The application performs the
following actions:

• Generation of key stream segments (KSS).
• Synchronization for E2EE.
• TETRA authentication algorithm based on K key on the SIM.
• Key management for E2EE keys.
• SIM interface encryption and authentication using the AES.

The file system holds the following.

• Network access parameters as ITSI.
• Security class definition and authentication definition.
• Integrated circuit card identifier.
• SIM version number.
• Operative Tactical Address (OPTA).

The E2EE keys are also kept on the SIM. However, they are accessible for the SIM application only, thus E2EE key
management is transparent to the radio.

The keys for AIE remain on the radio. The SIM application handles AIE key management.

2.15.11 High Assurance Boot
The radio has a facility that ensures that the code and data flashed in the radio is authentic and has not been
altered. The hardware forces the HAB module to run at boot time. The module checks if all software comes from
a trusted source. The radio is checking the signature of the code and data segments present in the radio using a
public/private key mechanism.

If the HAB authentication of the flashed software fails, it does not allow the radio software to run.

2.16 Packet Data
The radio provides, in the TMO, a TETRA bearer service for applications that use the IP protocol. This service is
available to external applications by connecting using the PEI.

The radio supports TETRA standard multi-slot packet data using the IP network layer protocol through
Point-to-Point Protocol (PPP), and TETRA SNDCP protocol. The IP connection is established between Terminal
Equipment and Mobile Terminal, allowing external applications to communicate with Terminal Equipment using
predefined IP addresses.
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This IP connection is referred to as the local link. The link established between the radio and the SwMI
is referred to as the wide link. When a wide link has been established, the radio is considered to be in
the wide mode.

Packet data applications reside internally, over UDP, or in an externally connected device connected via an 8-wire
RS232 data port in the radio. Communication to the external radio is initialized using AT commands. Once the
connection is established, the external application may request Point-to-Point Protocol (PPP) mode, and then
operates in PPP mode until the data connection is terminated. The radios can operate both on the single-slot packet
data channel and the multi-slot packet data channel.

The system provides point to point IP connectivity allowing the following datagram exchanges.

• Radio ←→ External Equipment (Terminal Equipment) (for example PC).

• External Equipment (Terminal Equipment) ←→ Network (through radio).

The radio supports only IP version 4 packets. The radio routes datagrams independently of the protocol sitting
on top of IP.

The radio supports an MTU of 1500 bytes.

The radio provides the best effort delivery service. However, if the delivery fails, the originating user application is
informed by sending back to Terminal Equipment an ICMP message, if possible.

The radio generates ICMP messages addressed to the Terminal Equipment in case of failed delivery due to the radio
environment. The delivery may fail due to, for example:

• no radio coverage.

• failed transmission.

• service interaction.

The packet data service PDCH access signaling has the same priority as circuit mode setup-related signaling. The
radio uses advanced link for PD transmission and supports advanced link flow control. The advanced link roaming,
if the advanced link is not disconnected between cells, is supported, where the SwMI supports it.

The radio does not support data compression. If an application attempts to negotiate data compression during context
activation, it is rejected. If a data compressed IP packet is received from the SwMI, it is silently discarded. The radio
supports IP header compression negotiation received from Terminal Equipment during PDP context activation, and
transparently transfers IP packets with the header compression between Terminal Equipment and the SwMI.

The packet data service employs the TETRA standard cell selection and re-selection. The packet data service is
suspended while the reselection is occurring, and resumes when the cell reselection procedure is complete.

The cell reselection is undeclared in a strict TETRA sense. However, the SNDCP protocol defines a
procedure for reconnecting the packet data service on the new cell. In this sense, the cell reselection
procedure resembles the unannounced cell re-selection procedure.

Multi-slot packet data is a selling feature.
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2.16.1 Voice and Data Support
The radio can alternate voice and packet data service. However, voice and data running in parallel are not supported.
This behavior corresponds to Packet Data Type B - IP dual mode.

If the SwMI rejects the context activation due to PD MS type not supported, the radio reinitiates context activation
indicating that supports Type C. It is done to accommodate legacy SwMIs that uses an older definition of these types.

The radio supports transmitting and receiving SDS on the packet data channel. Thus, these services may be
conducted in parallel.

The radio can operate in one of the voice-data interaction modes.

Table 2-3 Voice-Data Interaction Modes

Voice-Data Interaction Mode Description
Voice Only Mode You have the option to select Voice Only mode, in

which Packet Data service is disabled. If an external
application attempts to start up in this mode, packet
data registration for a wide link is rejected. If the packet
data service is active when this mode is selected, the
radio deactivates packet data. The PEI operates in the
local mode only (data transfer between TE and MT).

Data Only Mode You have the option to select Data only mode, in
which normal voice calls are not permitted. Incoming
non-emergency voice calls are rejected, and you cannot
initiate non-emergency voice calls. Incoming and
outgoing emergency calls are allowed.

Voice and Data Mode In Voice and Data mode any voice call activity that
occurs during a data session takes priority over the
packet data. Once a voice call has interrupted the data
session, the PD session is suspended, until the voice
activity has ended. Then the session is resumed. Voice
priority mode is the default mode.

You can choose one of the interaction modes. The choice of interaction mode is stored in non-volatile memory
and remembered at power up.

In Voice and Data mode, if the radio moves to the traffic channel due to the voice service, the radio terminates
any active packet data transmission or reception. The data service is suspended. The data service resumes when
the voice service ends.

The radio accepts any downlink SDS message received on the Packet Data Control Channel (PDCH). The radio can
send uplink SDS messages on the PDCH.

The radio allows PEI, and PD applications to activate and use the PD context simultaneously. The first application
initiates PD context activation. The next PD context activation from another PD application results in sending a
reply indicating that the PD context is active. When , and PEI PD applications are using the active PD context,
the radio can filter the downlink IP packets based on their TCP/UDP port.

• UDP packets not addressed to the GPS ports are routed to the PEI (using PPP).

When activating another PD context on the radio, use the same settings in both PD contexts.
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2.16.2 Packet Data IP Addressing
Table 2-4 Packet Data IP Addressing

Addressing Mode Description
Wide IP Address An IP address may be assigned to the terminal by

the SwMI during the Packet Data context activation.
When assigned, both Terminal Equipment and Mobile
Terminal applications use this address as the source
address in IP packets delivered to the infrastructure.

Local IP Address By default both Terminal Equipment and the radio
have their own IP addresses. Terminal Equipment and
Mobile Terminal use these addresses for local datagram
transmissions between Terminal Equipment and Mobile
Terminal only and are not passed to the SwMI.

Static or Dynamic IP Address Assignment The terminals support static and dynamic IP address
assignment. The dynamic support is requested in the
following situations:

• Request a Dynamic IP Address is set to
Dynamic and the PD Application Type is the
radio internal PD application.

• Request a Dynamic IP Address is set to
Dynamic and the PD Application Type is a PEI
PD application requesting dynamic IP address.

2.16.3 PD User Authentication
The PD user authentication is a method of authenticating the Terminal Equipment user before allowing the packet
data link activation. A PD Authentication server connected to the SwMI performs the actual authentication. The
terminal only sends the messages between the Terminal Equipment and the SwMI. In the wide mode, the terminal
offers PPP user authentication between Mobile Terminal and Terminal Equipment using Password Authentication
Protocol (PAP) or Challenge Handshake Authentication Protocol (CHAP), before the IP link is established. The
terminal always attempts to negotiate usage of the CHAP method. However, the radio agrees to use PAP, when
the Terminal Equipment application insists. If the terminal does not require PD user authentication, it operates
without any user authentication. However, if the terminal requires the PD user authentication, it rejects the Packet
Data Protocol (PDP) context activation.

If the SwMI does not agree for the authentication method (for example, PAP), the SwMI can reject it.

2.17 TETRA Network Protocol 1
TETRA Network Protocol type 1 (TNP1) is a bridge protocol based on the TETRA layer 3 over the air protocol.
The TNP1 supports all TETRA dispatch functionality.
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In the TMO, the TNP1 specifies a protocol for use over the PEI, that allows terminal equipment (TE) to have control
over the TETRA services: mobility management, call control, short data service, and supplementary services:
send GPS reports, software information and battery state information. In addition, commands to access the radio
configuration and storage parameters are available.

The radio supports TETRA standard packet data using the IP network layer protocol.

The radio can operate both on the single slot packet data channel and the multi-slot packet data channel.

Packet data applications reside internally, for example: GPS reports, WAP, or in an external device connected to the
8–wire RS232 data port on the radio. Communication to the external device is initialized using AT commands.

The system provides point to point IP connectivity allowing the following datagram exchanges:

• Radio ←→ External Equipment (TE) (for example PC).

• External Equipment (TE) ←→ Network (through radio).

The radio supports IP version 4 packet.

TNP1 services can use one of two PPP methods to connect from the terminal equipment to the radio, local mode,
and wide mode. The TNP1 should be used in wide-mode wherever possible, to allow the parallel operation of
TNP1-SDS services and packet data services over a common PPP link.

If the transmit inhibit is entered, the radio drops the wide mode connection, thus the PEI goes back to AT mode.
Then the TNP1 client detects this change and reinitiates the PPP session in local mode.

The radio disables the TNP1 session while being in the DMO.

AT commands are used to initiate the PPP service for TNP1 to operate. Once the PPP session is running all AT
commands are blocked. When the PPP session is closed, AT commands are available.

2.17.1 TNP1 IP Addressing
Table 2-5 TNP1 IP Addressing

Addressing Mode Description
Wide Mode All TNP1 services are available including packet data

transfer towards the SwMI. The address used is the
dynamic address MS IP or configured statically.

Local Mode All TNP1 services are available except packet data
transfer. The addresses used are the two static addresses
TE IP: 10.0.0.101 and MT IP: 10.0.0.100.

Port Addressing The radio uses a fixed port address for reception and
transmission of TNP1 packets. The port number is
4024.

2.18 Mobility Services
Following is the description of the Mobility Services.
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2.18.1 Main Control Channel Frequencies
The radio can find a wide range of main control channels. The radio maintains stored lists of carrier frequencies
which are scanned in order.

1. A dynamic list of up to 32 discrete entries maintained only by the radio software.
2. A static list of up to 32 discrete frequencies specified by the operator that can be preprovisioned. The

system operator can modify this list using the programming tool.
3. A frequency range specification, using a specific offset, that can be preprogrammed in the factory. The

system operator can modify this range using the programming tool. Then the radio scans all frequencies in
25 kHz intervals in the specified range.

4. An additional frequency range specification. Having two separate range specifications allows for two
non-contiguous blocks of frequencies or two different offsets.

2.18.2 Control Channel Selection
Each TDMA frame on a given carrier is comprised of four time slots, of which any can be used as a physical
channel. The following types of physical channels are available:

• Traffic physical (TP) channel — used primarily for circuit call traffic.
• Control physical (CP) channel — dedicated only for signaling.
• Packed Data Control (PDCH) channel — dedicated for Packet Data traffic.
• Unallocated physical (UP) channel.

The following types of control channels are available:

• Main Control Channel (MCCH) — occupies the first slot of the main carrier.
• Secondary Control Channel (SCCH) — can be used to extend Control Channel capacity.

The following types of SCCH are available:

• Common SCCH
• Assigned SCCH

In addition to the MCCH, a cell can have up to three common SCCHs, which could occupy slots 2, 3 and 4 in the
main carrier. This solution provides the ability to distribute the radio population among up to four channels and so to
increase Control Channel capacity (at the expense of traffic channel capacity).

Until having received a specific parameter on a cell, the radio uses the MCCH. When the signal is received, each
radio maps itself to a particular common SCCH, and that SCCH operates as the MCCH for the radio.

This is a selling feature.

2.18.3 Multi-System Operation
Multi-system operation is supported as follows:

• List of Allowed Networks — The radio holds a list of up to 100 allowed network identities (MCC/MNC
combinations) that are considered friendly networks. The first network in this list must be the radio home
network. Each network can have an associated name that can indicate to the user which network it is.
The radio can perform initial cell selection and registration on these networks and only these networks.
Registration on any of these networks is performed using the radio ISSI and without migration signaling.
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The same ISSI is used on all networks. You can limit registration to the home network only, or to a selected
network only, and to ignore the other allowed networks.

• Home-Only Mode — In this mode the radio recognizes only the first system in the allowed list. As a result,
the radio registers only on its home network, even if a foreign network is in range and is found first.

• Selected Network Mode — In this mode the radio recognizes only the system in the allowed list that you
selected. As the result, the radio registers only on this selected network, even if another network is in
range and is found first.

• Services — The radio operates in all networks as it does in its home network. All calls are placed using
SSI addresses, and it is the SwMI responsibility to reject calls for subscribers or groups that cannot be
reached in the local system.

The telephony gateway interprets telephone numbers with the country code of the local country.
For example, if you dial the number 01256-48-4566 in the UK, it is treated as if you dialed
+44-1256-48-4566.

2.18.4 Registration

2.18.5 Roaming
The radio continually monitors neighbor cells and scans the highest ranked neighbor cell. When the state of the
highest ranked neighbor cell is sufficiently better than the serving cell, or when the radio has lost the serving cell, the
radio employs cell reselection procedures using the following methods:

• If not in a call — undeclared cell reselection.

• If in a call and not transmitting or link failure occurs — unannounced cell reselection.

• If transmitting in a call, and a neighbor has been scanned, and the cells are synchronized — announced
type-1 or type-2 cell reselection.

• If transmitting in a call and no neighbor has been scanned or the cells are not synchronized — announced
type-3 cell reselection.

For compatibility with systems that do not support type-1 or type-2 cell reselection, the radio can be provisioned to
never perform these types of reselections.

The radio decides on the need for cell reselection, based on comparison of the signal strength and the service
level between the serving cell and neighbor cells. The service level criteria are based on the following criteria
listed in priority order:

1. System Wide Services available (Local/Wide Trunking)

2. Security Class

3. Subscriber Class

4. Location Area (Home Location area)

5. Cell Load

The radio prefers a cell that has a higher service level to one with a lower service level. If the radio is operating on a
serving cell that has a lower service level than a neighbor cell, the radio roams to the neighbor, even during a call.
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During network reconfiguration, a significant number of radios registered on one cell may roam. This roaming can
cause major congestion on specific cells. In order to avoid the congestion on control channels for the specific cells,
the specified radios roaming should be distributed in time.

As the operation cannot be performed immediately for all the radios, some of the radios must wait longer to roam.
The time cannot be programmed not to cause any of the radios to have inferior roaming capabilities. Thus the
roaming time for the radios is randomized.

The randomization means that after roaming scenario starts, a radio is not sending registration parameters to other
cells at once but waits random time before sending registration PDUs to other cells. Link failures and other related
scenarios are not randomized not to cause any unwanted delays in restoring the link.

2.18.6 Seamless Handover
Seamless handover eliminates voice interruption during calls by enabling the radio to roam faster between cells
while transmitting. Faster roaming is possible because the radio asks its serving cell to perform the reselection and
the 'SwMI' performs all of the roaming signaling. The radio then moves straight to the traffic channel on the
new cell and continues the call without call restoration.

2.18.7 Air Interface Migration
The Air Interface Migration (AIM) feature enables the radio to migrate to a foreign SwMI, that is, the radio
registration in a foreign SwMI is allowed. The AIM also enables the radio to attach the groups in a foreign SwMI
and to make and receive calls and SDS.

The AIM services cover individual call, group call and individually addressed SDS or Status. In order to receive
group calls or group addressed SDS and Status from a group of the current network, the radio has to attach the
nominated group. The radio cannot migrate to a foreign network while it is in an active call. The radio also cannot
attach a foreign group on the current network hence no group-addressed status/SDS messages can be sent to home
network of the migrated radio. The AIM is also not supported when the MS is in a foreign SwMI.

This is a selling feature.

2.18.8 Dynamic Air Interface Migration
The Dynamic Air Interface Migration feature offers users a quick and easy way to switch between networks.
Depending on that setting, every time a radio is powered up or a talkgroup is changed, it automatically roams to the
assigned network. If a talkgroup has no particular network assigned, the radio stays on the current network.

This feature consist of three major functionalities:

• It allows your radio to dynamically select the appropriate network after your radio is powered up.
• If you change talkgroup to the one from a different network, radio will automatically migrate to this network
(in this feature it is possible to assign network to particular talkgroup in codeplug).

• It gives you an option to automatically migrate to a network which is available in the region (network needs
to be first pre-configured in the codeplug). It is useful in case of no service state as the radio will attempt to
establish communication with any available network.

This feature is useful where quick switching between networks is required, for example when entering a building
that uses its own infrastructure.

Dynamic Air Interface Migration and Auto Full Registration (Any Networks) features are mutually exclusive.
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2.18.9 Congested Cell Handling
This feature is used only during initial registration and when roaming between sites. It is not used when camped on a
site that has become busy or congested due to no free traffic channel to make or receive calls.

When the cell that the terminal is trying to register is congested, a special level-based algorithm is in the place.
Depending on the level of congestion the terminal is waiting for the registration or is rejected on that cell.

The terminal recognizes whether the cell is congested (Control Channel Congestion). The terminal tries to roam to
not congested cells first, ranking congested ones as secondary. The cell congestion is one of the service level criteria.

The following cells are never marked as congested.

• Last suitable cell — if there are no other suitable cells (during roaming or initial cell selection).
• Serving cell.

The feature is configurable using the CPS.

2.18.10 Subscriber Class
When the radio powers up, or whenever it performs ITSI attach or migration registration, it always uses its
provisioned Subscriber Class (SC).

When the radio registers on a cell that does not support any of its SCs, it participates only in services that have
the emergency priority.

Whenever the radio SC does not match the cell SC, the radio uses normal ranking procedures or does not roam to
the cell at all.

2.18.11 Subscriber Class by Talkgroup
The Subscriber Class by Talkgroup feature forces all the radios attached to the same talkgroup to have the same
Subscriber Class.

The Subscriber Class by Group feature helps to avoid issues as presented in the following scenarios.

• Preserving traffic channel capacity. For two cells having the same coverage and placed together to multiply
traffic capacity a number of radios is attached to Talkgroup 1 on the first cell and only one radio is attached
to Talkgroup 1 on the second cell. A group call uses two traffic channels (one on the first cell and one on
the second). In this scenario, multiplying traffic capacity would not work without the feature. However, as
radios on the same talkgroup are forced (by Subscriber Class mismatch) to roam to one cell, all the radios
should use only the first cell.

• Spreading radios population across cells and prohibit them from roaming. Many radios used on a small area
with multiple BTS coverage causes huge roaming traffic. A congestion occurs and as a result you would
not be able to communicate. However with the feature, radios do not roam to a cell with mismatched
Subscriber Class, what stops the traffic roaming.

A radio Subscriber Class changes when the user changes between talkgroups which are assigned to another
Subscriber Class.

Up to 16 Subscriber Classes can be configured (in the CPS) and talkgroups assigned to them. The assignment is
carried out by talkgroup GSSI or by folder (except Favorite) which the talkgroup was chosen from.

Talkgroup may be assigned to more than one Subscriber Class (either by folder or Talkgroup range). The first
assigned Subscriber Class is used. Upon receiving Subscriber Class from the SwMI radios change their Subscriber
Class to the received one. The Subscriber Class received from the SwMI over the air has always higher priority
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than Subscriber Class by Group. If a radio already uses the same Subscriber Class as the one received from the
SwMI, the current Subscriber Class is not changed. Subscriber Class received over the air is maintained after
powering down the radio. On powering, the radio on the default Subscriber Class or Subscriber Class assigned
to an attached talkgroup is set.

Favorite folders cannot be assigned to any Subscriber Class.

None DGNA talkgroup can be assigned to Subscriber Class. Any activity (assignment, changing, and so on) on
Talkgroups from DGNA range (GSSI above 13999999) does not cause Subscriber Class change.

Subscriber Class by Group is a selling feature.

2.18.12 Auto Full Registration (Any Networks)
This feature allows to use the radio on any network that was pre-configured in that radio, like it was its Home
network. This is useful when the radio loses its Home network coverage, but is within coverage of another network
(for example, if a radio travels between different locations). Note that calls between networks are not possible.

Air Interface Encryption services are not available when roaming to a different (not Home) network.

Dynamic Air Interface Migration and Auto Full Registration (Any Networks) features are mutually exclusive.

This is a selling feature.

2.19 Supplementary Services
Following is the description of the TETRA Supplementary Services (SS) that the radio supports in the TMO.

2.19.1 Dynamic Group Number Assignment
The radio supports dynamic addition and removal of talkgroups in its talkgroup list through TETRA Dynamic Group
Number Assignment (DGNA) and De-assignment signaling (SS-DGNA).

The radio responds to DGNA directed to it or to DGNA directed to a group the radio is attached to.

When a dynamic group number assignment to add a new talkgroup is received, the radio adds the group in the first
available spot in the talkgroup list in the codeplug. Then you can scroll to the talkgroup to select the group. The
codeplug determines which DGNA operations are allowed for a group.

Depending on the group type the following is allowed.

• Static — only selection is allowed.

• Semi-Static — selection and reassignment are allowed.

• Dynamic — selection, deassignment, and reassignment are allowed.
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2.19.1 Dynamic Group Number Assignment

The groups can be assigned as not attached, attached as scanned or attached as selected. Assignment of the group
through DGNA with attached as selected makes it the selected group of the radio. If the group is assigned with
attached as scanned, if it is not already in the currently active scan list, the radio adds this group to a SwMI
Controlled scan list and begins monitoring downlink signaling addressed to this group. The SwMI controlled list
holds up to ten groups, and the radio monitors these groups as well as groups in the user scan list.

If the talkgroup list is full when adding a new group, the radio rejects the assignment operation. If the SwMI
controlled list is full and the assignment is with attached as scanned, the attachment is rejected.

When a talkgroup de-assignment is received, depending on the codeplug settings (DGNA Operations field in
the Talkgroup List) the radio behavior is as follows.

• If the DGNA Operations field is set to Static or Semi-Static, the radio.

– leaves the talkgroup and the parameters assignments to folders unchanged.
– sends an acknowledgment PDU with notification the group definition has been removed.

• If the DGNA Operations field is set to Dynamic or if the group is not in the talkgroup list, the radio.

– removes the talkgroup from the talkgroup list (if the talkgroup is in the list).
– removes all the occurrences of the talkgroup from the folder list.
– sends an acknowledgment PDU with notification the group definition has been removed (also if the
talkgroup has been deleted, or the talkgroup does not exist in the radio).

In all the cases, the talkgroup is removed from all the scan lists as no matter if they are active or inactive.

If the de-assignment is for the selected group, the radio notifies that there is no group attached (when in the group
mode), and does not attach to another talkgroup automatically.

If the de-assignment is for an announcement group, the talkgroup is removed from the talkgroup list. Additionally,
all the groups that are associated with this announcement group do not have an associated announcement group.
If the currently selected talkgroup is associated with this announcement group, the radio stops scanning the
associated announcement group.

When the DGNA operation is successful, if the radio is provisioned for DGNA user notification, you are notified
about the operation. For example group added, group deleted. The notification is displayed until you confirm the
operation. In case you receive a call, the message continues displaying until you confirm it.

On viewing an assigned talkgroup notification, the radio provides the ability for the user to make that the group is
the selected group.

The radio supports the reception of a DGNA Assignment that is addressed to its selected talkgroup as a supergroup
of the selected group. All signaling addressed to the supergroup is monitored in addition to signaling addressed to
the selected group, any announcement or associated groups, and groups in the active scan lists.

When the selected group is unselected, the radio ceases processing signaling to the supergroup that was associated
with that selected group.

The radio receives the lifetime of the supergroup as part of the assignment signaling. If a subsequent assignment to
the same group is not received within that lifetime, the radio ceases monitoring that supergroup.

The radio also supports supergroups of scanned groups, such that a group addressed DGNA assignment received on
one of the user scan group addresses causes the radio to monitor all signaling addressed to that supergroup as long as
the scan group is being monitored, and as long as the supergroup lifetime lasts.

The following DGNA functionality is not supported.

• Call-related DGNA.
• Functionality of the authorized user.
• Network authentication before accepting DGNA.
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2.19.2 Ambience Listening
The Ambience Listening (AL) allows a console operator or dispatcher to monitor audio activity in the vicinity of a
specific radio without giving any indication to the affected radio.

When the radio receives a call setup message with an AL call, the radio accepts the call. Then the radio opens the
microphone, and begins transmitting without showing any indication of the call. Call acceptance and rejection while
active in another call follows the PPC rules.

The radio imposes no time limit on the transmission (the T311 is disabled). The radio continues to transmit until the
SwMI ends the call or you perform an action that releases the call.

If you attempt to start a service while the SS-AL call is in progress, the radio disconnects the call and initiates the
service you requested. The radio allows performing all actions that can be performed without releasing the SS-AL
call. These actions include access of most menu items, changing modes, activating, deactivating scan lists, and
changing talkgroups. When change talkgroups, the radio appears as if it is performing an attachment. The attachment
appears to be successful, but the actual attachment signaling is performed only after the SS-AL call terminates.
When performing the attachment after the call, no indication will be shown to the user unless the attachment fails.

2.19.3 Pseudo Power-Down
If you attempt to power down the radio, the radio appears to turn off. However, it remains fully operational from
Layer–3 and below. The radio has a blank screen, and all LEDs are turned off.

When the SS-AL call ends in this pseudo power-down state, the radio turns off.

If you attempt to power up the radio from the pseudo power-down state, the radio acts as if it is really powering up.

2.19.4 Preemptive Priority Call
If during a call, a call setup is received for a call with higher priority than the present call, and the new call priority is
Preemptive Priority 3 (value 14 in the codeplug) or Preemptive Priority 4 — Emergency (15), the radio disconnects
from the present call and joins the new high priority call.

If the call priority of the new call is Preemptive Priority 1 (12) or Preemptive Priority 2 (13), depending on
configuration the radio either accepts or rejects the new call.

When the new call is accepted, a special tone is played, and you are notified of the high priority call.

2.19.5 Transmit Inhibit Mode
The Transmit Inhibit Mode is a mode in which the radio sends no radio transmissions. It is recommended to
activate the mode in RF sensitive areas, for example hospitals, airplanes, where safety can be jeopardized due
to transmission radiation.

To activate, selectMENU →More . . . → Networks → TXI Mode → Activate.

In this mode, the radio does not transmit under any circumstances except for the Emergency Calls. All the functions
and keys which cause transmission, for example registration to the network, changing talkgroup or folder, sending
SDS messages, or pressing the PTT button are disabled. Any transmission trial causes the radio to display Not
Allowed In TXI Mode notification and to play a tone.
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2.19.5.1 Transmit Inhibit Mode (Operation)

Your radio can still receive:

• Group calls.

• Messages — stored in the Inbox.

• Private call attempts — stored in theMissed Calls list, without the option to respond.

When no danger to safety exists anymore (for example, you leave the RF sensitive area), you can deactivate the
Transmit Inhibit Mode and the radio returns to standard operation.

You can deactivate the mode by selectingMENU → More . . . → Networks → TXI Mode → Deactivate,
pressing One-Touch button, or implicitly when initiating an Emergency Call.

RF Transmissions from the radio are prevented under the following conditions:

• TXI Mode is activated.

• The radio is turned off.

2.19.5.1 Transmit Inhibit Mode (Operation)
On entering or exiting the transmit inhibit mode, when the radio is camped on a cell, it sends a specially designated
SDS status message. This SDS message indicates to the SwMI that the radio is entering or exiting transmit inhibit
mode.

In transmit inhibit mode the radio is prevented from initiating any non-emergency call or service. The radio does
not send any low layer initiated transmission. All the menu entries and buttons, which cause the radio to transmit,
are disabled. Mobility procedures that do not require the radio to send an uplink transmission are performed
except for cell reselection.

In transmit inhibit mode the radio joins group calls for any group that the radio is monitoring, but the transmitting on
that call is still prohibited.

If you initiate an emergency call, the radio immediately leaves transmit inhibit mode and attempt to start the
emergency call if the radio is in service.

2.19.6 Calling Line Identification Presentation
If the radio is provisioned with the calling line identification presentation (CLIP), the calling party number is
transported as part of the incoming call setup signaling. Also the calling party number is shown on the radio
display. If the calling party ID is programmed in the radio with a corresponding name, the name is displayed in
addition to the number.

The number sent by the SwMI is expected to be in a form that can be used to call back the calling party at
any other time. Thus, for instance, the number can be stored in the address book.

If the calling party number is not present in the incoming call setup signaling, a blank line is displayed in its place.
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2.19.7 Late Entry
The user can join the groupcall even if not participating in it from the beginning. This is possible for example, if a
user turns on their TETRA terminal, in such a case the control channel automatically diverts the user's terminal
to a talkgroup call, if a call is already in progress. Similarly, if the user's terminal has been outside of the radio
coverage, for example in a tunnel, the control channel will also divert the user's terminal to a talkgroup call
assuming a call is already in progress.

This feature must be configured on SwMI. Acknowledged late entry, and late entry paging are not
supported.

2.19.8 Talking Party Identification
The PDUs and facility elements for these TETRA Supplementary Services are not supported. However, identification
presentation functionality is supported in most cases using the information found in the call setup messages.

2.19.9 DTMF Overdial
This supplementary service allows the radio to send DTMF tones to both internal and the external network during
the call (conversation).

2.19.10 Universal Time Display
The radio can present time information to the user. The time is derived from an internal clock. The radio maintains
the clock both when the radio is powered on and powered off.

If the power is lost the internal clock is not maintained.

If the maximal deviation between this time and the internal clock time is less than a value set in the codeplug, the
time received from the SwMI is updated.

In order to ensure the time displayed is accurate, the time is displayed only if within the last 48 hours either of the
following events have occurred.

• The radio has received a network time update from the system.
• You have manually updated the time.

If neither of the events have occurred within a 48 hour period the time is no longer displayed.

As the internal clock is not maintained after a power loss event, the time is not displayed until either of the
following events occur.

• The radio has received a network time update from the system.
• You have manually updated the time.
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2.20 General Purpose Input Output

The feature is enabled or disabled and the default configuration set for the radio using the CPS.

The radio display supports the following.

• Twenty-four-hour and twelve-hour formats.
• DD/MM/YY, MM/DD/YY and DD-MON-YY date formats.
• Adjustable time offset.

You can change the time information through the MMI (depending on the codeplug settings). System broadcast
information has higher priority than data entered manually. Thus time, date, and offset information entered from the
MMI is overwritten, when data is received from the SwMI. The radio provides user indications upon crossing to
another time zone, when a new MCC broadcast received.

2.20 General Purpose Input Output
In total there are three General Purpose Input Output (GPIO) ports on the transceiver device and four GPIOs on the
New Generation Control Head (NGCH). The GPIOs on the NGCH are accessible in remote mount configuration
only. The following default functionality is available through the transceiver GPIOs.

• Transceiver GPIO1 is associated with External Alarm.
• Transceiver GPIO2 is associated with Audio PA Enable.
• Transceiver GPIO3 is associated with Hook.

The following default functionality is available through the GPIOs located on the NGCH device.

• NGCH GPIO1 is disabled.
• NGCH GPIO2 is disabled.
• NGCH GPIO3 is associated with PTT CH Rear.
• NGCH GPIO4 is disabled.

The General Purpose Input ports can be associated with the following functions.

• Send Predefined Message.
• Send Status.

If the send status is selected, then on triggering of GPIO1/GPIO2 the radio sends a status message to the GISSI
on which the radio is currently attached.

If you are sending SDS using the MMI and SDS through GPIO at the same time, the SDS sent over GPIO shall be
rejected without any notification.

The General Purpose Output ports can be associated with the following functions.

• Specific Message Received Indication.
• Rx/Tx Indication.

The GPIO1/GPIO2 is activated when any SDS is received on selected Protocol Identifier (PI), except
the SDS and the long SDS PI.

If the Rx/Tx indication function is selected, whenever the radio is opening up a microphone/speaker for voice,
independent of the call type NGCH GPIO1/GPIO2 is activated.
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2.21 Data Box Radio
This feature allows transceiver to work without NGCH in a special data box mode. In this mode, the data box radio
is controlled through PEI with AT commands or TNP1 commands.

The data box radio is a feature supporting users who want to use the transceiver with third-party control radios.

The data box radio feature allows setting CH mode for transceiver operations using the CPS.

The data box radio is a fully functional mobile radio without a control head connected. Depending on the
CPS settings, when the NGCH is connected, the radio switches from the data box radio to standard radio.

To power the radio on use the Accessory Connector and Expansion Head Enhanced connector pins dedicated either
to Ignition (high level) or Emergency (low level). To power off the radio use the Ignition available on the Accessory
Connector and Expansion Head Enhanced connector.

The radio operating in data box mode supports all the features which apply to the radio with an NGCH except
for these features which require interface interactions.

The radio in data box mode supports the following software selling features.

• GPS

• Multi-Slot Packet Data

• Enhanced Security

• Permanent Disable

• Permanent Disable v2

• SCCH

2.22 SDS Remote Control
The SDS remote control feature enables controlling a radio through Air Interface using SDS-TL bearer service.
A controlling terminal (for instance, a controlling radio or SwMI controlling terminal) sends the SDS remote
control messages.
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2.22 SDS Remote Control

Figure 2-5 SDS remote Control Overview
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The SDS remote control functionality works in both TMO and DMO and the remote control PDUs are sent using TE.

You can use the feature only after a successful authorization, which requires entering a valid remote control PIN
number.

The remote control messages can be sent to a group or individual radios.

A controlled radio receives over the air control information using SDS type 4 with TL on the specific PID number
defined in the codeplug. If the received control message is originated from one of ISSIs present on the radio
authorized ISSI list, the radio executes received command and sends a response.

The SDS remote control enables the following:

• Switching between TMO/DMO modes (read, change, notify) for individual radio and group (using +CTOM
AT command).

• Selecting a talkgroup (read, change, notify) for individual radio and group (using +CTGS AT command).
• Reading and setting the scanning state (using +CTSCAN AT command).
• Collecting Network Information from individual radio (Network Registration Status and Cell Signal Quality
using respectively the +CREG and +CSQ AT commands).

• Setting volume level for individual MT (using +CLVL AT command).
• Rebooting the radio (using R AT command).
• Terminating a call (using H AT command).
• Call forwarding (using +MCCFWD AT command).

The available commands configured in the codeplug:

• Audio Control
• Group & Mode Management
• Network Information

The remote control protocol used for sending the remote control commands is based on the existing AT commands
protocol.
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This is a selling feature.

2.23 Call-Out
A call-out is an alert sent to one or many recipients when an incident requires immediate attention. The call-out
message can include an instruction to use a different talkgroup for the duration of the call-out or remain on
the attached talkgroup.

There are four types of Call-Out alerts:

• Normal
• Storm Plan
• Fallback Mode
• Test Call-Out

Only the emergency mode has higher priority than the call-out. When you receive the alert, the following responses
are available.

• Accept— additional information from the dispatcher is displayed.
• Stand by— voice and message communication is the same as for Accept.
• Reject— display returns to the home display and the talkgroup is set to the one before the call-out.

Call-out alert can be addressed as follows:

• ISSI — an individual.
• GSSI — a group of recipients.

All incoming and outgoing call-out messages are stored in CO Box (Call-Out Box) and can be managed through
the MMI. There is a two-level structure for the alerts. First level is the main alert list, and the second one are all
the messages associated with the alerts. Both lists are displayed chronologically with the newest on top. The
capacity of the CO Box is ten call-out alerts and 100 messages (incoming/outgoing). It has also the overwrite
policy which deletes the oldest one upon receipt of a new call-out message. When a new call-out arrives, the new
call-out overrides the old call-out (even if it has not been responded). An ongoing call-out overrides the old one in
any phase of the call-out alert.

In normal mode, you can browse the CO Box and read all the call-out messages. In the call-out mode, you can
only read the ongoing call-out messages.

The call-out service function in two main phases:

1. Alert Phase — you receive the alert with the associated messages that you can respond to. These messages
provide all the important information about an incident. A special tone is played when the alert is coming
in. The tone volume range is configured in the codeplug and cannot be adjusted through the MMI. The
conditions for stopping this tone are configured in the codeplug (for example, upon pressing any key).
Additionally, an ongoing alert tone is paused on incoming call-out group call. This alert is resumed once
the call ends (if not stopped before).

2. Information Phase — you are in the call-out mode and you may receive more messages about the incident
with the text or voice. You can also query for more information using the voice group call or the call-out
text function which enables to send a text message to the dispatcher host application. The voice message
can be sent with the high priority as a group call. You can answer back to the group or to the dispatcher
using the voice group call. You may receive more info about the incident via either via subsequent text or
voice messages

This is a selling feature.
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2.23.1 Call-Out Interactions

2.23.1 Call-Out Interactions
When you received a call-out alert while being in the emergency mode, the message is ignored.

In the transmit inhibit mode, you can receive call-out messages. However, you cannot respond until the transmit
inhibit mode is deactivated. When you decide to leave the transmit inhibit mode after viewing the message, the
radio prompts to accept, standby, or reject the call-out.

The call-out feature is not supported in DMO.

In the fallback mode (that is, when you are in the local site trunking) you can receive a call-out call. The receiving
radio enters the call-out fallback mode, which includes only voice communication, on receiving the call-out call.
You may clear the fallback mode only manually.

The dispatcher can test the feature by using the call-out test. The radio displays then Call-Out Test and generates
the alert tone. Only one soft key is available through the MMI with the label Test OK. After responding the
display return to the previous mode.

Storm plan alert is a special case of call-out. This alert is sent out to the larger group of people. You can respond
with any key stroke and afterwards you proceed to the information phase. The storm plan alert is sent several
times to raise reliability.

2.24 Radio Messaging System
The Radio Messaging System (RMS) feature enables radios to receive and send RMS messages through the TETRA
network using the Short Data Service (SDS) Transport Layer (TL).

Figure 2-6 Radio Messaging System Flow Model
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A Short Data Router (SDR) provides TETRA short data services between host applications connected to Dimetra
Mobile Stations or between a host application connected to a Dimetra Mobile Station and a host application
connected through the Dimetra Master Site. Furthermore the SDR provides TETRA short data services directly
between two Dimetra Mobile Stations or directly between a Dimetra Mobile Station and a host application
connected through the Dimetra Master Site.

To receive and send RMS messages, ensure that the RMS feature is enabled in the codeplug. The radio accepts
received RMS messages only from the calling party address defined in the codeplug. Any outgoing RMS status is
sent to the RMS status target address defined in the codeplug.
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The RMS status is a bidirectional messaging (from the control room to a radio and conversely). Sending an RMS
status is possible, where the RMS mode is enabled in the radio. In such case, the radio user can send one of ten
predefined RMS statuses to an address predefined in the codeplug. You can select the particular RMS status using
assigned one-touch buttons. A received RMS status is displayed in blue color on the idle display. The latest received
or sent RMS status is kept on the idle display until the next power cycle.

The RMS free text is a unidirectional message (from the control room to a radio). Received RMS free texts are
displayed in blue color on the idle display. The latest RMS free text is kept on the display (idle display) until the
next power cycle.

Upon receiving the request, the radio sends the latest sent RMS status to the control room without any user
interaction or notification.

Incoming and outgoing RMS statuses and RMS free text messages (with the exception for RMS status sent) are
stored in the RMS Box. The RMS Box capacity is maximum ten entries for incoming and outgoing RMS messages.
If the RMS Box is full, storing any new incoming or outgoing RMS message overwrites the oldest message
(received or sent) in the RMS Box.

This is a selling feature.

2.25 GPS Location Service
The GPS Location Service feature uses information from Global Positioning System (GPS) satellites orbiting the
Earth to determine the approximate geographical location of your radio.

The GPS Location Service availability, accuracy, and the position calculation time vary depending on the
environment in which you use the radio. The GPS Location Service can assist your dispatcher or colleagues in many
ways such as more efficient deployment of resources or locating your radio when you trigger your emergency service.

The radio can display the location information directly on the screen or send it over the air to your Dispatcher to
display it in the control center. Check your radio configuration details with your service provider.

Where the signals from satellites are not available, the GPS Location Service does not work. This situation
usually happens when your radio cannot establish a view of a wide area of open sky, for example, when
your GPS antenna is covered or facing the ground. Such situations include being:

• In underground locations
• Inside buildings, trains, or other covered vehicles
• Under any other metal or concrete roof or structure
• Near a powerful radio or television tower
• In extreme temperature outside the operating limits of your radio

Even if your location information can be calculated in such situations, it may take longer to do so. Therefore, in any
emergency situation, always report your location to your dispatcher. Where adequate signals from multiple satellites
are available, your GPS Location Service feature provides a location, most probably near to your actual location.
For GPS feature performance, under ideal test conditions see Table “GPS Specification”

The radio can be triggered to send Location Reports in various circumstances, for example:

• Upon a request
• Entering Emergency Mode
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2.25 GPS Location Service

• At specified time intervals
• At specified distance intervals

The Location Reports can be sent in two ways using:

• SDS
• Packet Data

If the Location Reports are sent over the Packet Data, a Packet Data icon is displayed when the message is being sent.

If the Location Reports are sent via SDS with User Defined Data Type-4 as a transport layer, either the ETSI
Location Information Protocol (LIP) or Motorola Location Request/Response Protocol (LRRP) GPS Location
Protocol is used. The LRRP GPS protocol either use SDS-TL (for added reliability) or Simple GPS with no SDS-TL
(for saving air interface resources). GPS Protocol Identifiers are:

• LRRP SDS TL = 131
• LRRP Simple GPS = 3
• LIP GPS = 10

Location reports are sent in TMO and can also be provisioned to be sent in DMO. If the radio is provisioned to
provide user indications, the feature operational status is indicated on the radio display.

Depending on the radio configuration, viewing the radio position and the status of the visible satellites is available.
The position may consist of longitude and latitude, UK, or Irish grid coordinates. The GPS Location Service feature
can be enabled or disabled as a whole using the CPS. It is possible to configure the feature parameters using the
CPS, or over the air. The CPS configuration provides a default profile. The commands received over the air may
overwrite the default profile configuration. The profile assigned to the radio determines when to send location data,
what data to send with what accuracy and to what address. All data requests and configuration commands received
over the air are checked to confirm they have come from a trusted source. Location reports are accepted only from
authorized ISSIs or IPs, depending on the configured transport layer (SDS, Packet Data).

Ensure the application receiving location messages and the radio are configured in a corresponding way.
Otherwise the radio will reject all system GPS requests.

The radio supports GPS triggers functionalities (using LIP or LRRP) to report GPS positions when the radio meets a
set of criteria. The following triggers, together with their specific parameters, can be set up by service provider:

Table 2-6 GPS Triggers

Trigger Type Trigger Event
Power-up Radio powers up in TMO.

Power-down Radio powers down in TMO.

Emergency
condition

Radio enters emergency operations.

Periodic Given time interval after the last location report expires.

Moved Radio position has changed by at least the distance defined (the radio checks the movement
from the last known position at an interval).

TMO ON Successful registration on entering TMO from DMO.

DMO ON Before TMO deregistration, and before entering DMO.
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Table 2-6 GPS Triggers (cont'd.)

Trigger Type Trigger Event
Transmit Inhibit
Mode ON

Radio is about to enter TXI.

Transmit Inhibit
Mode OFF

Radio has successfully registered after leaving TXI.

Low battery Radio detects its battery level has reached or fallen below the level specified by service
provider.

Loss of GPS Radio detects a loss of GPS for a minimum duration defined by service provider.

Recovery of GPS Radio detects a recovery of GPS signal for a minimum duration defined by service provider.

Status entered Radio sends a status defined in the CP for location reporting by pre-programming.

DCK Connected Radio detects that a Car Kit has been connected.

DCK Disconnected Radio detects that a connected Car Kit has now been disconnected.

GPS ON Positioning device has been switched ON.

GPS OFF Positioning device in the radio is about to be switched OFF.

Emergency
Periodic Profile
(LRRP only)

Radio is in emergency operation and given time interval after the last location report expires.

This is a selling feature.

2.25.1 GPS Accuracy
The GPS Location Service accuracy depends on the GPS coverage and the selected accuracy mode. In good GPS
coverage (at least -137 dBm or in open sky), the location accuracy presents as follows:

The presented values depend on variety of factors, for example the view on the sky. In order to optimize
the GPS performance the radio should have the clearest possible view of the open sky.

2.25.2 GPS Military Grid Reference System
The Military Grid Reference System (MGRS) is the geocoordinate standard used by the military for locating
points on Earth. The MGRS attempts to represent the entire surface of Earth on a worldwide grid. The grid is
based on the UTM (Universe Transverse Mercator) between 80°S and 84°N latitudes and UPS (Universal Polar
Stereographic) systems.

The UTM area is divided into 60 longitudinal strips, each 6° wide. The strips are numbered 1-60 beginning at the
180°-174° W (Zone 1) and increase to the East. Each strip (or Zone) is then divided (horizontally) into 8° latitude
bands.
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2.25.3 GPS Different Location Displays

An example of an MGRS coordinate would be 19TDJ3858897366, which consists of:

• 19 is the UTM Zone Number
• T is the corresponding UTM latitude band letter
• DJ is the MGRS Grid Reference used to define the 100 km square within the UTM/UPS block.
The columns A-Z (excluding "I" and "O"), like UTM, start at 180° and increase towards the East.
Every three columns, the pattern repeats. Letters designating rows, increase towards the North. The
letters cycle backwards through the alphabet in the southern hemisphere (towards the South):

– D is the MGRS column letter
– J is the MGRS row letter

• 38588 is the 5–digit MGRS Easting value. It represents the number of meters East of the origin
(that is, southwest corner) of the 100 km square in which it is contained.

• 97366 is the 5–digit MGRS Northing value. It represents the number of meters North of the origin
(that is, southwest corner) of the 100 km square in which it is contained.

MGRS Support feature can be programmed in CPS. The user can choose to display the GPS coordinates in MGRS
format.

This is a selling feature.

2.25.3 GPS Different Location Displays
Table 2-7 Different Location Displays

Latitude /
Longitude UK Coordinates Irish Coordinates UTM Coordinates MGRS

Coordinates
Time Time Time Time Time

Latitude 2–Letter Code 1–Letter Code 3–Letter Code 3–Letter Code and
2–Letter Code

Longitude Easting and
Northing Coordinate

Easting and
Northing Coordinate

Easting and
Northing Coordinate

Easting and
Northing Coordinate

Altitude Altitude Altitude Altitude Altitude

Satellites Satellites Satellites Satellites Satellites

• Time — indicates when the last time the location was calculated. The time is provided in Universal Time
Coordinated.

• Letter Code — grid zone or square on the map for different coordinate standard
• Latitude — expressed in degrees, minutes, and seconds.
• Longitude — expressed in degrees, minutes, and seconds.
• Number of satellites — used to calculate the location. In general, more satellites make for better accuracy.
The maximum is 12 satellites.

• Easting — refers to the eastward-measured distance expressed in meters.
• Northing — refers to the northward-measured distance expressed in meters.
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Skipping each digit of easting and northing coordinates decreases the accuracy by the factor of 10.

2.26 WAP
Wireless Application Protocol (WAP) is a standard for application layer network communications in a wireless
communication environment such as TETRA network. The protocol is used to access the mobile web from a
radio through a WAP browser.

This is a selling feature.

2.26.1 WAP Browser
The Openwave Mobile Browser is a WAP-complaint user agent. The WAP browser provides all of the basic services
of a computer-based web browser. Whenever any preemptive display interrupts the browser session, the browser
needs manual reactivating to return. The WAP browser does not support right-to-left languages (as Arabic and
Hebrew); English is used instead. For the content in these languages, the characters are not displayed.

2.26.2 WAP Push
WAP push allows WAP content to be pushed to a radio. This push is carried out by sending a specially formatted
(Push Access Protocol) XML document to the Push Proxy Gateway, that in turn forwards the document to the radio.

A WAP push message is an encoded message including a link to a WAP address. On receiving a WAP push,
a WAP enabled radio automatically gives the option to access the WAP content. The implemented WAP push is
compliant to WAP 2.0 standard.

The radio supports WAP 2.0 through a proxy only. Proxy-less connections are not supported.

This is a selling feature.

2.26.2.1 WAP Push Framework
A push operation in WAP is carried out by allowing a Push Initiator (PI) to transmit push content and delivery
instructions to a Push Proxy Gateway (PPG). The PPG delivers the push content to the radio as per to the delivery
instructions.

The PI is an application running on a web server and communicating with the PPG using the Push Access Protocol
(PAP). The PPG uses the Push Over-The-Air (OTA) Protocol to deliver the push content to the radio.
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2.26.2.2 WAP Push Service Indication

Figure 2-7 Push Framework
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2.26.2.2 WAP Push Service Indication
The service indication (SI) presents a notification and an associated URL with a prompt to enter the URL on the
radio display. The notification is then stored in the WAP box for subsequent presentation.

The SI can be valid only for a certain amount of time. After the specified time elapses the SI indicates void content.
The author of an SI can set the expiration date and time, that is, when the SI is automatically deleted from a radio.

The service provider can remotely delete SIs that became invalid. The removal is carried out through sending a
special SI to delete the invalid entity.

A new SI is indicated with a respective status icon, tone, and a pop-up. The pop-up occurrence depends on the
SI priority (high and medium) and the radio conditions (for instance, if the radio is in a call the pop-up does not
appear). Depending on the periodic alert feature availability, a notification of an unread SI can be indicated with
periodic notification, similarly to an SDS message.

2.26.2.3 WAP Push Service Load
Service Loads (SL) differ from the Service Indications (SI) by the fact they do not prompt to enter the URL. Instead,
the browser is automatically activated. The SL contains an URL indicating what service to load.

A new SL is indicated with a respective status icon, tone, and browser activation. The browser activation depends on
the SL priority (high) and the radio conditions (for instance, if the radio is in a call, the browser does not display).

SL messages sent with urgency cache can be not indicated directly to the user. Such SL messages load content and
store it in the cache (the process works in the background, only the PD icon is visible to the user).

2.27 Radio User Assignment and Radio User Identity
Radio User Assignment (RUA) and Radio User Identity (RUI) enables authentication for providing full access to
the infrastructure and the physical radio.

Where the RUI feature is enabled, on logging on to the radio you enter your User ID with the PIN to check your
identity. Only the successful logon provides the full access. A logon failure results in limited service.

Where also the RUA feature is enabled, after successful RUA/RUI authentication you are logged on to the physical
radio. Thus, you can still be reached at your radio number.

You can differentiate the RUA/RUI state by the interface color. Blue for logged on and gray for logged off. No
additional icon indicates whether you are logged on.

Besides the logged on off states, the radio can also be in the pseudo log on state indicated by the relevant icon.
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The User ID is stored in the RUI List. To verify who is logged on to the radio, see the second line in the RUI list
(the first line is New User ID).

RUA/RUI is a selling feature.

2.27.1 RUA/RUI Logging On
You can log on yourself or the dispatcher can log you on. The feature must be enabled in the codeplug, by your
service provider.

After turning on the radio, the infrastructure verifies a request from the radio and checks if it supports the RUA/RUI.
When the infrastructure accepts RUA request, you are asked for RUI and RU-PIN. After providing correct
information, a successful logon occurs and full access is granted for specified time.

When a RUI and/or RU-PIN are incorrect, a logon failure occurs. The infrastructure sends the RUA reject signal
to the radio. If enabled in the codeplug, limited service access is granted.

When the dispatcher is sending the RUA accept signal to the radio with the time period that the full service is
granted, then the successful book on occurs.

2.27.2 RUA/RUI Radio Behavior
When the radio is logged off and receives RUA accept from the infrastructure without sending logon information, it
indicates book on with assigned logon period timer. The radio sends automatically book on response according
to the terminal settings: Book on Reject — the radio rejects all the book on, Book on Accept — the radio
accepts all the book on.

To log off, use the radio menu. The dispatcher has also the option to log you off using Force Off setting.

The pseudo log on is a state which occurs when the RUA/RUI authenticated radio goes to LST, or infrastructure
accepts the logon with the empty granted assignment period. In this state, the radio has the full functionality
available except some services as forwarding calls. This state is signalized with a specific icon.

The RUA/RUI feature is specified with the following timers:

• Logon Process Timer — defines the amount of time during which the radio awaits log on response from
infrastructure.

• Time Out Warning Timer — defines the amount of time after which the radio displays the warning.
• Logon Period Timer — defines the amount of time during which the radio is logged on.

2.27.3 RUA/RUI Interactions
When you switch from TMO to DMO, the terminal logs off (depending on the codeplug settings). When you switch
from DMO to TMO, the radio initiates the log on process.

You may be RUI-authenticated when out of coverage. In this situation, the radio is in pseudo logged on status.
All the timers are the same as for the logged on user with the coverage. You may also be logged off when out of
coverage. In this situation, the radio is provided with the limited service access. In both cases, if the radio is back in
the coverage area and receives RUA request from SwMI, it prompts you to log on.

If during the emergency operations you receive the force-off, it logs you off without exiting the emergency
operations. As long as the radio is in the emergency operations, the radio display does not indicate any change.
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2.28 Picture DMS

When the radio turns on in the LST, it prompts for the PIN. If the correct PIN is entered, the radio switches to the
pseudo logged on state. When you move to the LST, the radio switches to pseudo logged on state. However,
no prompt for the PIN occurs.

When you change to a different physical terminal, the store and forward report is routed to the radio where you are
currently logged on. When the radio receives store and forward report, it does not display the report, as the reports
have to match the sent SDS. If an SDS consumer report is requested, it is recommended that the receiver sends an
explicit separate SDS message to confirm the message has been received and read. The report is stored together with
the sent SDS in the Outbox, because of that when you log off, delete the messages from the Outbox. When you
change to different physical radio, the previous permanent radio does not receive the report. The status of store and
forward message in the Outbox cannot be updated.

2.28 Picture DMS
Picture DMS is a unique signature generated and ascribed to each picture upon its capturing. It allows authenticating
pictures captured by Motorola radios so that they can be used as supporting evidence, for example, in a court of law.
An existing picture DMS cannot be modified or overwritten by another one. Any alteration attempt invalidates
the picture DMS.

Since DMS signatures are stored in the internal radio memory, they cannot be viewed by end users and only the
service provider can access them.

The radio can contain up to 1000 items. If no space for signatures is left, the pictures are still captured and stored,
but without generating DMSes.

Upon Terminal Permanent Disable all picture DMSes are erased and cannot be recovered.

This is a selling feature.

2.29 EXIF Data
EXIF data (EXchangeable Image File Format) is additional technical information about the picture and the radio
that is saved within special tags inside JPEG files. Except for standard EXIF tags, Motorola radios support the
following TETRA-specific tags:

• Full time and date

• GPS position

• Radio ISSI

• Talkgroup

• Site ID

EXIF tags cannot be viewed on the radio. To manage them, you need to use an appropriate application capable of
reading EXIF data.
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3 Man-Machine Interface

3.1 Controls, Indicators and Related Features

3.1.1 LED Indications
Table 3-1 LED Indications

Indication Status
Solid green In use

Blinking green In service

Solid red Out of service

Blinking red Connecting to the network

Entering DMO

Solid orange Transmit inhibit in service

Channel busy in DMO

Blinking orange Incoming call

No indication Idle

Radio powered down
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3.1.2 Controls and Indicators
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3.1.2 Controls and Indicators

Table 3-2 Controls and Indicators

Annotation Description
1 EMERGENCY button

Press and hold EMERGENCY button to enter Emergency operation. By default, when
your radio is off, press and hold to power on in Emergency Mode.

2 ROTARY KNOB

• Press and hold to turn your radio on.

• Rotate to set the volume.

• Press and rotate to select a different talkgroup.

• Press and hold the ROTARY KNOB to lock/unlock it. Powering off also unlocks a
locked ROTARY KNOB.

3 DISPLAY

Provides alphanumeric text and images within 65,536 colors and 640 x 480 pixels with
backlighting and scalable fonts.

Before using your radio for the first time, remove the plastic lens protector
from the display.

4 SOFT key

Press upper or lower SOFT key, to select the option that appears on the screen next to it.

5 ON/OFF/END/HOME key

• Press and hold to turn on/off your radio.

• Press to end calls.

• Press to return to the home screen.

6 NAVIGATION key

Press up, down, left or right NAVIGATION key for list scrolling, while moving around the
menu hierarchy, or for alphanumeric text editing.

From the home screen, press to activate one of the following:

• down NAVIGATION key — enters Recent Calls menu item.

• up NAVIGATION key — changesMy Groups talkgroup folder.

• left and right NAVIGATION key — toggles through the talkgroups.

7 KEYPAD

Use the keypad to enter alphanumeric characters for dialing, contact entries, and text
messages.

8 LED
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Table 3-2 Controls and Indicators (cont'd.)

Annotation Description
9 MOBILE MICROPHONE PORT

Provides connection for accessories such as fist microphone with PTT.

10 MENU key

Press to enter the main menu and the context-sensitive menu.

11 SEND key

Press to initiate or answer duplex calls, or send messages.

12 EXTERNAL ALARM key

Press to activate One-Touch Button feature (activates/deactivates the horn and lights by
default).

13 SPEAKER CONTROL key

Press to activate One-Touch Button feature (turns the speaker on/off by default).

14 BACKLIGHT key

Press to activate One-Touch Button feature (dims the backlight by default).

15 PTT (Push-To-Talk)

• Press and hold to talk in simplex calls or to initiate a group call, release it to listen.

• Press to send status and text messages.

16 MICROPHONE

• It is recommended to turn off the terminal before connecting any of the accessories.
• A detailed list of compatible accessories is included in Accessory Leaflet, part number:
6866539D39. To obtain the document, contact your service provider.

3.1.3 Keypad Lock
You can lock the keypad to prevent accidental pressing of keys. The keypad lock can be invoked using the menu
or predefined menu shortcut (by default ).

By default, while the keypad is locked, all front and side keys (including PTT) are inoperative except for the
ON-OFF and EMERGENCY buttons. The PTT button behavior can be set in the codeplug.

When an incoming emergency call is received, the PTT button automatically unlocks for the call duration.

When the keypad is locked one of the following is displayed:

• Nothing — no notification is displayed.
• Notification Only— Keys Locked is displayed.
• Notification and Instruction— Press Menu and * to unlock is displayed.
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3.1.4 Automatic Keypad Lock

The displayed option can be set in the codeplug. By default it is set to Notification and Instruction.

3.1.4 Automatic Keypad Lock
The automatic keypad lock is a feature enabling the radio to lock its keypad automatically after a defined period.
The radio allows activating or deactivating the feature using the MMI. If the feature is enabled, after a defined time
of inactivity the keypad locks automatically. Any user activity restarts the Automatic Keypad Lock timer. When
the keypad locks automatically, the following notification is displayed Keypad auto locked. You can change the
time value required for the automatic lock through the MMI.

3.1.5 One-Touch Button Feature
To use One-Touch Button feature press and hold an assigned key to activate one of the following features:

Table 3-3 One-Touch Button Features

Feature Description
Backlight Switches backlight settings.

TMO Talkgroup Scan Turns on/off the Talkgroup Scan feature in TMO Mode.

DMO / TMO Switch Switches between TMO and DMO Mode.

Sending Status Sends a dedicated status message to a dedicated address.

Change Talkgroup Changes the talkgroup to the predefined by your service provider.

Hi/Low Audio Activates high/low audio.

Sending User Defined Message Sends a predefined/user defined template to a dedicated address.

Transmit Inhibit (TXI) Turns on/off TXI Mode.

Private Call Initiates a private call to a predefined entry in the contact list.

Phone Call Initiates a phone call to a predefined entry in the contact list.

PABX Call Initiates a PABX call to a predefined entry in the contact list.

Screen Saver Turns on/off the Screen Saver feature.

Display Time Shows time and date on a display.

Covert Mode Turns on/off the Covert Mode.

Horn and Lights Turns on/off the Horn and Lights.

Initiate Call-Out Fallback Alert Sends Fallback Alert.

RUA / RUI Logs you in/out.

Previous Talkgroup Switches the radio to the previously used talkgroup.

RMS Mode (applicable only for * and #) Toggles on/off RMS feature.

GPS Status Message Sends your GPS location in a message to a dedicated address.

Speaker Enable / Disable Per Call Enables speaker during the call.
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Table 3-3 One-Touch Button Features (cont'd.)

Feature Description
Timed Talkgroup Change Initiates the Timed Talkgroup Change feature. While in the

predefined talkgroup, it can be assigned to the second press function.

Double Push PTT Sends the D- PTT tone to the talkgroup you are currently using.

If the One-Touch Button feature is enabled, the One-Touch Dial is disabled. If no feature is assigned to a
button, your radio displays an Unassigned Button message.

3.2 Display
This section presents the radio's home screen elements.

Table 3-4 Display

Annotation Description
1 Status icon area

2 Text display area

3 SOFT key area

4 MENU/Context sensitive icon

The color of the SOFT keys informs you about the mode or state that your radio is in.

Table 3-5 Colors of the SOFT Keys

Color Mode or State
Light blue Normal TMO and DMO Mode

Light red Emergency Mode or Disaster Alert Call

Olive Local Site Trunking Mode

Yellow Call Out — Standby

3-6 -



3.2.1 Status Icons

Table 3-5 Colors of the SOFT Keys (cont'd.)

Color Mode or State
Red Call Out — Alert

Green Call Out — Accepted

Blue Radio Message Service (RMS).
RMS is a mode which allows you to send and receive predefined short messages without
enteringMessages in the menu structure.

Grey Radio User Assignment (RUA) — Limited service

3.2.1 Status Icons
Status icons appear when your radio is engaged in certain activities or when you have activated certain features.

Table 3-6 Status Icons

Icon Description
Trunked Mode Operation

In Service (Signal Strength) — Allows you to check signal strength. More bars indicate a
stronger signal.

No Service

Migration — Displayed when your radio is registered to the foreign network.

Broadcast Call — Displayed when the radio is in the Broadcast Call.

Scan — Indicates talkgroup scanning is activated in the radio.

Priority Scan — Indicates that priority scanning is activated in the radio.

Data Connected — Displayed when the Packet Data feature is activated and the external
device sets up data connection with the radio.

Data Transmit/Receive — Displayed when the Packet Data feature is activated and the
external device sets up data connection with the radio.

• No number — standby data session.

• Number 1, 2, 3, or 4 — indicates active data session with 25%, 50%, 75%, or
100% bandwidth.

Direct Mode Operation

Direct Mode Call – Displayed during a Direct Mode call; more bars indicate a stronger
signal.

Direct Mode — Displayed when the radio is in Direct Mode.
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Table 3-6 Status Icons (cont'd.)

Icon Description
DMO Gateway Communication Mode — Indicates that gateway is selected. The icon
has the following states:

• Solid — while the radio is synchronized with the gateway.

• Blinking — while the radio is not synchronized or during attachment.

• No icon — during a radio to radio and repeater call.

DMO Repeater Communication Mode — Displayed when the Repeater or GW + Rep
option in DMO Mode is selected. This icon has the following states:

• Solid — while the radio has detected the repeater (for example when the radio
receives a presence signal).

• Blinking — while the radio has not detected the repeater or during attachment.

• No icon — during a radio to radio and gateway call.

General Icons

All Tones Off and Duplex and Simplex Ring Muted — Indicates that all alert tones are off
and both duplex an simplex ring volume is set to 0.

Simplex Ring Muted — Indicates that simplex ring volume is set to 0 and duplex ring
volume is set to more than 0.

Duplex Ring Muted — Indicates that duplex ring volume is set to 0 and simplex ring
volume is set to more than 0.

Speaker Off (Low Audio) — Indicates that audio will not sound through the speaker.

Earpiece Connected — Indicates that the earpiece is connected.

Horn and Lights — Indicates that an external alarm (for example, horn and lights) is
activated.

GPS — Indicates that a valid location coordinates are received.

RUI Logged on — Indicates that you are logged on into the radio.

RUI Pseudo Log On — Indicates that you are in pseudo logged on state.

RUI Packet Data — Indicates Pseudo Log On state when the Packet Data feature is
activated and the external device sets up data connection with the radio.

• No number — standby data session.

• Number 1, 2, 3, or 4 — indicates active data session with 25%, 50%, 75%, or
100% bandwidth.

RUI Packet Data — Indicates Pseudo Log On state when the Packet Data feature is
activated and the external device sets up data connection with the radio.

Emergency — Appears while the radio is in Emergency Operation.

Disaster Alert Call — Appears while the radio is in the Disaster Alert Call.
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3.2.1 Status Icons

Table 3-6 Status Icons (cont'd.)

Icon Description
List Scrolling — Displayed to indicate that the ROTARY KNOB is in list scrolling mode.

New Message Has Arrived — Indicates a new message just arrived.

New Message(s) in Inbox — Indicates that you have unread messages in your Inbox.

Unread (New) WAP Message — Indicates that new page was loaded to the browser.

Call-Out — Indicates Call-Out alert.

Call-Out Alert Arrived — Indicates a receipt of a new Call-Out message.

Call-Out Alert Unread — Indicates unread alert in the CO Box.

End-to-End Encryption (E2EE)
Solid, when the E2EE is enabled

• for the selected talkgroup,

• for the highlighted private number,

• for the manually entered private number,

• when transmitting voice in Group Calls,

• when transmitting voice in Simplex Private Calls.

Blinking, when the End-to-End Encryption is enabled

• when receiving voice in Group Calls,

• when receiving voice in Simplex Private Calls,

• during encrypted Duplex Private Calls.

SDS End-to-End Encryption
Solid, when the E2E status of an SDS message, or the E2E status of a message recipient
address.
In High Security mode, when your radio processes only the encrypted information, this
icon is always visible in when you are in the messages menu (for example, Inbox).

Unread (New) WAP Message — Indicates that you have not enteredWAP Box since last
WAP message was received (Blinks when the priority is high).

WAP Message Icon — Displayed next to the priority in the message list view.

WAP Message Time — Displayed next to the create date in the message list view.

WAP Message Expiration — Displayed next to the expiry date in the message list view.

WAP Message Title Icon — Displayed next to the title along with the text in the message
list view.

Keys Locked — Indicates that keys are locked.
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Table 3-6 Status Icons (cont'd.)

Icon Description
Non Secured Call — Air Encryption Unavailable
Blinking, indicates that Air Encryption is not available when the radio:

• Is in the Local Site Trunking Mode.

• Attempts to connect to a gateway.

Not Secured Call — Air Encryption Unavailable
Alternately blinking, indicates that Air Encryption is not available when the radio:

• Is in TMO Mode.

• Communicates through a gateway.

Not Secured Call — Air Encryption Unavailable
Blinking, indicates that Air Encryption is not available in DMO Mode. The icon appears
after the PTT button is pressed.

3.2.2 Idle Display
The terminals provide access to all services from the main idle display. There is no need to select a mode before
calling.

The idle display shows the following content:

• Icons on the top line.

– Status icons.

– Signal level icon.

♦ Displayed in TMO at all times.

♦ Displayed in DMO only when receiving a voice in a group call.

– Up to five lines of text.

• Softkey labels and optional menu icon.

• An optional wallpaper background.

From the idle display, you have an easy access to stored target lists.

• Pressing the UP key accesses the favorite talkgroups list.

• Pressing the DOWN key accesses the recent calls lists.

• Pressing the SEND key accesses the last dialed numbers list.

• Pressing the Contacts softkey accesses the address book.
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3.2.3 Configurable Idle Screen

3.2.3 Configurable Idle Screen
Configurable Idle Screen is a feature that allows your service provider to determine what additional information is
displayed below the status icon area on the idle screen . The following information can be selected:

• Network
• Range
• Talkgroup name
• Time and date
• Home mode display
• RMS/FMS
• ISSI

3.2.4 Display Features
The radio utilizes colors to highlight certain special situations.

• When the battery is low.
• When the signal strength is low.
• When the radio is in an emergency mode/call.

The radio has enlarged zoom fonts that you can choose using the menu (Zoom and Extra Zoom, where available).

The backlight can be provisioned to operate in one of the following modes.

• Disabled — The backlight does not operate at all.
• Semi-Auto — Pressing a provisioned one-touch button toggles the on/off state of the backlight. The
backlight is also turned off automatically when the backlight timer runs out.

• Auto — Pressing any key automatically turns on the backlight.

The backlight remains on until the backlight timer runs out, or if a provisioned one-touch button is pressed to turn it
off. You can also toggle between the modes using the menu.

The radio supports a provisioned option to display a screen saver when the radio has been idle for a provisioned
time, or when you explicitly activate it. The screen saver consists of an image, which can be provisioned from any
GIF image, and a text string which can also be provisioned. When the screen saver is being displayed, any key input
or incoming service causes the screen saver to deactivate.

3.2.5 Languages Supported
Table 3-7 Languages Supported

Language MTM800 Enhanced
English Yes

Arabic Yes

Chinese (simplified) Yes

Chinese (traditional) Yes
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Table 3-7 Languages Supported (cont'd.)

Language MTM800 Enhanced
Croatian Yes

Danish Yes

Dutch Yes

French Yes

German Yes

Greek Yes

Hebrew Yes

Hungarian Yes

Italian Yes

Japanese Yes

Korean Yes

Lithuanian Yes

Macedonian Yes

Mongolian Yes

Norwegian Yes

Portuguese Yes

Polish Yes

Russian Yes

Spanish Yes

Swedish Yes

User defined Yes
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3.3 Audio

3.3 Audio

3.3.1 Tones
Table 3-8 Radio Tones

Tone Name Default Tone Diagram

Back to Coverage
Back to Full Service

0 100 200 300 400

2400
2100
1800
1000

900
600
400
200

[Hz]

[ms]

Clear-to-send

0 100 200 300 400

2400
2100
1800
1000

900
600
400
200

[Hz]

[ms]

Bad Key Pressed

0 100 200 300 400

2400
2100
1800
1000

900
600
400
200

[Hz]

[ms]

From Out-of-Service to In
Service

0 100 200 300 400

2400
2100
1800
1000

900
600
400
200

[Hz]

[ms]

In Emergency

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Talk Permit

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

• Talk prohibit

• System busy

• Time-out timer expire

• Called radio not
available or busy

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Call Disconnected or Failed
Due to Network

0 100 200 300 400 500[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Toggling Betwen DMO and
TMO

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]
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Table 3-8 Radio Tones (cont'd.)

Tone Name Default Tone Diagram

Entering/Exiting Local Site
Trunking

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Receiving/Sending
Emergency Alarm

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Emergency Alarm Failed

0 100 200 300 400 500 600[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Entering Emergency

0 100 200 300 400 500 600[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Exiting Emergency

0 100 200 300 400 500 600[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Entering TXI

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

Exiting TXI

0 100 200 300 400[ms]

2400
2100
1800
1000

900
600
400
200

[Hz]

All the audible indications can be disabled by your service provider.

3.3.2 Volume Control
If the volume control mode is set to Individually Controlled, you can adjust the following volumes individually.

• Duplex (alerting volume at incoming phone/PABX or duplex private call).
• Simplex (alerting volume at incoming simplex private call).
• Earpiece (voice audio volume in the internal or external earpiece).
• Speaker (voice audio volume in the speaker).
• Keypad (keypad tones volume).
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3.3.3 Volume Adjustment Mode

The adjustments are made for the volumes within the ranges defined in the audio mode. Simplex and duplex calls
use the same range. All other volumes are fixed for each audio mode.

If the volume control mode is set to Commonly Controlled, you can adjust only all volumes at the same time.

When the rotary knob is in the volume mode the radio adjusts the value of the commonly controlled volume along
with the audio volume.

3.3.3 Volume Adjustment Mode
You can set the volume to Individual or Common. When it is set to Individual, the volume level for Voice,
Duplex, Simplex, Earpiece, Speaker and Keypad can be set per user preferences. When set to Common, the audio
have one setting for all items.

3.3.4 Voice Operating Transmission (VOX) Control
Voice Operating Transmission (VOX) allows transmitting voice in a hands-free condition. The feature enables the
radio to automatically key-up upon detecting audio and automatically de-key when audio is no longer present. The
VOX control of audio is used when a duplex private call or telephone call uses the fist microphone.

On the MTM800E radio, VOX can be enabled or disabled using CPS.

3.4 Testing

3.4.1 Test Page/Test Mode

The Test Mode option must be enabled in the codeplug. The test mode is only for use by authorized
persons. When using KVL 3000 (a portable device used to load encryption keys to a secure entity), set the
baud rate on it to 19200 bits/second.

Use the following key sequence to access the test mode: .

If the test mode option is not enabled in the codeplug, you have only access to the KVL mode options
KVL On or KVL Off.

The following information is available in the test mode.

• Ver Info – Version Information – displays software/hardware version information.

– Build Date – software build (a compiled version of software)
– CP Ver – CodePlug version
– DSP Ver – Signalling Processor Software version
– Host Ver – Application Software version
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– HardwareID– hardware identification number
– EquipID – TEI (Tetra Equipment Identity)
– LLS version– Local Language Package version
– NGCH Software Version – software version of the control head

• Addresses;

– Home MNI – country identification code, network code
– Group ID – number of the currently selected talkgroup
– Own ISSI – Own Individual Short Subscriber Identity
– ASSI– Alias Short Subscriber Identity

• Err Logs – Error Logs – displays information about software errors.
• Cells Info – Cell Information – displays information about the foreground and background cells (BTS sites).
This menu displays the RSSI levels of the cells.

• Cell Lists – Displays frequency lists.

– Frequency List1 (32 variable frequencies)
– Frequency List2 (32 fixed frequencies)
– Frequency List3 (comprehensive hunt)
– Frequency List4 (comprehensive hunt)

• Data Svc – Data Services – allows access to the air tracer enable, the conformance tests, and the KVL mode.

– Air Tracer
– Conf Test – Conform test
– KVL Mode

In the KVL mode, the display is immediately dark and empty. However, the green LED is on.
During data exchange with the AIE KVL, the orange LED is on. On successful key exchange,
the green LED is on again. In any error situation, the red LED is on. You can leave the KVL
mode by pressing the power button.

– E2E KVL Mode
– MS Logging

• CE Monitor– Crypto Engine Monitor
• Key Info – Key Information — allows displaying the security information for the following conditions:

– For the serving cell:

♦ Curr Cell SC – Security class of the serving cell, that is Security Class 1, Security Class 2, Security
Class 3, Security Class 3 with GCK.

– For the group OTAR:

♦ CMG GSSI – Crypto Management Group (CMG) group of MSs with common key material

– For SDMO and TM-SCK OTAR:

♦ SCK SubsGrType – SDMO SCK Subset Grouping Type.
♦ Curr Subs Info – current SDMO SCK Subset Number and SCK-VN.
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3.4.2 Service Page

♦ Fallback TMSCK – current Fallback TMO SCK, that is SCKN and SCK-VN attributes.

♦ SCK List – list all SCKs stored in the MS, that is SCKN and SCK-VN attributes (SCK version
number).

When checking that the SDMO key information in the radio, be advised that the SDMO
KAG (SDMO Key Association Group) range in the AuC (Authentication Centre) is from 0
to 9 and the range in the radio is from 1 to 10.

– For the GCK (Group Cipher Key):

♦ Full GCK-VN – current Full GCK-VN.(GCK version number).

♦ GCK List – list all GCKs stored in the MS, that is GCKN and GCK-VN attributes.

• DMO info– Direct Mode Operation information

3.4.2 Service Page
Depending on the codeplug configuration the manufacturer, type, and serial number information is available. The
information is available through the service page accessible from the MMI.

The service page provides the following data.

• Manufacturer

• Product Type

The manufacturer and product type information is displayed only on radios distributed under
Motorola trademark.

• ISSI — the ISSI which is currently in use. If a SIM Card is present the ISSI is read from the card, otherwise
it is taken from the codeplug.

• TEI — the TEI is displayed as a hexadecimal number.

• Serial number — Motorola serial number is displayed only on radios distributed under Motorola trademark.

• OPTA — if the BSI SIM support is disabled no OPTA information is displayed.

3.4.3 Hardware Test
This mode allows performing basic hardware tests and share the results immediately on the display.

The hardware test mode is only for use by authorized persons.
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4 Customer Programming Software

4.1 CPS Plus Overview
Customer Programming Software (CPS) Plus provides a programming interface between a PC and TETRA radios.

CPS Plus allows you to program radios with configuration files called codeplugs. A codeplug is a repository of
configuration data for a radio. It includes features (also the selling features) and adjustable parameters.

Codeplugs can be modified using CPS Plus.

CPS Plus enables you to easily manage radio software updates. A typical software package contains platform-specific
software components: firmware, codeplugs, language packs, and selling features (licenses required). Such packages,
for all available platforms, are bundled in release packets and delivered on a disk or online. You can import release
packets directly to CPS Plus and use the bundled software to upgrade radios.

Figure 4-1 CPS Plus — Overview

Table 4-1 CPS Plus — Overview

Annotation Description
1 Motorola Solutions supplies its customers with radio software release packets and Customer

Programming Software (CPS) Plus.

2 CPS Plus User can modify radio codeplugs, apply audio templates, and manage radio software
upgrades.

3 CPS Plus is compatible with assorted models of Motorola Solutions TETRA radios and can read
and write radio configuration from up to 16 devices through the USB port on a PC or a laptop.

The most common tasks using CPS Plus include:

• Reading codeplugs from radios.
• Writing codeplugs to radios.
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• Editing codeplugs.
• Upgrading radios with newer software.
• Enabling standard features.
• Enabling selling features.
• and many more.

4.1.1 Using CPS Plus Online Help
When and where to use:
To learn about the application and to search content.

Procedure Steps

1 For information about changes in radio software releases (Release Packets), click Help → What's New in
CPS Plus.

2 To open the help file, press F1 or click Help → CPS Help Index .

3 To find the content, browse the table of contents or use the Search tab.

SUGGESTION

To narrow your search criteria, enter the keyword in quotation marks, for example “keyword”.

4 To go back and forth between the viewed pages, press LEFT/RIGHT ARROW + ALT.

5 To browse up and down and preview the pages from the table of content, press UP/DOWN ARROW + ALT.

6 To increase the font size, in the CHM browser click Options → Internet Options → Accessibility. Select
the check box Ignore font sizes specified on Web pages. Click OK.

4.1.2 What is New in CPS Plus
• Graphical User Interface (GUI) has been refreshed but the intuitive interface and functionality remains familiar
to users who used previous versions of CPS. See 4.2 User Interface, page 4-6.

• Software updates for radios are combined in release packets that can be easily imported without upgrading the
CPS application. See 4.4.2 Importing Release Packets to CPS Plus, page 4-39.

• Radios can automatically switch in to flashing mode. See 4.3.3 Turning On Radios in Flashing Mode —
Automatically, page 4-21.

• Choose a subset of parameters, edit, and write to radios. See 4.4.8 Modifying Configuration Using Profiles,
page 4-46.

• A new fly-out GUI element displays radios status and provides a right-click menu with common options. See
4.2.9 Radio Icons List, page 4-15.

• Identify the differences in configuration between radios. 4.4.5 Comparing Codeplugs, page 4-44.
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4.1.3 Migrating Between CPS Versions

• Keep codeplugs up-to-date without compromising settings. See 4.4.7 Upgrading a Codeplug, page 4-45.

• Choose a default language pack for your radios. See 4.4.9 Adding Languages to Radios, page 4-50.

• Identify the invalid codeplug parameters at glance. See 4.2.8 Codeplug Panes, page 4-14.

• You can edit codeplugs and program radios at the same time with no performance disruptions.

• Importing Audio Device Descriptors. See 4.4.11 Importing Audio Device Descriptors to CPS Plus, page 4-52.

• Removing Audio Device Descriptors. See 4.4.12 Removing Audio Device Descriptors From CPS Plus, page 4-53.

• Enabling/disabling feedback tones and Windows Visual Style. See 4.2.3.1 Options, page 4-10.

• Upgrade or downgrade a radio’s codeplug version. See 4.3.13 Upgrading a Radio, page 4-35.

• Limited support for programming Zeon Radios.

• Convert codeplugs and profiles from a master file to a specific radio model. See 4.4.3 Converting Codeplug/Profile
Radio Model, page 4-40.

• Verify a codeplug/profile for errors before programming a radio. See 4.4.6 Verifying Codeplug/Profile for
Copy, page 4-45.

• Report issues with CPS Plus. See 4.5.8 Report Issue, page 4-59.

4.1.3 Migrating Between CPS Versions
After installing the CPS Plus application, you can still retain previous versions of CPS. Legacy CPS may be needed
if you support radios running on legacy software platforms, not supported by the new CPS Plus (lower than
MR5.9). The new CPS Plus supports multiple radio software versions (release packets). Therefore you do not need
to upgrade CPS Plus for every new radio software release.

Replacing Legacy CPS with CPS Plus

You have decided to replace the legacy CPS with the latest CPS Plus. It is possible only if your radios run on the
software platformsMR5.9 and higher. If not, first upgrade the radios using the legacy CPS and then you may
uninstall the legacy CPS.

Maintaining Legacy CPS and CPS Plus

You have decided to use CPS Plus for newer radios and retain your legacy CPS to use it with radios running on
legacy platforms, not supported by CPS Plus (lower than MR5.9). Always install CPS Plus as the last one, to make
sure that you have installed the latest USB drivers. The legacy CPS versions lower than R6x.575.01 (also known as
lower thanMR5.10 radio software) require older USB drivers. Therefore remember to use the USB Driver Tool
before connecting the legacy radios and the other way around.

Check marks indicate in what cases, when switching between the two instances of CPS, you use the USB Driver
Tool. For example, you currently use CPS Plus but want to program older radios. The old legacy CPS version that
you have on your PC reads D6x.509.02. It is older version than the R6x.575.01, therefore use the USB Driver Tool
and install old drivers. In the table, this case is under the first row CPS Plus and the third column Legacy CPS
Preceding R6x.575.01.
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Table 4-2 CPS Plus — The Use of USB Driver Tool for Switching Between Different CPS Versions

CPS Plus Legacy CPS
Preceding R6x.575.01

Legacy CPS
R6x.575.01 or Newer

CPS Plus

Legacy CPS Preceding
R6x.575.01

Legacy CPS R6x.575.01
or Newer

4.1.4 Supported File Formats
Table 4-3 CPS Plus — Supported File Formats

File
Extension Description Create Edit Import Export

.add Audio Device
Descriptors file
format.

.cpd Old codeplug file
format. Use File
→ Save As to
save to the new
.cpe format.

.cpe Codeplug file
format.

.dbf Old codeplug file
format. Use File
→ Save As to
save to the new
.cpe format.

.gif A screen saver
graphic file
format.

.mou TETRA key
distribution file
format.

.prl Profile file
format.

.rpk Radio software
release packets
file format.

.z19 Old radio
software file
format.

Only as .rpk
software release
packet files.
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4.1.5 Motorola TETRA Radios Supported by CPS Plus

4.1.5 Motorola TETRA Radios Supported by CPS Plus
Table 4-4 CPS Plus — Supported Radios

Radio Type Radio Model Radio Icon in CPS
Plus

MTP810Ex, MTP830, MTP830FuG, MTP830S, MTP850,
MTP850FuG, MTP850S

MTP850Ex

MTH800

CEP400

MTP3100, MTP3200 SIM, MTP3200FuG

Portable

MTP3150, MTP3250, MTP3250 SIM, MTP3250FuG

MTM800Mobile

Transceiver and Control Head for: MTM800E, MTM5400,
MTM800FuG
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Table 4-4 CPS Plus — Supported Radios (cont'd.)

Radio Type Radio Model Radio Icon in CPS
Plus

Covert TCR1000

PDA MTC100

4.2 User Interface
CPS Plus content is arranged in a classic tri-pane design with the menu on top and the work-spaces split with adjustable bars.

Figure 4-2 CPS Plus — Main Window
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4.2.1 File Menu

Table 4-5 CPS Plus — Graphical User Interface

Annotation GUI Item Description
1a Menu bar An area that groups all the menus.

1b Toolbar An area that groups icons for basic tasks.

2a Codeplug pane — Codeplug tree Represents a hierarchical data structure of a codeplug.

2b Codeplug pane — Codeplug fields A table with data-entry points for features and values.

3 Radio Icons List A fly-out area that visually represents connected radios
and status of programming operations.

4 Information pane An area that provides a dialog interface between the
application and the user. It contains the following tabs:

• Help— displays context-sensitive topics.

• Invalid — displays invalid parameters, for
example when the parameter you have entered is
out of range.

• Warning— displays cautionary messages.

5 Progress bar Conveys the progress of a programming task.

6 Codeplug file name tab Allows you switch between the opened codeplugs. Click
to bring the preferred codeplug to front.

4.2.1 File Menu
Table 4-6 CPS Plus — File Menu Items

Menu Item Description
Open Codeplug Use to open a configuration file.

Open Profile Use to open a profile.

Open Codeplug with Upgrade Use to create a newer version of an existing codeplug and open it in CPS
Plus. You can use your already configured codeplugs with the newer radio
software, but first upgrade the device to the relevant radio software version.

Upgraded codeplugs preserve all the user data settings.

Open Profile with Upgrade Use to create a newer profile. In order to support newer radio software
versions the profiles must be up-to-date.

The upgraded profile preserves all the settings from the baseline
profile.

Convert Model Use to convert a codeplug from one radio model to another.
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Table 4-6 CPS Plus — File Menu Items (cont'd.)

Menu Item Description
Close Use to close the active codeplug.

Save Use to save changes to the active codeplug.

Save As Use to save as a new codeplug.

Read Radio Use to transfer a codeplug from a radio to CPS Plus.

Write Radio Use to transfer an active codeplug from CPS Plus to a radio.

Radio Copy Wizard Use to copy and write a subset of specified codeplug parameters from an
active codeplug to the selected radio.

Codeplug Copy Wizard Use to copy and replicate a subset of specified codeplug parameters from an
active codeplug to the selected codeplug.

Verify Codeplug/Profile for Copy Use to verify the codeplug for errors before copying it to a radio.

Generate Profile Use to create a file with a subset of specified codeplug parameters. This
function is like Copy Wizard, but you can save the profile on a disk and
reuse it in the future.

Apply Profile to Radio Use to program configuration from a profile to the selected radio.

Apply Profile to Codeplug Use to copy values from a profile and replicate them on to an active
codeplug. This function is like Codeplug Copy Wizard.

Compare Codeplug Use to examine configuration differences between two codeplugs.

Import Use to import a file to CPS Plus.

Export Use to export a file from CPS Plus.

Change Codeplug Password Use to protect a codeplug with a password.

Exit Use to close CPS Plus.

4.2.2 Edit Menu
The Edit menu contains commands used while editing codeplugs.

Table 4-7 CPS Plus — Edit Menu Items

Menu Item Description
Copy Use to copy text content from the selected codeplug

field so you can paste it in another location.

Paste Use to paste the text content you have copied from
another codeplug field.

Find Use to search an active codeplug to find a specific
field.
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4.2.3 Tools Menu

Table 4-7 CPS Plus — Edit Menu Items (cont'd.)

Menu Item Description
Undo Use to reverse changes that you have done to the

active codeplug. This function does not work after
you save the changes to the codeplug.

Redo Use to remake changes done by the Undo
command.

4.2.3 Tools Menu
Table 4-8 CPS Plus — Tools Menu Items

Menu Item Description
Turn Off Radio Use to turn off the radio safely.

Upgrade Radio Use to upgrade a post-MR5.9 version radio without loosing all the user data.

Up/Downgrade Radio Lite Upgrade Lite only allows to upgrade radios that are version pre-MR5.9 to a
version that is MR 5.9 or newer. Downgrade Lite only allows to downgrade
a radio to MR5.9 or newer.

SUGGESTION

When using the dowgrade option, all the user data is lost. Only
the factory and the sensitivity data remains unchanged. It is not
recommended to downgrade codeplugs and then downgrade
radios. Use the Restore Radio option instead.

Write Software Use to write a selected firmware to a radio. Verify that you perform this
operation to the correct unit. The software version must match the codeplug
version that resides on the radio. The software version can be found in the
Codeplug → Subscriber Unit Parameters → Application Image.

Restore Radio Use to write a previous version of software to a radio. CPS Plus uses
radio software from the release packet repository and copies of compatible
codeplugs. Each time after reading a radio, CPS Plus automatically backs
up each codeplug and stores in the directory chosen during the installation,
by default: C:\Program Files\MotorolaSolutions\Tetra
CPS Plus\BackupCodeplugs.

After this operation, the user data values remain unchanged.

Erase Memory Use to delete entire radio flash memory. That is to delete the radio software,
codeplug with all settings, and security keys.
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Table 4-8 CPS Plus — Tools Menu Items (cont'd.)

Menu Item Description
Restore Permanent Disable V2
Radio

Use to reactivate a disabled radio (only for PDV2). CPS Plus automatically
selects the appropriate software version and uses codeplugs from the backup
folder to restore the radio.

Plug in the dongle with Selling Feature licenses to the PC.

Radio Languages Settings Use to write a selected language pack to a radio.

Enable Selling Feature Use to add a selling feature to the radio.

Close all codeplugs.Plug in the dongle with Selling Feature
licenses to the PC.

Import/Remove Audio Template
Files

By default, audio template files are included in release packets. If you
removed the default audio templates or received a set of customized
templates, use this option to import the files to the CPS Plus repository.

Options Use to change CPS Plus general settings.

4.2.3.1 Options
Table 4-9 CPS Plus — Description of the Options

Menu Item Description
General Use to set the user interface language and to protect codeplugs with a password before saving.

Filename Use to define a filename pattern for codeplugs that you have read from radios and
want to store on a hard drive, for example SN[999ABC9999]_TEI[F8F9FAFBFCFD-
FEF]_ISSI[100]_CP[7014]_SW[Unknown].cpe.

SUGGESTION

Consistent filenames help you control a codeplug inventory.
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4.2.3.1 Options

Table 4-9 CPS Plus — Description of the Options (cont'd.)

Menu Item Description
Display Use to control graphical elements of the interface.

Hide splash window— do not show the splash screen while loading the application (launch
faster).

Show tooltips for codeplug fields (range for parameters)— display a small box with range
values when hovering a mouse cursor over a codeplug field.

Minimize the icon to the system tray (conserver space on the taskbar)— minimize to
an icon in the system tray (next to the system clock icon) — conserve space on the taskbar
for other applications.

Remember USB ports location in the Radio Icon List— boxes in the Radio Icon List
can remember the USB port assignments. Therefore you can organize and keep the same
array of connected radios and manage the programming almost intuitively. For example, you
connect four radios to four separate USB ports for the first time. CPS Plus remembers the port
assignment and next time you connect a single radio to the USB port 2, the radio appears
in the box 2 in Radio Icon List.

Enable feedback tones (Note: this option will impact Internet Explorer as well) )—
allows you to enable or disable feedback tones (clicking sound). These tones are played while
you click on codeplug fields. When the flag is checked, feedback tones are enabled. You may
uncheck this option to mute the feedback tones.

Enable Windows Visual Style— allows CPS to adopt Windows Visual style. Windows XP
and later operating systems support a feature called Visual Styles that enables the appearance
of common controls to change based on the theme chosen by you. When the flag is checked,
the CPS is configured to use Windows Visual Styles and if left unchecked, the CPS uses
Windows Classic style.

Communica-
tions

Use to toggle data compression and enable faster programming.

Directories Use to define the default locations for codeplugs.

Do not change the default directory for the backup codeplugs.

Default Selling
Features

Use to define which selling features are selected by default in the Tools → Enable Feature
dialog box.

Default
Language
Packs

Use to define which languages appear as default radio languages in the Tool → Languages
option.
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Table 4-9 CPS Plus — Description of the Options (cont'd.)

Menu Item Description
Log Use to define the default location and the format for log files.

Recovery Use to define the recovery mode. If you accidentally disconnect and turn off the radio during
programming (corrupted software, codeplug or a language pack), this function can recover
radio.

• Recovery

Auto— after you connect the corrupted radio, CPS Plus detects the software version, and starts
the recovery process automatically. If no suitable software or a codeplug is stored in the default
location on the hard drive, CPS Plus switches to the manual recovery.

Manual— after you connect the corrupted radio, CPS Plus detects the software version but
lets you start the recovery process manually.

• Software Version Strategy

Latest First— CPS Plus uses the most recent, available on the hard drive (release repository
and backup folder) radio software and codeplug.

Oldest First— CPS Plus uses the earliest, available on the hard drive (release repository and
backup folder) radio software and codeplug.

4.2.4 Release Packet Menu
A delivery method for release packets may vary (on a disk or online). Ask your local customer representative for details.

Table 4-10 CPS Plus — Release Packet Menu Items

Menu Item Description
Import Release Packet Use to import release packets to the local CPS Plus repository.

Import Software Use to import release packets that contain specific radio software.

Release Packet Manager Use to explore and manage (import, view, and remove content) software
files stored in the CPS Plus repository.

Reset All Release Packets Use to restore the packet repository to its default contents (packets
shipped and installed with CPS Plus). CPS Plus deletes all the
release packets imported manually after the installation and preserves
only the default packets. You can also use this option to restore
the default release packets if you accidentally removed them from
the repository. The default location of the release packets is:
c:\Program Files\MotorolaSolutions\Tetra CPS
Plus\Bin\repository_link_folder\
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4.2.4.1 Release Packet Manager

4.2.4.1 Release Packet Manager
Table 4-11 CPS Plus — Description of the Packet Browser Window

Window Element Description
Imported Packets Lists the release packets stored in the CPS Plus repository. To add a new

packet to the repository, click Import New Packets and select the file. To
remove a packet from the repository, select the item from the list and click
Remove Packets. CPS Plus restarts after each operation.

Content Manifest Lists all the components of the selected release packet. You can only view
the content but cannot add or remove the packet elements.

Import New Packets Use to import a packet or packets to the CPS Plus repository.

Remove Packets Use to remove a packet or packets from the CPS Plus repository.

4.2.5 View Menu
The View menu contains commands to toggle the CPS Plus panes.

Table 4-12 CPS Plus — View Menu

Menu Item Description
Hide Tree View Use to toggle the codeplug tree view pane.

Hide Bottom View Use to toggle the bottom information pane.

Task Window Use to verify programming operations history.

4.2.6 Window Menu
TheWindow menu contains commands that allow you to arrange codeplug windows that are currently opened on
the desktop.

4.2.7 Help Menu
The Help menu contains commands that allow you access the online help browser and information about the CPS
Plus version. You can also report CPS Plus related issues by using the Reporting Issue option.

For information about supported radio models, click Help → About.
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4.2.8 Codeplug Panes
Figure 4-3 CPS Plus — Codeplug Panes GUI Elements

A number of codeplug nodes and fields varies according to a radio model.

Table 4-13 CPS Plus — Codeplug Panes GUI Elements

Annotation GUI Item Description
1 Codeplug tree Represents a hierarchical data structure of all codeplug

nodes (features).

2 Codeplug fields search bar Allows you to search the active codeplug and find a
codeplug field.

3 Check boxes Select to enable codeplug features and options.

4 Selling Feature indicator The grey bar indicates that it is a selling feature.

5 Drop-down list Contains multiple values to choose from.

6 Set Default button Allows to reset the field to its default value.
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4.2.9 Radio Icons List

Table 4-13 CPS Plus — Codeplug Panes GUI Elements (cont'd.)

Annotation GUI Item Description
7a Indicates that the parameter value is incorrect.

7b

Invalid parameter indicator

Indicates that some parameters in this node have incorrect
values.

8 Range tooltip Indicates a range for numerical parameters.

Enabling a Selling Feature on a Radio

Invalid Codeplug Parameters

4.2.9 Radio Icons List
Radio Icons List provides monitoring and operational functions to manage radios. It is a fly-out element so it can
automatically appear and hide out from the working area (useful to save space). Icons and color codes help you
to identify radios and a programming operations status. The context-menu, in other words the right-click menu,
provides access to the most frequently used functions.

Figure 4-4 CPS Plus — Radios Icons List

Table 4-14 CPS Plus — Radios Icons List

Annotation GUI Item Description

Assorted radio model icons.1

The radio needs a recovery.
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Table 4-14 CPS Plus — Radios Icons List (cont'd.)

Annotation GUI Item Description

Radio is connected and ready for programming.

Programming operation finished. Radio is ready for
programming.

Programming operation is pending.

2

An operation error has occurred.

3 Progress bar Conveys a progress of a programming operation.

4 Context-menu Available when the radio is ready for programming.

Motorola TETRA Radios Supported by CPS Plus

4.2.10 Keyboard Shortcuts
Table 4-15 CPS Plus — Keyboard Shortcuts

Description Keyboard Shortcut
Open Help F1

Open Codeplug CTRL + O

Save CTRL + S

Read Radio CTRL + R

Write Radio CTRL + W

Copy CTRL + C

Paste CTRL + V

Undo CTRL + Z

Redo CTRL + Y

Find CTRL + F

Options CTRL + K

Switch focus to the next/previous opened codeplug CTRL + TAB

Exit ALT + F4
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4.3 Getting Started

4.3 Getting Started
Whether you are a new user or have used earlier versions of the application, the following topics are designed
to help you get up and running.

4.3.1 Connecting Radios to a PC
Prerequisites:

• You have the USB programming cable.

• If portable radios: The battery must not be discharged (CPS Plus detects the required battery level before
triggering the flashing mode)

• If mobile radios: DC power source is attached— a car battery or a DC power supply.

• CPS Plus is running.

When and where to use:
Always before using a radio with CPS Plus. Some of the CPS Plus options are unavailable until you attach a radio
and turn it on in flashing mode.

Procedure Steps

1 Connect the radio to the PC using the USB programming cable.
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Figure 4-5 CPS Plus — Connecting Portable Radios
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4.3.1 Connecting Radios to a PC

Figure 4-6 CPS Plus — Connecting Mobile Radios

MR10.6.5 control heads and transceivers can only be programmed separately. For earlier mobile radio
models it is possible to program the transceiver via the control head cable while the devices are paired.

Table 4-16 CPS Plus — Radio Cables

Annotation Description Part Number Radio Model
1 Programming Cable PMKN4026_ MTH800, MTP850

series, CEP400, MTP830,
TCR1000

2 Programming Cable PMLN5235A MTP810 Ex, MTP850 Ex
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Table 4-16 CPS Plus — Radio Cables (cont'd.)

Annotation Description Part Number Radio Model
2a Programming Cable PMKN4129A MTP3100, MTP3150,

MTP3200, MTP3250

3 Programming Cable HKN6184_ MTM800E, MTM5x00,
MTM800 FuG, MTM800
FuG ET

4 Programming Cable PMKN4110A MTM800, MTM5x00
Transceiver, MTM800E
Transceiver, MTM800
FuG, MTM800 FuG ET
Transceiver

5 2.3 metre or 4 metre
accessory expansion cable

PMKN4029_ or
PMKN4056_

MTM800E, MTM5x00,
MTM800 FuG, MTM800
FuG ET

6 Desktop power supply GPN6145_ MTM800, MTM800E,
MTM5x00, MTM800 FuG,
MTM800 FuG ET

Step result: Mobile transceivers connected through the rear connector as well as fully charged portable radios
with a charger attached automatically turn on in flashing mode. It takes approximately 15 seconds, after the
USB notification tone, to auto-start in flashing mode.

2 Turn on the radio in flashing mode.

Step result: The radio is ready for programming when the radio icon appears on the list.

Result:
You can begin programming operations.
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4.3.2 Turning On Radios in Flashing Mode — Manually

4.3.2 Turning On Radios in Flashing Mode — Manually
Prerequisites:

• The radio is turned off.

• The radio is connected to the PC.

• For mobile radios, make sure that the desktop power supply (12 V DC power source) is connected.

When and where to use:
Always before using a radio with CPS Plus. Some of the CPS Plus options are unavailable until you attach a radio
and turn it on in flashing mode. Entering in to flashing mode varies for different radios.

A radio in flashing mode will revert to charging mode after a time-out period of 5 minutes. Follow the
procedure below to set the radio back into flashing mode.

Procedure Steps

1 Portable radios with a full, numeric keypad and mobile radios with the controlhead: press and hold for
about three seconds the 1+9+POWER keys.

2 Portable radios with a limited keypad: press and hold for about three seconds the FUN1+FUN2+POWER
keys.

3 The application can detect mobile transceivers, connected through the rear connector, and automatically
turn on in flashing mode.

Result:
The USB alert sound is heard. The radio is ready for programming when the radio icon appears in CPS Plus.

Postrequisites:
To turn off the radio from the flashing mode, right-click the radios icon and select Turn Off Radio.

4.3.3 Turning On Radios in Flashing Mode — Automatically
Prerequisites:

• The radio is connected to the PC.

• A radio battery charged to more than 15% capacity.

• The radio is in a charging dock or a charger is attached.

• For mobile radios, make sure that the desktop power supply (12 V DC power source) is connected.

• A portable radio can be turned on or off.
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When and where to use:
Before programming, each radio must be turned on in flashing mode. If you insert a fully charged portable radio in
to a charging dock, that is connected to the PC through a programming cable, CPS Plus automatically detects the
radio and turns it on in flashing mode. You do not have to manually turn on the radio in flashing mode, which is
useful if you connect and program multiple radios. The mechanism also works with a single radio connected to CPS
Plus through a programming cable with a charger attached.

Procedure Steps

1 The application can detect a connected portable radio and automatically turn it on in flashing mode.
It takes approximately 15 seconds after the USB notification tone to auto-start in flashing mode.
Step result: The USB alert sound is heard. The radio display turns red and blinks. The radio is ready for
programming when the radio icon appears in CPS Plus.

2 The application can detect a mobile transceiver , connected through the rear connector, and automatically turn
it on in flashing mode.
It takes approximately 15 seconds after the USB notification tone to auto-start in flashing mode.
Step result: The USB alert sound is heard. The radio display blinks. The radio is ready for programming
when the radio icon appears in CPS Plus.

Turning On Radios in Flashing Mode — Manually

Connecting Radios to a PC

Radio Icons List

4.3.4 Opening a Codeplug
Prerequisites:
You have a codeplug on a disk or connected a radio to PC and turned on in flashing mode.

When and where to use:
Always before viewing or modifying a codeplug in CPS Plus.
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4.3.5 Reading Codeplugs from Radios

Procedure Steps

1 To open a codeplug from a disk, click File → Open Codeplug.
Step result: The Open dialog box appears.

2 Choose a location, select the file, and click Open.

3 To read a codeplug from a radio, in the Radio Icons List, right-click the radio icon.
Step result: The context menu appears.

4 Click Read.
Step result: Once the reading operation begins, do not disconnect or turn off the radio. The radio icon turns
orange and the progress bar displays the operation status. Wait until the operation is complete, the radio
icon turns green.

5 To read codeplugs from multiple radios, click File → Read Radio.
Step result: The Read Radio dialog box appears.

6 Select the radio or radios and click Start Operation.
Step result: Once the reading operation begins, do not disconnect or turn off the radio. The radio icon turns
orange and the progress bar displays the operation status. Wait until the operation is complete, the radio
icon turns green.

4.3.5 Reading Codeplugs from Radios
Prerequisites:
Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

When and where to use:
You want to view a current configuration of a connected radio or radios.
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Procedure Steps

1 To read a codeplug from a single radio, right-click the radios icon and select Read.
Step result: Once the reading operation begins, do not disconnect or turn off the radio. The radio icon turns
orange and the progress bar displays the operation status. Wait until the operation is complete, the radio
icon turns green. A codeplug displays.

2 To read codeplugs from multiple radios, click File → Read Codeplug

Step result: The Read Radio dialog box appears.

3 Select the radios.

4 Click Start Operation.
Step result: Once the reading operation begins, do not disconnect or turn off the radio. The radio icon turns
orange and the progress bar displays the operation status. Wait until the operation is complete, the radio icon
turns green. Codeplugs for each selected radio display.

4.3.6 Writing a Codeplug to a Single Radio
Prerequisites:
Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

When and where to use:
You want to write a codeplug to a single radio.

Hardware calibration values are tuned individually, that means that each radio has its unique codeplug.

SUGGESTION

To apply changes to multiple, compatible radios, use a profile or the Copy Wizard option with a master
codeplug.
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4.3.7 Writing a Master Codeplug to Multiple Radios

Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 Modify the codeplug accordingly.

3 Save the codeplug.

4 To write the codeplug to the radio, click File → Write Radio.

5 Select the radio and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

4.3.7 Writing a Master Codeplug to Multiple Radios
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.
• The codeplug must be compatible with the targeted radio or radios.
• All the programmed radios are of the exact same model.

When and where to use:
You want to apply common settings to multiple, identical radios. Instead of writing individual codeplugs to each
radio, you can prepare a single, master codeplug or a profile. Either one allows you to replicate common settings
(user data) to another radio or radios.

Using Copy Wizard or a profile you overwrite user data (adjustable parameters) on the selected radio.
Hardware calibration values (so important for each individual device) remain unchanged.

Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 Modify the codeplug accordingly.
Step result: The modified codeplug becomes a master codeplug for multiple radios.

3 Save the master codeplug.

4 Click File → Copy Wizard.
Step result: The Copy Wizard — Select Groups dialog box appears.
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5 Click Select All.

6 Click Next.
Step result: The Copy Wizard dialog box appears.

7 Select the radio or radios and click Start Operation..

• Auto ISSI Assignment— to make CPS Plus automatically assign consecutive ISSI numbers (each
radio must have a unique ISSI), select the check box and enter the starting number. Otherwise, after
applying the master codeplug to the radios, manually assign ISSI to each device.

• Enable Selling Feature— to activate the selected selling features on each radio, plug in the selling
feature dongle and select the check box.

Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

8 To manually change ISSI, read the codeplug from the radio. Go to Codeplug → Subscriber Unit Parameters
→ Radio ISSI and enter the value. Write the codeplug to the radio.

Must match enabled ISSI on the network.

4.3.8 Adding a First, New Radio to the System
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• This task requires a thorough knowledge about the system and network.

SUGGESTION

It is a long task. Read all the steps before configuring the radio.

When and where to use:
You want to configure a radio to at least make and receive calls on the network.

Procedure Steps

1 Read a codeplug from the new radio.
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2 Assign ISSI. Go to Codeplug → Subscriber Unit Parameters → Radio ISSI and enter the value.

Must match enabled ISSI on the network.

3 If configured, users can preview the radio ISSI from the menu or as a home screen information, or a welcome
screen. Copy the ISSI number and paste to the following fields accordingly:
a. Codeplug → Subscriber Unit Parameters → This Radio Private Number— ISSI displays on a radio

when the user navigates toMenu → My Info → My Private Num.
b. Codeplug → Display Parameters → Home Mode Display → Home Mode Display Text— ISSI

displays on a radio in the idle mode.
c. Codeplug → Display Parameters → Home Mode Display → Welcome Screen— ISSI displays as a

radio welcome screen; only if a screen saver is disabled.
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4 Assign GSSI to talkgroups.
All Motorola radios support a folder structure for talkgroups. There can be a single level or dual level folder
structure. Before you add GSSI to talkgroups, create the folders and the talkgroups.
a. To create a folder, go to Codeplug → Talkgroups → TMO→ TMO Folders List and name each folder.
b. To make the folder visible and allow users to enter talkgroups, select the Status check box.

SUGGESTION

To fill out multiple fields with the same value or to select multiple check boxes in the same
column, highlight the fields, right-click, and select Fill Down.

c. To define the capacity of the folder, enter the value for the Number of Talkgroups in the Range.

The total number of talkgroups for all folders determines the number of rows in the Talkgroups
in Folder node.

d. To organize folders into a structure with subfolders nested underneath the parent folders, from the Parent
Folder, select the primary one.

e. To prevent users from transmitting voice, select the Receive Only check box.
f. To create a talkgroup, go to Codeplug → Talkgroups → TMO→ TMO Talkgroup Lists, name each

talkgroup and enter the GSSI in to the ID field.
g. To set visibility properties for talkgroups, go to Codeplug → Talkgroups → TMO→ Talkgroups in

Folder, click a field under the Name column and select the talkgroup.
The following statuses are available:

• Programmed— users can see and select this talkgroup. Leave as the default status.

• Not Programmed— users cannot see nor select this talkgroup. It is also unreachable by Call
Out messages.

• Invisible— users cannot see nor select this talkgroup but it is reachable by Call Out messages.

SUGGESTION

To quickly select a talkgroup, enter the first character of the name before scrolling down the
talkgroup list.

h. Go back to Codeplug → Talkgroups → TMO→ TMO Talkgroup List and if needed, from the Default
Folder, select the primary folder for each talkgroup.

i. If Announcement Talkgroups (ATG) are enabled on the network then each talkgroup can have one ATG
assigned to it. To make the talkgroup ATG, select the Announce Group check box. You can allow users
to start announcement calls. To assign to ATG, from the Associated Announce Group drop-down list,
select the value.

j. Select a group priority if the network supports this feature.
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5 Verify Group Cipher Key (GCK). Go toCodeplug→ Talkgroups→ TMOTalkgroup Lists →GCKNumber.
GCK allows the radio to operate on networks that have this level of security.
a. To import the keys, click File → Import → KARs and KAGs.
b. Select the appropriate files and click Import.
c. For many talkgroups, more than one KAR or KAG file may be required. Make sure that you import all files.
Step result: Once the keys are imported, the GCK Number column displays the values. If no KAGs have
been imported, it shows the default number 65536.

6 Adjust the security settings. Go to Codeplug → Security.

Consult your network provider to ensure the correct setup.

7 Set the start scan frequency and a number of frequencies to scan. Go to Codeplug → Mobility and System
Parameters → Frequency List → Frequency List 1–4 and enter the values.

• Frequency List 1— the radio populates this list once it has registered on a network and so the CPS
Plus cannot load frequencies.

• Frequency List 2— a list of permanent frequencies used on a network that can be used to enable
faster initial registration.

• Frequency List 3 and Frequency List 4— use to force the radio to scan two sub bands. It can speed
up the first registration of a radio on a network.

– First Frequency to Scan must match the lowest frequency used on the network.

It is not always a round number, such as 490.00000 MHz. For example a network that
uses 12.5 kHz offsets may start at 490.0125 MHz.

– Number of Frequencies is normally set to 400.

8 Set Country Code and Network Code of the system to register on. Go to Codeplug → Mobility and System
Parameters → Address Extension → Country Code | Network Code and enter the values.

9 Save the changes.

10 Write the codeplug to the radio.

SUGGESTION

Each radio must have unique ISSI. If you write the codeplug to multiple radios, you can use the Copy
Wizard option and assign consecutive numbers of ISSI to each device.

Postrequisites:
Test the radio on the network.
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4.3.9 Adding Another, New Radio to the System
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• You have a master codeplug that you use for existing radios or you have a properly configured radio to
read the codeplug from.

• The codeplug must be compatible with the targeted radio or radios.

When and where to use:
You want to add another radio or radios to an existing fleet. You want the new radio to have the same configuration
as the existing devices (master codeplug).

Using Copy Wizard or a profile you overwrite user data (adjustable parameters) on the selected radio.
Hardware calibration values (so important for each individual device) remain unchanged.
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4.3.10 Enabling a Standard Feature on a Radio

Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

The new and the existing radios must be of the exact same model.

2 Click File → Copy Wizard.
Step result: The Copy Wizard Select Groups dialog box appears.

3 Click Select All.

4 Click Next.
Step result: The Copy Wizard dialog box appears.

5 Select the radio or radios and click Start Operation.

• Auto ISSI Assignment— to make CPS Plus automatically assign consecutive ISSI numbers (each
radio must have a unique ISSI), select the check box and enter the starting number. Otherwise, after
applying the codeplug to the radios, you must assign ISSI to each device.

• Enable Selling Feature— to activate the selected selling features on each radio, plug in the selling
feature dongle and select the check box.

Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

6 To manually change ISSI, read the codeplug from the radio. Go to Codeplug → Subscriber Unit Parameters
→ Radio ISSI and enter the value. Write the codeplug to the radio.

Must match enabled ISSI on the network.

4.3.10 Enabling a Standard Feature on a Radio
Prerequisites:
Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

When and where to use:
You want to enable a feature on a radio or radios.
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Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 Go to Codeplug → Feature Flags and select the check box for the appropriate feature.

3 To write the codeplug to a radio, click File → Write Radio or use the right-click menu from the Radio
Icons List.

SUGGESTION

To apply changes to multiple, compatible radios, use a profile or the Copy Wizard option with a master
codeplug.

Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

4.3.11 Enabling a Selling Feature on a Radio
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• Plug in the dongle with Selling Feature licenses to the PC.

• Close all codeplugs.

When and where to use:
You want to update radios configuration and add a selling feature, for example the WAP feature. Licences for the
paid features are stored on the Selling Feature dongle (USB stick).
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4.3.12 Modifying a Codeplug Using an XML File

Procedure Steps

1 Click Tools → Enable Selling Feature.
Step result: The Enable Selling Feature dialog box appears with all the connected radios listed.

2 From the Feature list, select the items.

3 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

4 To verify that the proper features are enabled on the radio, read the codeplug from the radio and go to .

5 Go to Codeplug → Feature Flags and select the check box for the appropriate feature.

6 To write the codeplug to a radio, click File → Write Radio.

Result:
You have added and enabled the selling feature to the radio.

4.3.12 Modifying a Codeplug Using an XML File
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• You have MS Excel 2003® or higher or other XML editor.

When and where to use:
You want to modify radio configurations using an external XML file. It is especially useful when you want to change
and apply the same configuration to multiple radios of the same type by creating a template (a master codeplug). For
example, in a special event you want to configure a fleet of radios with the same operational talkgroups. An XML file
can be prepared outside CPS Plus (use MS Excel 2003® or higher), then imported and applied to a master codeplug.
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Procedure Steps

1 Open a codeplug from a disk or read it from a radio.
Step result: The codeplug opens.

2 To export an XML file from CPS Plus: click File → Export → User Data

Step result: The Feature List dialog box appears.

3 Select user data and click OK.
Step result: The Save As window appears.

4 Choose a location, enter the file name and click Save.
Step result: After a confirmation message appears, you can switch from CPS Plus to an external XML editor to
modify user data values.

5 To modify the XML file: launch the XML editor, open the XML file that you exported from CPS Plus,
modify the values, and save the file as the XML format.
Step result: You have modified the XML file. You can switch to CPS Plus and import the User Data file.

6 In CPS Plus, verify that the codeplug you want to modify using the XML file is opened.

7 To import the XML file to CPS Plus, click File → Import → User Data.
Step result: The Open dialog box appears.

8 Choose a location, select the file, and click Open..
Step result: The importing operation begins. Wait until a confirmation message appears.

9 Save the codeplug.

Result:
You modified the codeplug using data from the XML file. You can use the modified codeplug as a master codeplug.

SUGGESTION

To apply changes to multiple, compatible radios, use a profile or the Copy Wizard option with a master
codeplug.
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4.3.13 Upgrading a Radio

4.3.13 Upgrading a Radio
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• You have the proper software release pack.

• If you are upgrading a mobile radio version along with languages, it is necessary for the transceiver to have
the desired languages enabled its codeplug. See 4.4.9 Adding Languages to Radios, page 4-50.

When and where to use:
You want to load newer software to a radio.

Due to USB limitations, you can upgrade up to 16 radios at the same time.
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Procedure Steps

1 Click one of the following:
• Tools → Upgrade Radio

• To roll back a radio to it's previous version without loosing user data, use the Restore
Radio function

• To upgrade a radio between MR5.6 and MR5.9 or post-MR5.9 version use the
Up/Downgrade Radio Lite function.

• Tools → Up/Downgrade Radio Lite

• Upgrade Lite only allows to upgrade radios that are version pre-MR5.9 to a version that
is MR 5.9 or newer.

• Downgrade Lite only allows to downgrade a radio to MR5.9 or newer.

This will get rid of all user data and only keep the selling feature, factory and sensitivity data after
up/downgrade. If you want to keep the user data during upgrade use the Upgrade Radio function
instead.

2 From the Up/Downgrade to drop-down list, select the software version.

3 From the Languages drop-down list, select the language(s) that are to be used on the radio.

For mobile radios, select matching languages for both transceiver and control head.

4 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

Postrequisites:
To verify that the operation has been successful and to find logs from other operations, clickWindow → Task
Window.
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4.3.14 Changing a Radio Screen Saver

Turning On Radios in Flashing Mode — Automatically

Turning On Radios in Flashing Mode — Manually

Connecting Radios to a PC

Radio Icons List

4.3.14 Changing a Radio Screen Saver
Prerequisites:

• Applies only to radios with a color display.

• You have a GIF image ( maximum 256 colors) on a disk (an animated GIF file also supported).

• The graphic file size does not exceed 18 kB.

• The maximum image dimensions are 130x130 pixels for portable radios and 640x480 pixels, 240x320 or
320x240 for mobile radios depending on your mobile radio model..

When and where to use:
You want to replace a default radio screen saver image with a custom picture, for example the department logo. The
screen saver image is a decorative, background element for the radio display (it does not save the screen or a battery).

SUGGESTION

To apply changes to multiple, compatible radios, use a profile or the Copy Wizard option with a master
codeplug.
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Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 To import the image to CPS Plus, click File → Import → Screen Saver.
Step result: The Import Screen Saver dialog box appears.

3 Click Load.
Step result: The Open dialog box appears.

4 Choose a location, select the file, and click Open.
Step result: The Import Screen Saver dialog box appears. You can preview the selected image.

5 Click Import.
Step result: The Operation completed successfully message appears.

6 To adjust the screen saver parameters, go to Codeplug → Display Parameters → Screen Saver and modify
accordingly.

7 To verify that the screen saver option is available from the radio menu, go to Codeplug → Display Parameters
→ Menu Configuration → Setup → Display → Screen Saver..

Postrequisites:
Write the codeplug to the radio.

SUGGESTION

You can assign One-Touch Button to this function.

4.4 Using CPS Plus
The following topics are designed to help you perform specific tasks using the CPS Plus application.

4.4.1 Using the USB Driver Tool
Prerequisites:

• CPS is installed on the computer.

• You know your CPS version.

• You understand the concept of switching between the new and old USB drivers.
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4.4.1.1 Radio Software Release Versions Matrix

When and where to use:
After installing the CPS Plus application, you can still retain previous versions of CPS. Legacy CPS may be
needed if you support radios running on legacy software platforms, not supported by the new CPS Plus (lower than
MR5.9). The USB Driver Tool ensures that you always install the proper USB drivers for relevant CPS. If you
want to use the legacy CPS (versions older than R6x.575.01) with old radios (MR5.9 and older), use Install Old
Driver. Each time when you install the drivers, you overwrite the existing USB drivers (newer or older). Therefore,
to program radios using CPS Plus after using the legacy, old CPS and radios, use Install New Driver. CPS Plus
always works with the new USB drivers.

Procedure Steps

1 Click Start → Programs → Motorola → USB Driver Tool

Step result: The CPS Driver Tool window appears.

2 Click either button to install the relevant driver.

If the Software Installation window appears, click Continue Anyway.
Step result: The installation begins. Wait until the following message appears: Installation
finished! Press any key to continue....

4.4.1.1 Radio Software Release Versions Matrix
CPS Plus supports radio software from MR5.9 onwards. For older radio software, use the legacy CPS.

Table 4-17 CPS Plus — Samples of Radio Software Versions

Radio Model MR5.9 MR5.10 MR5.11 MR5.12
MTP850, 800MHz R10.xxx.6511 R10.xxx.6911 R10.xxx.7108 R10.xxx.7412

MTM800E Control
Head/ Transceiver

R14.xxx.6511 /
R17.xxx.6511

R14.xxx.6911 /
R17.xxx.6911

R14.xxx.7108 /
R17.xxx.7108

R14.xxx.7412 /
R17.xxx.7412

4.4.2 Importing Release Packets to CPS Plus
Prerequisites:
You have the release packet on the disk.

When and where to use:
You have received new release packets and you want to use CPS Plus to upgrade radios. Also, when you had your
CPS Plus repository folder removed from the disk (for example after a disk failure).
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Procedure Steps

1 Click Packet → Import Packet.
Step result: The Open window appears.

2 Select the release packet file and click Open.

SUGGESTION

To select multiple files, press and hold the CTRL key. To select a block of files, press and hold the
SHIFT key.

Step result: Importing begins. It takes approximately 20 seconds to import a single packet.

3 After the operation is complete, click OK.
Step result: CPS Plus restarts.

Result:
CPS Plus stores the packet in the default repository folder. The content of the packet (software files, codeplugs,
and audio profiles) is ready to use with your radios.

4.4.3 Converting Codeplug/Profile Radio Model
Prerequisites:

• Make sure that the release packet supporting the target radio model is imported into the CPS.

• The source codeplug or profile is opened in the CPS.

When and where to use:
Use to convert a codeplug or profile for use with other radios.

Procedure Steps

1 Click File → Convert Model.
Step result: The Convert Model window appears.

2 Select the target radio models for which you want to convert the codeplug or profile to.

3 In the Target Version column, select the target version the codeplug or profile will be converted to.

4 Press Convert and allow the operation to finish.
Step result: The new converted codeplug or profile window appear.

Postrequisites:
After converting the codeplug or profile for a radio it is necessary to save the results for each new window.
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4.4.4 Copying Configuration Between Radios and Codeplugs

4.4.4 Copying Configuration Between Radios and
Codeplugs

Prerequisites:

• The codeplug parameters must be valid.

• The codeplug must be compatible with the targeted codeplug or codeplugs.

• The codeplug must be compatible with the targeted radio or radios.

When and where to use:
You want to copy parameter values from one codeplug to other codeplug or codeplugs, or directly to other radio or
radios. CPS Plus provides multiple ways to replicate configuration between codeplugs or radios.

1. You can copy configuration (whole nodes) between two codeplugs, for example all values for the Security
node from a codeplug A to a codeplug B.

2. You can copy configuration (entire or only selected user data) from a master codeplug to other codeplugs
or radios using the Copy Codeplug Wizard and Copy Wizard options.

3. You can create a profile with a subset of specified codeplug parameters. You can store the profiles on the
disk and apply to codeplugs or radios anytime (the Copy Wizard is a real-time option) or even share with
other CPS Plus users.

If you copy Subscriber User Parameters to multiple radios, verify that each radio has a unique ISSI.

Using Copy Wizard or a profile you overwrite user data (adjustable parameters) on the selected radio.
Hardware calibration values (so important for each individual device) remain unchanged.

Procedure Steps
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1 To copy parameters between a codeplug A and a codeplug B follow the substeps:
a. Open the two codeplugs or read the codeplugs from radios.
b. To fit the two codeplugs on the screen, clickWindow → Tile Vertical.
c. Click the relevant node in the codeplug A to select it.
d. Drag the node from the codeplug A to the corresponding node in the codeplug B.

Figure 4-7 CPS Plus — Drag-and-Drop Operation Between Codeplugs

Step result: You have copied parameter values from the selected node in the codeplug A to the same
node in the codeplug B.

e. Save changes in the codeplug B.
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4.4.4 Copying Configuration Between Radios and Codeplugs

2 To copy parameters from a master codeplug to other codeplugs using the Copy Codeplug Wizard, follow
the substeps:
a. Open the master codeplug from a disk or read it from the radio.
b. Click File → Copy Codeplug Wizard.

Step result: The Copy Codeplug Wizard — Select Groups dialog box appears.
c. Select a group or groups with user data parameters and click Next.

Dependent, lower level user data gets automatically selected.

Step result: The Select the Target Codeplug Files dialog box appears.
d. Select a codeplug or codeplugs and click Open.

Step result: The Target Codeplugs dialog box appears. The compatible codeplugs are selected.
e. Click Copy.

Step result: The operation begins. Wait until it is completed. CPS Plus copies the parameters and saves
changes to the updated codeplugs.

f. To change ISSI, open the codeplug, go to Codeplug → Subscriber Unit Parameters → Radio ISSI and
enter the value.

3 To copy parameters from a master codeplug to radios using the Copy Wizard, follow the substeps:
a. Open the master codeplug from a disk or read it from the radio.
b. Click File → Copy Wizard

Step result: The Copy Wizard — Select Groups dialog box appears.
c. Select a group or groups with user data parameters and click Next.

Dependent, lower level user data gets automatically selected.

Step result: The Copy Wizard dialog box appears.
d. Select the radio or radios and click Start Operation.

• Auto ISSI Assignment— to make CPS Plus automatically assign consecutive ISSI numbers (each
radio must have a unique ISSI), select the check box and enter the starting number. Otherwise, after
applying the master codeplug to the radios, you must manually assign ISSI to each device.

• Enable Selling Feature— to activate the selected selling features on each radio, plug in the
selling feature dongle and select the check box.

Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio
icon turns orange and the progress bar displays the operation status. Wait until the operation is complete,
the radio icon turns green.
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4.4.5 Comparing Codeplugs
When and where to use:
You want to examine differences in configuration between two codeplugs and copy the values between the codeplugs.

Procedure Steps

1 Open the two codeplugs.

2 Click File → Compare Codeplug.
Step result: The Select Document window appears.

3 Select the check boxes and click OK.

If the OK button is inactive it means that the codeplugs are not compatible. Verify the version and
the model and open the correct file.

Select the Bypass the User Defined Language comparison checkbox to bypass the comparison of the
User Defined Language Nodes of the two codeplugs.

Step result: The Compare Codeplug window with listed differences appears.

4 To filter the codeplug tree and display only the different nodes, click Diff Features.
Step result: The codeplug tree shows only the different nodes but all the fields within these nodes.

5 To filter the codeplug tree and display only the different nodes and the particular different fields within these
nodes, click Diff Fields.
Step result: The codeplug tree shows only the differing nodes and the differing fields within these nodes.

Click Report to save the comparison results to a *.txt file.

6 (Optional) To copy a value from one codeplug to another, highlight the appropriate codeplug path in the
Compare Codeplug window.

7 (Optional) From the Compare Codeplug window toolbar press <- or -> depending on which value you
want to copy.
Step result: The changed codeplug value becomes highlighted.
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4.4.6 Verifying Codeplug/Profile for Copy

8 Close the window and chose the codeplug(s) to save. Press Save.

Supported File Formats

4.4.6 Verifying Codeplug/Profile for Copy
Prerequisites:

• The codeplug or profile is opened in the CPS.

When and where to use:
Use to verify if there are any invalid fields in the codeplug or profile before copying them to the radio.

Procedure Steps

1 Select the desired codeplug or profile you would like to verify.

2 Click File → Verify Codeplug/Profile for Copy

Step result:

• If passed a message box saying There is no potential error. is displayed

• If failed the Potential Invalid Field window is displayed. Double-click on each filed displayed in
the window and correct the values.

4.4.7 Upgrading a Codeplug
When and where to use:
You have received a new release packet. You can use the new codeplugs (modify if needed) or upgrade your older,
already configured codeplugs, and add the latest radio features and parameters. After this operation, the user data
values in your old codeplug remain unchanged and only the newly added parameters are set to defaults.
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Procedure Steps

1 Click File → Open with Up/Downgrade.

2 Select the file and click Open.

SUGGESTION

You can select multiple files.
Step result: The Up/Downgrade Codeplug window appears.

3 From the Target Version drop-down list, select the software version.

4 Click Start Operation.
Step result: After the upgrade is complete, the individual codeplugs open.

5 Save the upgraded codeplug.

Postrequisites:
If needed, configure the new parameters.

Supported File Formats

4.4.8 Modifying Configuration Using Profiles
Profile is a subset of specified parameters. Unlike codeplugs, profiles contain only selected nodes and fields.
Profiles are smaller than codeplugs; therefore programming time for a single profile is much shorter than for
an entire codeplug.
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4.4.8 Modifying Configuration Using Profiles

Figure 4-8 CPS Plus — Using Profiles

Examples for Using Profiles

1. You have a codeplug with default values. You want to have it configured according to operational
requirements. You want to delegate the configuration to engineers with specific knowledge domains for
example GPS experts, audio experts, and so on. You create separate profiles with specific nodes and
send them to the engineers.

2. You received an announcement about an upcoming event and as a result the radios must be reconfigured
for a weekend. It turned out that only Audio Settings must be temporarily tuned up. You generate two
profiles with Audio Settings. The first profile contains current settings. The second profile is modified
according to the new requirements for the weekend event. You program your radios for the event. After
the weekend, you revert the changes using the profile with the original audio values.

3. You want to make a minor change to the codeplug and replicate the changed configuration among multiple
radios. Creating a profile and writing it to multiple radios is efficient especially when your change involves
a single or a few related fields, for example enabling/disabling features.
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Creating a Profile

Applying Profiles to Codeplugs

Applying Profiles to Radios

4.4.8.1 Creating a Profile
When and where to use:
You want to create a configuration file with a subset of specified parameters from a codeplug. You can use profiles
with codeplugs or radios. Profiles are smaller than codeplugs; therefore programming time for a single profile is
much shorter than for an entire codeplug.

Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 To create a profile, click File → Generate Profile.
Step result: The Generate Profile — Select Groups dialog box appears.

3 Select a group or groups with user data parameters and click Next.

Dependent, lower level user data gets automatically selected.
Step result: The Save As window appears.

4 Save the profile.

Postrequisites:
To modify the profile, click File → Open Profile and adjust the parameters accordingly.

4.4.8.2 Applying Profiles to Codeplugs
Prerequisites:

• The codeplug is opened and active.

• The profile and the codeplug are for the same radio model type.

• The profile version is not higher than the codeplug version.
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4.4.8.3 Applying Profiles to Radios

When and where to use:
To replicate configuration from a profile to a codeplug.

Figure 4-9 CPS Plus — Applying Profiles to Codeplugs

Procedure Steps

1 Click File → Apply Profile.
Step result: The Open window appears.

2 Select the profile and click Open.

Result:
Configuration from the opened profile is applied to the codeplug.

4.4.8.3 Applying Profiles to Radios
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• You have the profile file on the disk.

• The profile is appropriate for the radio model type.

• The profile version is not higher than the radio version.
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When and where to use:
To replicate configuration from a profile to a radio.

Figure 4-10 CPS Plus — Applying Profiles to Radios

Procedure Steps

1 Click File → Apply Profile to Radio.
Step result: The Open window appears.

2 Open the profile.
Step result: The Apply Profile to Radio dialog box appears.

3 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

4.4.9 Adding Languages to Radios
Prerequisites:

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

• The radio software supports the chosen language.

• The radio software ships with default language, it is highly recommended to add local language to the
first codeplug.

When and where to use:
You want to localize the radio settings. In other words, after programming multiple language packs to the radio, the
radio user can choose a preferred language from the radio menu.
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4.4.10 Importing Audio Templates to CPS Plus

Procedure Steps

1 Click Tools → Radio Languages Settings.
Step result: The Languages dialog box appears.

2 From the drop-down list, select a language.

SUGGESTION

To define a default language pack (always selected languages), click Tools → User Options → Default
Language Packs , then select the default language packs and click OK.

3 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

4 To activate a specific language on a radio, open or read the codeplug from the radio.

5 Go to the following codeplug node:Codeplug → Language Parameters → Language Settings.

6 Select a language.

7 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

Postrequisites:
Radio users can select a local language using the language menu on the radio.

4.4.10 Importing Audio Templates to CPS Plus
Prerequisites:

• Close all codeplugs.

• You have an audio template file (*.stf) or an audio template package (*.sfts).

When and where to use:
Default audio template files are included in release packets. In some cases, engineers can provide you with separate,
customized templates. You can import them to the CPS Plus repository and use for radio audio profiles. You
cannot create audio templates using CPS Plus.
You cannot create audio templates using CPS Plus.
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Procedure Steps

1 Click Tools → Import/Remove Audio Template Files.
Step result: The Import/Remove Audio Template Files window appears.

2 To import a new audio file or an audio package, click Import.

3 To replace an existing audio template, select the file and click Remove. Import the new file afterwards.

4.4.11 Importing Audio Device Descriptors to CPS Plus
Prerequisites:

• Your accessory is not listed in the following codeplug table: Codeplug → Buttons, Keys, and Accessories
→ Accessory List

• You have an Audio Device Descriptors (*.add) file. These files are provided separately by Motorola.

When and where to use:
Some radio models (MTP3xxx, MTP8xxx) use Audio Device Descriptors for compatible IMPRES accessories (with
an ADS chip). In such cases, a separate ADD file holds information about the hardware and a separate audio
template provides audio settings for the accessory. You can import an ADD file and store the relevant data in the
CPS repository. That means that you can have your own, custom audio values for the attached accessory, different
than those stored by the ADS chip itself. You cannot create an ADD file using CPS Plus.

If you are unable to find the Accessory List node, that means that your radio model does not support ADD
files. All information about accessories hardware is in audio templates. You can skip this procedure.

Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 To import the ADD file, go to Codeplug → Buttons, Keys, and Accessories → ADD Import/Remove.

3 Click Import.
Step result: The Open dialog box appears.

4 Choose a location, select the file, and click Open.

Result:
The codeplug stores information about the accessories specified in the *.add file. After programming, the radio
supports the listed accessories.
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4.4.12 Removing Audio Device Descriptors From CPS Plus

Removing Audio Device Descriptors From CPS Plus

Applying Audio Templates to Radios

Importing Audio Templates to CPS Plus

4.4.12 Removing Audio Device Descriptors From CPS Plus
Prerequisites:
Audio Device Descriptors are already stored by CPS and you can see a list of supported accessories in the following
codeplug table:Codeplug → Buttons, Keys, and Accessories → Accessory List

When and where to use:
Some radio models (MTP3xxx, MTP8xxx) use Audio Device Descriptors for compatible IMPRES accessories (with
an ADS chip). In such cases, a separate ADD file holds information about the hardware and a separate audio
template provides audio settings for the accessory. You can import an ADD file and store the relevant data in the
CPS repository. That means that you can have your own, custom audio values for the attached accessory, different
than those stored by the ADS chip itself. You cannot create an ADD file using CPS Plus.

If you are unable to find the Accessory List node, that means that your radio model does not support ADD
files. All information about accessories hardware is in audio templates. You can skip this procedure.

Procedure Steps

1 Open a codeplug from a disk or read it from a radio.

2 To remove an accessory from the codeplug, go to Codeplug → Buttons, Keys, and Accessories → ADD
Import/Remove.

3 Click Remove.
Step result: The Remove Accessory dialog box appears.

4 Select the accessory and click OK.

5 Choose a location, select the file, and click Open.
Step result: CPS stores on the disk and updates the codeplug with the information about the imported hardware.

Result:
The codeplug no longer stores information about the removed hardware. After programming, the radio no longer
supports the removed accessory.
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Importing Audio Device Descriptors to CPS Plus

Applying Audio Templates to Radios

Importing Audio Templates to CPS Plus

4.4.13 Restoring a Radio
Prerequisites:

• You have a relevant software release packet on a disk.

After you import a release packet using the Import Packet option, CPS Plus stores all the software
components in the following directory:c:\Program Files\Motorola\Tetra CPS
Plus\Bin\repository_link_folder\.

• You have copies of the relevant codeplugs in the backup folder.

Each time after reading a radio, CPS Plus automatically backs up each codeplug and
stores in the following directory: c:\Program Files\Motorola\Tetra CPS
Plus\BackupCodeplugs\.

When and where to use:
You want to downgrade a radio. In other words, you want to write a previous version of software to the radio. For
example, you wrote a newer beta software to the radio for testing purposes and afterwards, decided to revert the
radio to its previous configuration.

After this operation, the user data values remain unchanged.

Procedure Steps

1 Click Tools → Restore Radio.
Step result: The Restore Radio window appears.

2 From the Restore To drop-down list, select the software version.
Step result: CPS Plus automatically selects the appropriate software for the radio.
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4.4.14 Recovering a Radio

3 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

If the radio software version, that you selected, does not match the codeplug version, that resides on
the radio, an error message appears. Verify that the radio software used for restoring and the codeplug
that resides on the restored radio have the same version.

4.4.14 Recovering a Radio
Prerequisites:

• The Tools → User Options → Recovery → Recovery Mode is set toManual.

• You connected the radio to PC and turned it on in flashing mode.

• The radio icon displays a red warning sign and the context-menu in the Radio Icons List is not available
for the radio.

• You are unable to read the radio.

• You have a relevant software release packet on a disk.

After you import a release packet using the Import Packet option, CPS Plus stores all the software
components in the following directory:c:\Program Files\Motorola\Tetra CPS
Plus\Bin\repository_link_folder\.

• You have copies of the relevant codeplugs in the backup folder.

Each time after reading a radio, CPS Plus automatically backs up each codeplug and
stores in the following directory: c:\Program Files\Motorola\Tetra CPS
Plus\BackupCodeplugs\.
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When and where to use:
To manually recover the corrupted areas of the radio flash memory (occurred due to programming errors) and
write the correct software components again.

SUGGESTION

CPS Plus can trigger the recovery automatically. Go to Tools → User Options → Recovery → Recovery
Mode , set the Auto mode and let CPS Plus perform the recovery when needed. CPS Plus uses radio
software from the release packet repository and copies of compatible codeplugs. If all software components
(release packets, backup codeplugs) are proper and located on the disk, CPS Plus automatically selects the
appropriate radio software and starts the process.

Procedure Steps

1 To verify that the radio is corrupted, click File → Read Radio.
Step result: The Read Radio dialog box appears. You are unable to select the radio and the description
line displays: The radio is corrupted. Please use Recover Radio to repair it
and try again.

2 Click Tools → Recover Radio.
Step result: The Recover Radio dialog box appears.

3 From the Recover To drop-down list, select the software version.

4 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

Result:
Once the radio is recovered, the radio icon turns green. You can read the radio.

4.4.15 Applying a Hotfix File
Prerequisites:

• You have the appropriate .hfx hotfix file.

• Connect a radio or radios to the PC, turn on in flashing mode, and wait until the radio icon appears on the list.

When and where to use:
You received a hotfix file that contains customized values of codeplug parameters. You want to fix radios
configuration using the hotfix file.
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4.5 Troubleshooting

Procedure Steps

1 Locate the hotfix file on the disk, using the Windows® Explorer.

2 Double-click the hotfix file.
Step result: CPS Plus is brought to front and the Select Radio dialog box appear.

3 Select the radio or radios and click Start Operation.
Step result: Once the programming operation begins, do not disconnect or turn off the radio. The radio icon
turns orange and the progress bar displays the operation status. Wait until the operation is complete, the
radio icon turns green.

Postrequisites:
Verify that the radio settings are correct.

4.5 Troubleshooting
The following topics are designed to help you identify and overcome possible problems or unexpected situations.

4.5.1 Unable to Launch CPS
1. Only one CPS instance (process) can run at the time.

2. CPS may already be running and its window minimized.

3. Terminate the CPS process manually and try launching CPS again. To shut down the process, press
CTRL+ALT+DELETE keys, click TaskManager, select theCPSPlus.exe instance and click End Process.

4.5.2 Unable to Exit CPS Plus
Terminate the CPS process manually. To shut down the process, press CTRL+ALT+DELETE, click Task Manager,
select the CPSPlus.exe instance and click End Process.

4.5.3 A Radio is not Functioning
1. Charge the battery.

2. Remove the battery, wait for 10 seconds and reinstall the battery.

3. Contact customer support.
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4.5.4 Programming Mode Cannot Initiate
You connected the radio to the PC but failed to turn it on in flashing mode.

1. Charge the battery.
2. Verify that the radio functions properly. Turn the radio on and off. If you cannot turn it on, remove the

battery, wait for 10 seconds and reinstall the battery.
3. Connect the radio to a different USB port.
4. Verify that the hardware is properly installed in Windows. Go to Device Manager → Universal Serial

Bus controllers. If the TETRA hardware is not on the list, scan for new USB devices and reinstall the
USB drivers.

5. Verify that you use proper USB drivers dedicated to the software release.
6. Do not disconnect the radio and restart the PC. If new hardware is found, reinstall the USB drivers manually.
7. Contact customer support.

4.5.5 I Disconnected a Radio During Programming
1. Do not turn off the radio.
2. Do not exit CPS Plus.
3. Reconnect the radio to the PC.
4. Wait until CPS Plus discovers the radio (it appears in Radios Icons List).
5. Repeat the programming operation.

SUGGESTION

To verify the programming operations history, clickWindow → Task Window.

4.5.6 Programming Interrupted or Failed
Connect the radio to the PC as for programming. If needed, CPS Plus automatically recovers the radio using its
previous configuration, (CPS Plus backs up the proper configuration on a disk).

SUGGESTION

To verify the programming operations history, clickWindow → Task Window.

The radio codeplug must have been read at least once by the CPS in order to take backup.

4.5.7 Invalid Codeplug Parameters
You are unable to save the codeplug or perform certain operations.

1. To find the invalid parameters, go to the Information pane, click the Invalid tab, and double-click the path.
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4.5.8 Report Issue

SUGGESTION

Alternatively, you can use the Compare Codeplug to find the differences (including the invalid parameters)
between two files.

2. Correct the values and try again.

4.5.8 Report Issue
Prerequisites:

• Active internet connection.

• Configured e-mail client.

When and where to use:
When an application or codeplug error occurs, you may send a report to inform Motorola Solutions about the issue.

Procedure Steps

1 Click Help → Issue Report

Step result: The Report Issue window appears.

2 Enter optional information such as User Name and Issue Description. Check-mark the boxes to select
information that will be included in the report.

3 Check-mark Open Mail Application to Review Report Before Sending if you wish to add additional
information or reports to the e-mail. Otherwise an issue report is sent after pressing Send Report.

4 Press Send Report.
• Optionally you can press Create Report Archive. A pop-up window appears that allows you to save

the issue report to a ZIP file.
Step result: A new e-mail message window appears from your default e-mail client.

5 Add additional information about the issue and manually send the e-mail.
Step result: A message window saying The report archive has been sent successfully is displayed.
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Appendix A: Glossary

Item Description
10/100Base-T A method of connecting Ethernet devices directly to an Ethernet switch/hub. Max

transfer rate is 10 or 100 Mbps

A-ISSI Assigned ISSI

A/V Antivirus

AAA Authentication, Authorization, and Accounting

ABO Automatic Busy Override

ACC Adjacent Control Channel

Accounting
Management

Involves the reporting of the activities of radio users on the system. The system provides
several accounting management facilities

ACCH Associated Control Channel

ACELP Algebraic Code Excited Linear Prediction

Acknowledged Data
Transfer

A service provided by the layer below which gives an acknowledgement back over the air
interface from the lower layer peer entity. This service is used by the layer 3 entities to
get a secure transmission including retransmissions.

Acknowledgement A message sent in response to another message to indicate status.

AD Active Directory

ADM See Alias Database Manager

Admin See CENTRACOM Elite Admin

Advanced Lights
Out Management
(ALOM)

ALOM functions allow for monitoring, logging, alerting and for basic control of the
system. ALOM is particularly useful for remotely managing a server in a typical "lights
out" environment. It is the next generation strategic solution, replacing the functionality
of Remote System Control (RSC) used on VSP servers and Lights Out Management
(LOM & LOMlite) used on Sun Netra servers

Advanced Link An Advanced Link (AL) is a bidirectional connection between one Mobile Station (MS)
and a Base Station (BS) with provision of acknowledged and unacknowledged services
including windowing, segmentation, extended error protection and choice among several
throughputs. The data transfer via the advanced link requires a set-up phase

AEB See Ambassador Electronics Bank

AEB slot For E1, one of 960 possible slots on the Ambassador Electronics Bank (AEB) Time
Division Multiplexing (TDM) backplane busses (32 busses x 30 AEB slots/bus). For T1,
one of 768 possible slots (32 busses X 24 slots/bus)

AEB System Timer Ambassador Electronics Bank System Timer Module. An AEB module that provides
system clocking and data bus arbitration. Each Audio Switch uses two AEB System
Timer Modules in a redundant configuration

AEI See Audio Expansion Interface

Affiliated Zone The zone to which a radio is currently registered

Affiliation The process by which a Mobile Station identifies its location and talkgroup affiliation to
the system as it moves through the coverage area
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Item Description
Affiliation Display A Motorola software application that tracks mobility characteristics of radio users by

monitoring current affiliations and deaffiliations on the system

Affiliation Group The talkgroup to which a Mobile Station is currently attached

AGC Automatic Gain Control

AI Air Interface
Additional Identity

AIE See Air Interface Encryption

AIE KVL See Air Interface Encryption Key Variable Loader

AIMI See Ambassador Interface Multiplex Interface

Air Interface
Encryption (AIE)

The Dimetra IP System supports Over the Air Standard Encryption of Mobile Stations
and Base Stations using the standard TETRA algorithms TEA1, TEA2 and TEA3

Air Interface
Encryption Key
Variable Loader
(AIE KVL)

This AIE KVL is used for transporting AIE keys (k and SCK) and for keys used in the
infrastructure (ki) used for distribution of AIE keys. It connects to the AUC, MS, ZC,
TSC and BRC and is used by the network operator

Air Traffic
Information Access
(ATIA)

An option that provides raw data on air traffic activity that can be used to drive a
customer-supplied billing package

Air Traffic Router
(ATR)

The Radio Applications Programming Interface (RAPI) is located on the ATR server that
is colocated on the same LAN as the ZC. The ATR manages all non-call processing
processes for the Zone Controller and relies on the ZC to provide aliases and security
group information. The ZC and the ATR are connected with a TCP link

AIS 1. See Alias Integrated Solution
2. See Archiving Interface Server

AKD Authentication Key Distribution

AL See Ambience Listening

ALGID Algorithm Identification

Alias An alphanumeric name used to identify for example a mobile station, a talkgroup or
a site. Aliases can be assigned to represent something more meaningful to a console
operator than the six digit ID number

Alias Database
Manager (ADM)

A software tool for managing the alias database, which is the database that stores all radio,
console, talkgroup, and multigroup aliases used in the system (part of CENTRACOM
Gold Server)

ALOM See Advanced Lights Out Management

AllStart A talkgroup setting which requires resources on all involved sites to be available before
the call can begin

Alias Integrated
Solution

The Alias Integrated Solution (AIS) provides the means for dynamically assigning a user
alias to a radio upon user logon to the radio. The dynamically assigned user alias is made
available to 3rd party via the MultiCADI API

Alphanumeric Text
Service (ATS)

A Motorola application used to send short data messages from a PC operating under
Windows to a display on a Mobile Station

AMB See Ambassador Board
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Item Description
Ambassador Board
(AMB)

A board that processes the audio coming from and going to its links. Each board supports
two independent, full duplex E1 and T1 links. Used in the Ambassador Electronics Bank
(AEB) to interface CEBs or MGEGs to the AEB

Ambassador
Electronics Bank
(AEB)

Also Embassy Switch. Dimetra master site equipment consisting of a Time Division
Multiplexing (TDM) audio switch capable of simultaneously routing audio from multiple
sources to one or more destinations. In a Dimetra system, each Zone Controller controls
the audio routing for its associated AEB

Ambassador
Interface Multiplex
Interface (AIMI)

A Central Electronics Bank (CEB) module that provides the interface between the AEB
and CEB, and provides CEB timing and data bus arbitration

Ambience listening
(AL)

The ability to listen remotely to audio in the vicinity of a Mobile Station

AMS Alert Management System

Announced Cell
Reselection

Cell reselection where Mobile Station (MS) Mobile Link Entity (MLE) informs the
Switching and Management Infrastructure (SwMI) both in the serving cell and in the new
cell that cell change is performed. There can be three types of announced cell reselection:
- type 1: the MS-MLE knows the new cell and the traffic channel allocations on the cell
before deciding to leave its serving cell;
- type 2: the MS-MLE knows the new cell before changing to it, but does not know the
channel allocation on the new cell in advance;
- type 3: the MS-MLE need not to know the new cell before changing to it. The serving
cell is only informed by the MS-MLE that it wants to change cell

Announcement Call An announcement call is a point to multipoint group call that provides the capability to
communicate with multiple talkgroups simultaneously

Announcement
group

A special group which is used to address a number of normal groups which are associated
to the announcement group

API Application Programming Interface

APN Access Point Name

Application
Launcher

Application Launcher enables you to access one or more management applications
without going through the process of logging on to each application separately

Archiving Interface
Server (AIS)

The AIS provides flexible, high-quality archiving services for audio and data associated
with various types of calls and various events associated with radio resources. Together
with a logging recorder and a replay station, AIS makes up the logging system

ARP Address Resolution Protocol

AS Alias Server

ASC Automatic Synchronization Configuration

ASIC Application Specific Integrated Circuit

ASSI Alias Short Subscriber Identity

ATCC See Auto Tune Cavity Combiner

ATG Announcement Talkgroup

ATIA See Air Traffic Information Access

ATM Asynchronous Transfer Mode
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Item Description
ATR See Air Traffic Router

ATS See Alphanumeric Text Service

AuC See Authentication Centre

Audio Expansion
Interface

An interface module that receives audio from the CEB backplane for console position
speakers and recording devices

Audio Interrupt Capability that allows users of a talkgroup to interrupt the audio of the current
transmitting talkgroup member

Authentication MS authentication in the radio system infrastructure:
A function which allows the radio system infrastructure to validate that a mobile station
is genuine before granting access to system services. Upon receiving an authentication
request, the mobile station may also perform a mutual validation of the infrastructure to
ensure it is safe to operate.
The use of authentication establishes a level of trust between the radio system's
infrastructure and subscriber mobile stations.
User authentication in the network infrastructure (optional feature):
The System Core Security Management Server functions as a user authentication server,
controlling access through dial-in terminal servers by maintaining individual user
accounts and passwords for each authorized remote user. The RSA ACE/Server product
installed on the System CSMS is used for authentication. Access to the network is denied
if users do not provide appropriate credentials

Authentication
Centre (AuC)

A Motorola software application that allows system managers to manage encryption
keys for Dimetra

Authentication Key
(K)

A secret key used to validate a mobile station's ability to operate on the radio system.
Each MS is assigned a unique authentication key at the factory or a secure facility.
The authentication key is imported or typed into the Authentication Centre along with its
associated reference (REF)

Authentication
Material

A set of session keys used to perform explicit authentication. Each MS is assigned a set
of unique authentication material based on its authentication key (K). The authentication
material is generated and sent from the Authentication Centre (AuC) to thezone
controllers of the system using the system Key Encryption Key (KEKm)

Auto Tune Cavity
Combiner (ATCC)

The ATCC receives signals from several base radios and sends a combined signal to
the site sending antenna

Automatic site
selection

The Mobile Station will choose the best site

AVC Aggregated Virtual Circuit

B-CEN Black CEN (not trusted)

Base Interface
Module (BIM)

This CEB module links conventional base station/repeaters and CEB for audio
communications-

Base Radio (BR) Dimetra remote BTS site equipment. Each base radio (BR) provides one TETRA carrier,
comprising four TETRA time slots. The BR is equipped with three receivers for diversity
reception which increases the coverage area and reception quality

Base Radio
Controller (BRC)

The Base Radio is made up from a number of replaceable units. A Base Radio Controller
is used to communicate with the Site Controller and to control the other units within
the Base Radio

Base Station Term used to identify the installation including the BTS, antenna and ancillary equipment
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Item Description
Basic Link A Basic Link (BL) bidirectional connectionless path between one or several Mobile

Stations and a Base Station, with a provision of both unacknowledged and acknowledged
services on a single message basis

Basic logging This feature collects radio system traffic and generates the collected data in a report format

BCCH Broadcast Control Channel

Bearer Service A type of telecommunications service that provides the capability for the transmission of
signals between user network interfaces

BER See Bit Error Rate

BERT Bit Error Rate Test

BIC Barring of Incoming Calls

Billing System (BS) A Billing System is a feature that collects, stores and displays subscriber accounting data

BIM See Base Interface Module

Bit Error Rate
(BER)

Bit Error Rate characterizes the quality of a digital channel for all traffic on the channel

Black Key An encryption key that is encrypted by another key

BLT Bulk Loader Tool

BNC Connector Bayonet-Neill-Concelman connector. A standardized coaxial cable connector, used for
Thin Ethernet cables, ARCnet networks and for the transmission of audio and RF signals

BNCH Broadcast Network Channel

BOC Barring of Outgoing Calls

Border Router The Border Router is a router residing between Customer Enterprise Network (CEN) and
DMZ network, on master site as well as on remote sites connected to the CEN.
The Border Router interposes a protective firewall to prevent access to the Dimetra
system from unauthorized external devices

bps Bits per second

BR See Base Radio and Border Router

BRC See Base Radio Controller

Broadcast A message to all Mobile Stations currently listening. Broadcast information can be of a
variety of types including adjacent channel information and current system access control
information. A Broadcast message needs no acknowledgment

BS See Billing System

BSCH Broadcast Synchronisation Channel

BTS Base Transceiver System. BTS is the common acronym for:

• Enhanced Base Transceiver System (EBTS)

• Mini Base Transceiver System (MBTS)

• Motorola Transceiver System (MTS)
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Item Description
BTS Site A remote segment within the Dimetra IP system responsible for call processing and

mobility services within a local geographical area. A Dimetra IP BTS site (also known
as a base site) contains equipment such as TETRA Site Controller (TSC), Base Radio
Controller (BRC), Environment Alarm System (EAS), and RF distribution equipment.
The BTS site functions as the termination point for air interface encryption services. A
static cipher key-trunked mode operation (SCK-TMO) key is stored and used by BTS
site equipment and subscriber mobile stations (MS) to encrypt/decrypt voice and data
communications. To receive future SCK-TMO key updates, BTS site equipment must
also store and utilize a unique infrastructure key (Ki) and zone key encryption key (KEKz)

Bundle A collection of Inter TETRA Connections (ITCs) which utilizes the same scenario over
the inter system interface

Busy handling When channel resources are not available, the controller generates a busy indication
over the control channel. This busy indication in form of a tone is given to the MS user
indicating it is in queue for the next available resource

Busy queue A memory storage in the central controller to hold Mobile Station information and
requests until a channel is assigned after a busy condition

Busy Queuing A method of queuing a call when resources are not available to grant the call

C-SCCH Common Secondary Control Channel

CAD Computer Aided Dispatch

CADI See Computer Aided Dispatch Interface

CAI Common Air Interface

Call Continuation The capability of passing active calls or busy queue designations across zone boundaries.
Also termed "Call Handoff" “Call Coordination” or “Call Reconnect”

Call Detail Record The Call Detail Record contains information aboutusage of Packet Data service

Call handoff The automatic assignment of an available channel when a radio user roams from one site
to another with continuous communications

Call Set-up Time Group Call:
the call set-up time is a measure of the time between the initiating PTT and the first audio
slot to be transmitted by the initiating Mobile Station.
Private Call:
the call set-up time is a measure of time between the initiating PTT and the alert
indication that the receiving unit is ringing.
Interconnect Call (MS initiated):
the call set-up time is a measure of time between the initiating PTT and the alert
indication that the PSTN Gateway has initiated the call.
Interconnect Call (PSTN initiated):
the call set-up time is a measure of time between the reception of the QSIG_SETUP from
the external network to the transmission of the QSIG_ALERT to the external network

Call Back A message sent to the radio indicating a busy condition is over and to initiate the channel
request again

Camped A Mobile Station (MS) is said to be camped on a cell when the MS is synchronized on
the cell Base Station (BS) and has decoded the Broadcast Network Channel (BNCH) of
the cell. The synchronization procedure is performed by the Media Access Control
(MAC) and the interpretation of the network information from the BNCH (Voice+Data) is
performed by a procedure in the Mobile Link Entity (MLE). It is the MLE which decides
when an MS is said to be camped on a cell
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CAS 1. Channel Associated Signalling

2. Child AntiVirus Server

CAT Coverage Acceptance Test

CATP Coverage Acceptance Test Procedure

CBR Constant Bit Rate

C&C Command & Control

CC See Crypto Card

CCC See Crypto Communications Controller

CCGW See Conventional Channel Gateway

CCH Control Channel

CCCH Common Control Channel

CCI Command & Control Interface

CCITT Consultative Committee for International Telegraph and Telephone

CCK Common Cipher Key

CCM Channel Control Module. A CENTRACOM console module that is a direct interface for
the dispatcher to make calls and to indicate received calls.

CCMS See Customer Configuration Management System

CDM See Console Database Manager

CDR See Call Detail Record

CE Crypto Engine

CEB See Central Electronics Bank

Cell A geographical area which is covered by a BTS site. Note that at the edge of the cell the
Mobile Station can begin to receive signals from adjacent cells and will use its stored
reselection criteria to determine at what point it should retune to a better signal

Cell Reselection TETRA defines five types of cell reselection for a Mobile Station (MS) involved in
a circuit mode call; these definitions are given in this list. See also Announced Cell
Reselection, Unannounced Cell Reselection, Undeclared Cell Reselection

Cell ID A relative identification number of a cell. Relative to the current serving cell

CEN See Customer Enterprise Network

Center for Internet
Security

An organization dedicated to help addressing security of internet-connected systems by
providing means to measure, monitor, and compare the security level of systems

CENTRACOM The Motorola product line of console dispatch equipment, including furniture and
programming

CENTRACOM
Elite Admin

An application for creating objects on the CENTRACOM Elite operator position desktops

CENTRACOM
Gold Elite Subnet

A subnet that consists of a Windows based Console Database Manager/Alias Database
Manager (CDM/ADM) file server(s) and a number of Windows based Operator Dispatch
workstations
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CENTRACOM
Gold Series
Platform

A platform that supports Classic Gold CRT, Classic Gold Button and LEDs, and Elite
operator positions

Central Electronics
Bank (CEB)

The CEB is the main processing bank in Dimetra trunking systems and provides an
interface between the console positions and the RF equipment and thereby the entire
Dimetra system

Central Network
Management

This term is used to describe the system control equipment to which the sites are all
connected. This is comprised of a number of items including the Zone Controller, Zone
Manager, User Consoles, and Site Link Multiplexers (Only R3.x & R4.0)

CEPT Conference European des Postes et Telecommunications. An association of the
26th European PTTs (Postes (mail), Telephone and Telegraph) that recommends
communication specifications to the International Telecommunications Union (ITU)

CES CENTRACOM Elite Server

CG 1. Charging Gateway
2. Cryptogroup
See Cryptogroup

CGC Confirmed Group Call

Channel Control
Window (CCW)

The display seen by a console operator when using a CENTRACOM Elite console
operator position. Each CCW corresponds to an object monitored by the console

Checkpoint Check Point Software Technologies, a company producing products for network security

CHS Cluster Hot Standby. Equivalent to Synchronised Standby

CIE Console Interface Electronics

Circuit Mode Data A mode that offers constant data transfer rates of 2.4-28.8 kbps

CIS See Center for Internet Security

CiscoView Device
Manager

A Web interface provided with CiscoWorks 2000 that provides real time views of
networked Enterprise LAN Switch Systems devices

CiscoWorks2000
(R5.0 & R5.1)

A network management application that includes CiscoView Device Manager and
Resource Manager Essentials (RME). CiscoWorks 2000 is used to manage the Cisco
Catalyst 6509 Ethernet LAN switch. The CiscoWorks applications reside on the Ethernet
Switch Management Server (ESMS) and work together as a LAN management solution

CK Cipher Key

CKEK Common Key Encryption Key. An encryption key used solely to encrypt traffic keys
targeted for a group of secure entities

Clear MS A mobile station that is registered on the system with ciphering off

CLIP Calling Line Identification Presentation

CLIR Calling/Connected Line Identification Restriction

Cluster A cluster is defined to be a UCS cluster consisting of one to seven zones served by the
same UCS. A system consists of one to sixteen clusters. See Multicluster System

CMG Crypto Management Group

CMS Cable Management System

CMSU Central Mass Storage Unit
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CNE Central Network Equipment. The equipment located at the Master Site or Mobile

switching Office

CNI Customer Network Interface

Codeplug The firmware that holds the unique personality for a system or device. The codeplug is
programmable to change system or unit parameters. Codeplugs are found in Mobile
Stations, CENTRACOM equipment, as well as in some repeaters and 6809 controllers

COAM Customer-Owned and Maintained

COIM See Console Operator Interface Module

Collected Data Collected Data is statistical data, which is used for statistical purposes such as number
of calls and types of calls

Colocated Pertaining to a configuration in which equipment resides in the same physical site

Computer Aided
Dispatch Interface
(CADI)

The CADI enables the user to do remote network management through an Application
Programming Interface (API). Possible functions may be radio check, radio inhibit and
Dynamic Group Number Allocation (DGNA)

Configuration
Management

Refers to the capabilities which allow the user to configure operational parameters of
physical and logical devices used within the system. There are two categories, Subscriber
Management performed through the User Configuration System and Infrastructure
Management performed through the Zone Manager

Console The console is the equipment used by dispatchers to interact with the Dimetra system and
thus to communicate with system users. The console is the equipment used by dispatchers
to interact with the Dimetra system and thus to communicate with system users

Console
Administration
Terminal

A terminal that is connected directly to the Zone Controller to perform Terminal
administrative functions for the system

Console Database
Manager (CDM)

A software tool that permits changes to the console database, which stores all features
programmed for the console

Console Interface also known as Elite API. The Dimetra Console Interface runs under Windows. May
be used by 3rd party developers

Console Operator
Interface Module
(COIM)

An interface board in the Central Electronics Bank that has the connections for the
console operator positions. The module controls audio flow and data signals to and
from the console position

Console Operator
Remote Interface
(CORI)

An interface board used in a Central Electronics Bank to provide connections between
the Console Operator Interface Module and telecom lines to a remote operator position

Console Patch A unique call type. Some types of console patches can be performed by a console
operator to either expand the participant size for the call or to provide interoperation
ability between different agencies that do not communicate together. For example, two
multigroups would be created if talkgroups 1, 2, 3, and 4 were patched together and if
talkgroups 1,2, and 3 are home to zone 1 and talkgroup 4 is home to zone 2

Console Phone
Patch

A manual patch of a phone line module to another CCM/CCW. A CCM/CCW may be
associated with a trunked talkgroup or a conventional channel at the time of the patch

Console Only
Talkgroup Call

A type of call used exclusively for console operators, and does not involve any Mobile
Stations. All console operator members can be located within the same zone or in
different zones
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Constant delay
service

A network service (NS) where the transit delay of the NSDUs between the network
connection endpoints remains constant for the duration of the connection

Control channel The first time slot on the TETRA carrier frequency is always used as the main Control
Channel. The rest of the slots on the main carrier are used as Traffic Channels

Control Site A Control Site provides remote dispatch capabilities and remote access to network
management functions

Control Message Term used to describe messages of a controlling nature sent between the BTS and the
Mobile Station (MS)

Control Router
(R5.0)

The Control Routers allow communication between the Zone Controller (ZC) and the
Transitional LANs within the Ethernet/LAN switch

Controlling Zone The zone that coordinates the resources for a call. For group calls, the designated Home
Zone of the group is always the Controlling Zone for the call, regardless of where group
members are affiliated. For individual calls, the controlling zone is the zone from which
the voice service is being requested

Controlling Zone
Controller (CZC)

The Zone Controller responsible for controlling a call throughout its duration

Conventional
Channel Gateway
(CCGW)

The CCGW provides analog call detection, vocoding and devocoding of audio, station
keying and dekeying through Tone Remote Control (TRC) or E&M relay, and tone LOBL
(Line Operated Busy Light) detection (for parallel console interoperation). The CCGW
may or may not be integrated with the site router. The alternative is to have the CCGW
locally on the LAN. This option is available to console sites with a large number of
conventional resources

Conventional to
Conventional Patch

A console patch that patches multiple conventional resources within the same zone
together

Cooperative WAN
Routing

CWR interfaces the master site in one zone to Radio Frequency (RF) sites, dispatch sites,
system Operations Support System (OSS), and other zones. In multizone systems, core
and exit routers are configured in pairs to provide path redundancy for audio and control
packets. With CWR, the routers work to control an external relay panel to switch a group
of 12 non-redundant T1/E1 links between the two routers

CORBA Common Object Request Broker Architecture

Core Router The Core Routers allow communication between the BTS and other subnets

CORI See Console Operator Remote Interface

CoU Class of Usage

cPCI compact Peripheral Component Interconnect

CPS See Customer Programming Software

CRAM Console Remote API Manager Service

CRC Cyclic Redundancy Check. An error checking technique

CRHN Control Room Head Number

Critical site See critical site assignment
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Critical site
assignment

Critical Site Assignment is a Motorola service that supplements the group call service.
For each talkgroup, the Network Manager can create a list of ‘Critical Sites'. These are
sites that must be included in a group call for it to be set up. Thus, even when Fast Start
is in operation, the call will not be set up until channels are available at all the critical
sites for the talkgroup

Crypto Card A PCI-based encryption module installed in the AuC server. The AuC Crypto Card
provides encryption services to the AuC such as key generation and database encryption.
A master key is stored in the AuC Crypto Card and is utilized to encrypt and decrypt
data stored in the AuC database

Crypto
Communications
Controller

The Crypto Communications Controller establishes the communication between the Host
CE. Cuttently implementation uses a Power QUICC II for the CCC

Cryptogroup (CG) A Cryptogroup is a set of keys which are used with the same communication groups at
different times.The KMF supports up to three keys within a Cryptogroup.At any one
time, one of these keys is active for communications, and the other two are there to
maintain communications when changing over to different active keys

CryptR Generic name for the hardware device performing the function of either PDEG, SDEG
or KMF Cryptr

CSMA/CD Carrier Sense Multiple Access/Collision Detect. Technique used in Ethernet to manage
access to a shared transmission medium

CSMS Core Security Management Server

CSV Comma Separated Values

Current
Alerts/Alarms

A Fault Management feature which provides the user with a mechanism to view the
current alerts and alarms in a zone

Current serving BS The Base Station (BS) on one of whose channels the Mobile Station (MS) is currently
operating

Customer
Configuration
Management
System (CCMS)

Customer Configuration Management System is tools and processes to manage the
configuration of a customer system. The system controls data like serial numbers, s/w
and h/w versions, parameter settings, license numbers and so on, in a database to provide
detailed information about the complex structure of systems

Customer
Enterprise Network
(CEN)

The Customer Enterprise Network is a customer network that is connected to the Dimetra
RNI

Customer
Programming
Software (CPS)

The software application used for programming Mobile Stations. Formerly called RSS

Customized IP Plan Provides the possibility to configure the Zone Octet and Cluster Octet in the IP Plan
independently from the Zone ID and Cluster ID

Customized IP Plan
CD

CD-ROM that contains the complete IP Plan and Shared TLAN (optionally)
configurations

CVC Constituent Virtual Circuit

CVO Clear Voice Override

CWR See Cooperative WAN Routing

CZC See Controlling Zone Controller
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DAOS Data Add-On Services

DAQ Delivered Audio Quality

DAT Digital Audio Tape

Data Gateway Data gateway. See SDR and PDG

Data Link
Connection
Identifier (DLCI)

A DLCI is a communications channel identifier used in frame relay communications to
identify a PVC (permanent virtual circuit) over the link between the BTS and the Central
Network Equipment.

Data Prioritization See Packet Data Prioritization

Database Server A UNIX based computer connected to the Ethernet network, which supports the Zone
Manager and contains the database for the Dimetra system.

DBP Downstream Billing Processor

DC 1. Dispatch Console (D5.5SER and backward)
2. Domain Controller (D6.0SER and forward)

DCE Data Communication Equipment

DCK Derived Cipher Key

DDI Direct Dial In. Also known as DID (Direct Inbound Dialling).
Data Distribution Interface

DDP See Disabled Dialling Pattern

Deaffiliation The process in which the Mobile Station signals to the system, that it is no longer
monitoring the system, because it is power down or it is changing mode to another system
which is not part of the Dimetra system.

Decryption The process of unscrambling an encrypted message or information to regain the original
information or message.

Delayed
Acknowledgment

A message indicating status transmitted after some delay.

DEM See Digital Elevation Model

DeMilitarized Zone
(DMZ)

The DeMilitarized Zone is a network interconnecting other networks, namely the
Dimetra RNI and the CEN. For routing of traffic between these networks coordinated IP
spaces are required.

DGNA See Dynamic Group Number Assignment

Diagnostics A feature that allows the user to disable a failing device, enable repaired devices, and/or
set certain device operational states.

DIB Data Interface Box

DID Direct Inbound Dialling. Also known as DDI (Direct Dial In)

Digital Access Cross
Connect System
(DACS)

A data concentrator and organizer for Tl / El based systems.

Digital Elevation
Model (DEM)

Computer readable database with the elevation values (meters above sea level) of a
certain area.
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Digital Power Meter
(DPM)

Device that measures the effect of the site antenna.

Digital Versatile
Disc (DVD)

An optical disc storage media format that can be used for data storage, including movies
with high video and sound quality.

Dimetra Console See Elite Console

Dimetra™ DIgitalMotorola Enhanced Trunked RAdio. The Motorola Dimetra system family is
a sophisticated range of digital radio equipment that delivers the full benefits of the
TETRA standard. It is designed to meet the needs of the users of both Private Mobile
Radio networks (PMR) and Public Access Mobile Radio systems (PAMR). The Dimetra
product line includes base stations, switches, operations management control, portables,
mobiles, and consoles, all of which are easily reprogrammed as the system is enhanced.

DIN Deutsche Industrie Normen (German Industrial Standards).

Direct Mode
Operation (DMO)

Direct communications between 2 or more mobile stations without using any
infrastructure.

Direct set-up
signalling

A signalling procedure where immediate communication can take place between the
calling and the called users without the alerting process and without an explicit response
from the called user that he has answered.

Diagnostic Zone ID Number of zone with the lowest zone octet within the MSO (Mobile Switching Office).

DIPS Dimetra IP Scalable

Disabled Dialling
Pattern (DDP)

An individual telephone within an ECN.

Disk Controller This Zone Controller module handles the flow of data to and from the hard drives and the
quarter inch tape drive.

Dispatch Console Dimetra master site equipment consisting of an advanced dispatch system, which provides
fixed dispatch capabilities to both the Dimetra trunked system as well as conventional
PMR radio systems including the ability to connect calls between these systems. The
dispatcher may also connect calls to a telephone system.

Dispatcher A person logged on to the console terminal or RCM terminal as a Dispatcher who
monitors and transmits commands to radio traffic.

DL Discreet Listening: A feature that allows real-time listing to private calls and telephone
interconnect calls made by a radio user. The feature gives no indication to the calling
parties that the call is being listened to. The feature keeps an extensive log of call
activities of the monitored radios as well as the actions taken by Discreet Listening user.
It is possible to connect a third party recorder to the feature for recording purposes.

DLCI See Data Link Connection Identifier

DM See Direct Mode Operation

DM-SCK Direct Mode Static Cipher Key

DMO See Direct Mode Operation

DMZ See DeMilitarized Zone

DNS Domain Name System

Downlink The radio frequency communications path from the BTS to the Mobile Station. Also
referred to as the BTS transmit path.
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DPM See Digital Power Meter

Driver card A Zone Controller platform card for conversion of TTL protocol to RS-232 for the Line
card.

DS0 The basic unit in the DSn (T1 and up) and E1 transmission applications. A DS0 carries a
64 Kbps data stream. A T1 line has 24 DS0s and an E1 line has 32 DS0s.

DSP Digital Signal Processing

DSU Data Service Unit. A device used in digital transmission for connecting data terminal
equipment (DTE).

DSC Digital Service Cross Connect. Cross connection point for DS1 signals.

DTE 1. Data Terminal Equipment
2. Data Traffic Estimator

DTM Digital Terrain Model

DTMF Dual Tone Multi Frequency

Dual or external
provisioned Radio
User

A Radio User is considered external or dual provisioned at the UCS level when its ISSI
value falls into the Individual Subscriber Map range (of the last submitted Home Zone
Map) of the external zone which does not belong to a home cluster.

Dual or external
provisioned
Talkgroup
(Multigroup)

A Talkgroup or Multigroup is considered external or dual provisioned at the UCS level
when the ID of a Talkgroup or Multigroup falls into a Group Map range (of the last
submitted Home Zone Map) of the external zone which does not belong to a home cluster.

Dual Watch Monitoring of both the trunked control channel and selected direct mode channel by a
radio operating in direct mode.

Duplex
Transmission

Duplex transmission means that both parties in the call can send and receive traffic at the
same time. There is generally no need for a PTT to request transmit permission.
Note: Duplex can be achieved in a TDMA system (such as TETRA) without the need for
the Mobile Station (MS) to actually transmit and receive at the same time; this is known
as time division duplex. Also note that although the transmission in the air is in duplex
mode the MS is simplex, thus the control of the loudspeaker and the microphone may
be performed using PTT in a semiduplex fashion as this may be the only accessory
which is available.

DVD See Digital Versatile Disc

Dynamic Group
Number Assignment
(DGNA)

Dynamic Group Number Assignment allows the user to create groups before or during
group calls.

Dynamic regroup A Radio Dispatch Management option allowing a dispatcher to move radios from one
talkgroup into another. The radios receive reprogramming of certain parameters using
signalling over the control channel.

Dynamic site
assignment

This feature allows the Dimetra system to assign voice channels only at the sites where
radio users are registered to complete calls.

E&M Ear and mouth
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E1 Digital carrier facility used for transmission of data through the telephone hierarchy. E1

consist of 32 channels, and has a total speed of 2.048Mbit/s. E1 links are used in most
countries other than the United States and Japan. T1 links are mostly used in the US
and Japan. Both T1 and E1 are composed of DS0s, the basic 64 Kbps path that makes
up these links.

E2E End-to-End

E2EE End-to-End Encryption

E2EE KVL End-to-End Encryption Key Variable Loader

EAS See Environmental Alarm System

EBTS See Enhanced Base Transceiver System

EBTS Service
Software

The TETRA EBTS Service Software package used to configure and communicate with
the Dimetra BTSs.

EC 1. Electronic Codebook
2. See Echo Canceller

Echo Canceller (EC) The Echo Canceller provides echo cancelling of the echo returned from the telephone
system.

ECK Encryption Cipher Key

ECN See Exclusion Class Number

ECTA Extended Console Talkgroup Assignment

ECU Environmental Conditioning Unit

EEPROM Electrically Erasable Programmable Read Only Memory

EIA Electronic Industries Association

Elite Console A software based radio dispatch console working under Microsoft Windows® operating
system.

Elite Operator
Position

Motorola's GUI-based operator position.

Embassy Switch Ambassador Electronics Bank (AEB). A Time Division Multiplexing (TDM) audio
switch capable of simultaneously routing audio from multiple sources to one or more
destinations. In a Dimetra system, each Zone Controller controls the audio routing for
its associated AEB.

EMC 1) Encryption Module Cartridge.
2) Electromagnetic Compatibility.

Emergency Call The highest priority service of talkgroup call. When the emergency button of a subscriber
unit is pressed and a PTT initiated, an Emergency Call is granted depending on the
emergency setup method selected; that is, Top of Queue or Ruthless Pre-emption.

Encrypted MS A mobile station that is registered on the system to operate with ciphering.

Encryption The manipulation of a packet's data in order to prevent anyone but the intended recipient
from reading that data. There are many types of data encryption, and they are the basis
of network security.

Encryption
Algorithm

A method of encrypting and decrypting information.

- A-15



TETRA Radio Product Information Manual

Item Description
Encryption
Device/Crypto Card

A PCI-based encryption module installed in the PrC server. The PrC Encryption Device
(a Crypto Card) provides encryption services to the PrC such as key generation and
database encryption.
A master key is stored in the PrC Encryption Device and is utilized to encrypt and decrypt
data stored in the PrC database.

Encryption Key A set of 1s and 0s that is used to determine the transformation of plain text to cipher text
in a cryptographic algorithm and vice versa.

Encryption
Management

The Network Management system is able to switch the use of encryption at a site on or
off. This is a site wide function for all control and traffic channels, except where users
may be individually provisioned to operate without encryption. These units will always
operate with encryption switched off.
The Network Management system is able to remotely download new SCK to all BTSs in
the network using the remote Software Download facility.

End-to-End
Encryption (E2EE)

The Dimetra IP System supports End-to-End Encryption using the AES algorithm.

End-to-End
encryption Key
Variable Loader
(E2EE KVL)

The E2EE KVL is used for End-to-End encryption. It provisions the KEK (Key
Encryption Key used for OTAK) and some other OTAK related parameters. The E2EE
KVL can also be used for store-and-forward between the KMF and the MS. The E2EE
KVL connects to the KMF and MS.

Enhanced Base
Transceiver System

A site connected to a Dimetra master site via a site link. A Dimetra remote EBTS site
consists of a base radio (BR), and a site controller.
Contains up to 8 base radios, TETRA Site Controller, Environmental Alarm System,
RF Distribution System, antennas, power supply and the telephone company supplied
X.21 or E1 line termination equipment.

Environmental
AlarmSystem (EAS)

EAS. Remote Base Transceiver System (BTS) site component that provides monitoring
of internal and external site alarms and controlling functions such as redundancy control
and so on

EOL End Of Life

EPROM Erasable Programmable Read Only Memory. A non-volatile, read only chip with a quartz
window on the top. The chip requires erasing with UV light before reprogramming.

ESD Electrostatic Discharge

ESMS (R5.0 & R5.1) See Ethernet Switch Management Server (ESMS).

ESP Enhanced Services Platform

ETG Enhanced Telephone Gateway.

Ethernet A method used for connecting computer systems together using local area network
(LAN) technology.

Ethernet Hub A device that acts as a multiport repeater in allowing multiple devices to be connected
together into a single Ethernet LAN. All the devices connected to the hub share the
available bandwidth as all packets are repeated at all ports.

Ethernet Switch A device that acts as a multiport bridge allowing multiple devices to be connected
together into a single Ethernet LAN. Each of the devices connected to the switch have the
full bandwidth available as a switch learns which devices are connected to which ports.
Router: A device that routes IP packets between IP subnets.
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Ethernet Switch
Management Server
(ESMS) (R5.0 &
R5.1)

The Compact PCI server where the CiscoWorks2000 suite of applications resides.

Ethernet Virtual
Connection (EVC)

An association of two or more UNIs that limits the exchange of Service Frames to UNIs.

ETS ETSI Technical Specification. A technical specification produced by ETSI to define a
communications standard.

ETSI See European Telecommunications Standards Institute

European
Telecommunications
Standards Institute
(ETSI)

The European standards organization responsible for the TETRA standard.

Exclusion Class
Number (ECN)

A set of telephone numbers or Disabled Dialling Patterns (DDPs) defined in the
Telephone Interconnect database that radios cannot access.

Exit Router The Exit Routers allow communication between different SMSO (LAN SHARED MSO).

Explicit
Authentication

This term is used to describe a successful challenge-response-result authentication
procedure based on knowledge of the secret key K.

External calls A call where only one of the parties (either the source or the destination) is in a TETRA
network. The other party is in a non-TETRA network.

FACCH Fast Associated Control Channel

FAS Frame Alignment Signal

Fast Start A feature that allows a talkgroup call to start as long as resources programmed as critical
are available. Non-critical resources are added to a call in progress as they become
available.

FAT Factory Acceptance Test.

Fault Management A feature that allows the user to monitor operation status, display fault information,
perform diagnostics on the system, and provide notification of managed object
malfunctions.

Fault Tolerant (FT) A redundant equipment design that withstands a single point of failure without disruption
of call processing or isolation of the failure with only partial loss of call capabilities.

FIFO See First in, first out

FIP Feature Implementation Proposal

FIPS Federal Information Processing Standards

FIPS-140-1 This Federal standard assures that cryptographic modules are effectively designed to
meet specific security objectives.

Firewall Device that protects the Dimetra System against intrusion and other attacks from outside
Dimetra.

First in, first out
(FIFO)

In a busy trunked system, radio service requests are handled in the order received.

Fixed Network
Equipment (FNE)

All the system components excluding the mobile equipment that is the CNE and all
the remote site equipment.
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Fleetcall See Announcement group

Fleetmap A document listing configuration information for all users in the system.

FLM Formatted Logical Message

FNE See Fixed Network Equipment

FRAD Frame Relay Access Device.

Frame TETRA term used to describe a period of time on a channel. A frame is further divided
into timeslots, and a number of frames may be grouped into a multiframe.

Frame Relay A form of packet switching that uses smaller packets and requires less error checking than
traditional forms of packet switching. Communications protocol used for multiplexing
and routing data over the site link.

FRE Field Replaceable Entity

Frequency Reuse
Planning

A complex method of maximizing coverage with the same set of RF channels. With
proper planning, a given set of RF frequencies can be reused a number of times
throughout a very large service area.

FRU Field Replaceable Unit

FSSN Fleet Specific Subscriber Number

FSU Fault Sense Unit

FT See Fault Tolerant

FTP File Transfer Protocol

FullVision ® (FV) Subsystem of the Dimetra network manager. This uses Hewlett-Packard OpenView
Network Node Manager to provide a industry standards-based fault management
platform.

FullVision ®

Integrated Network
Manager (INM)

A Dimetra IP network management application used for reporting system fault
conditions. Using the SNMP protocol, the FullVision® INM application displays alarms
reported by all devices.

FV See FullVision ®

FVS FullVision® Server

FW See Firewall

G-HLR See Group Home Location Register

GAS General Application Server

Gateway Router The Gateway Router allows communication between all VLANs and the Transitional
LANs within the Ethernet/LAN switch.

GBN See Ground Based Network

GCK Group Cipher Key

GCKN Group Cipher Key Number

GCTC Group Call to Control Room
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General Purpose
Input/Output
Module (GPIOM)

The purpose of the GPIOM is to interface audio and auxiliary devices (for example,
microphones, speakers, and recorders) to the voice card located in the dispatch console.
The GPIOM can support 16 audio input paths and 16 audio output paths simultaneously
and independently, depending on which devices are connected to the GPIOM

GGSN Gateway GPRS Support Node. This is the only node, that Dimetra IP implements and
that allows mobile users to access the customer network or specified private IP networks.

GHLR Group Home Location Register

Global Positioning
System (GPS)

A global positioning system which uses satellites to provide a continuous time
and positioning system. The EBTS and NTS uses this system to maintain system
synchronization.

GMS Group Message Server

GOS See Grade Of Service

GPIOM See General Purpose Input/Output Module

GPRS General Packet Radio Service

GPRS Tunneling
Protocol (GTP)

The GPRS Tunneling Protocol is used to establish a Packet Data session through the
Dimetra infrastructure.

GPS See Global Positioning System

Grade Of Service
(GOS)

A specification which determines how often a radio or console user will receive a busy.
This is typically rated as a percentage of the total calls being processed by the system.

Graphical User
Interface (GUI)

An icon-based user interface.

Ground Based
Network (GBN)

The entire E1 based network that make up the site links and inter MSO links.

Group Home
Location Register
(G-HLR)

The HLR that stores information for talkgroups that are home to that zone.

Group Home Zone The controlling zone for calls originated by a zone's talkgroup members, regardless of
where they are located in the system at the time they originate the call.

Group-Based
Service

Talkgroup voice-based services, includes Talkgroup Calls, Multigroup Calls, Emergency
Calls, and Group Regrouping.

GSKO Group Session Key for OTAR

GSSI Group Short Subscriber Identity. TETRA term, in Dimetra called Group ID or Talkgroup
ID.

GTP See GPRS Tunneling Protocol

GTSI Group TETRA Subscriber Identity

GUI See Graphical User Interface

GW Gateway
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Half duplex
Transmission

Half duplex transmission means that only one Mobile Station (MS) can send traffic in a
call at any time. All other MSs in the call will receive traffic. In the case of a voice call,
for example, traffic transmission is generally initiated by an MS user pressing the PTT at
which time the MS speaker is muted. The MS user releases the PTT at the end of the
traffic transmission in order to hear the response from another MS in the call.

HDD Hard Disc Drive

HDLC High level Data Link Control

HLA Home Location Area

HLR See Home Location Register

Home Location
Register (HLR)

The entity that is used to receive (from the UCS) a master copy of individual and
talkgroup Mobile Station information for call processing. It will also contain mobility
information for individuals and talkgroup on a per zone level.

Home network A network where a Mobile Station (MS) has a direct subscription. This means that an MS
identity has been allocated in advance of any network access.

Home Zone A designation made for each talkgroup and individual in the system that helps determine
what Zone Controller will coordinate the call process.

Host A computer which provides services to other computers, such as database access.

Hot pull Modules or boards that can be pulled out and replaced without powering down the
equipment that contains them.

HPOV Hewlett-Packard OpenView

HSRP High Speed Redundancy Protocol

HSSI High Speed Serial Interface

HZM Home Zone Map

I&DC Initialization & Default Configuration

I-HLR Individual subscriber unit HLR

I/F Router The Interface Routers provide access to the Wide Area Network (WAN) links.

IA See Information Assurance

ICCS Integrated Command and Control System

ICMP Internet Control Message Protocol.

ID Identification

Identity (Group or
Individual)

A number which uniquely identifies an individual Mobile Station or group of mobile
stations on a system.

IDSS See Intrusion Detection System Sensor

IDSS Manager Intrusion Detection System Sensor Manager

IEC International Electro-technical Committee

IEEE Institute of Electrical and Electronic Engineers

IFM Interzone Fault Management

iGAS See Improved Generic Application Server
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IHLR Individual Home Location Registration

ILO See Integrated Lights Out

ILOM See Integrated Lights Out Manager

Immediate
Acknowledgment

A message indicating status transmitted without delay.

Implicit
Authentication

An authentication procedure where the mobile station/infrastructure are assumed to
be implicitly authenticated based on knowledge of the static cipher key-trunked mode
operation (SCK-TMO) key.

Improved Generic
Application Server
(iGAS)

Improved Generic Application Server (iGAS) is a management system that allows the
user to easily administer different server containers run on one dedicated server hardware.

Inbound Event Request made by a radio user and sent to the RCM.

Individual Call Private Call or telephone interconnect call.

Individual Site
Access

This command allows individual radio user access for Private Call and Interconnect
options on specific sites, as configured by the Dimetra Network Manager.

Individual- Based
Service

Individual voice-based services which include Private Calls, Landline-to-Radio
Interconnect Calls and Radio-to-Landline Interconnect Calls.

InfoVista A customisable performance management application for the transport system. It reports
and graphs a wide variety of data from multiple devices, such as routers, Ethernet
LAN switches, and the WAN switches. InfoVista resides on the Transport Network
Performance Server (TNPS).

Information
Assurance (IA)

Information Assurance (IA) aims at protecting and defending information and
information systems by ensuring confidentiality, integrity, authentication, availability,
and non-repudiation. In Dimetra there are numerous improvements that have
been implemented on the application/configuration level, focusing on fixing the
information-related risks inherited from previous releases, or on ensuring the
IA-compliance of the new components.

Infrastructure The equipment and facilities that make up the Dimetra IP radio system. These include
zone, BTS site, and network management devices.

Inhibit A Dimetra RCM feature cancelling transmit and receive functions of a radio. The target
radio must be on and within system range in order for this feature to function.

Initial cell selection In TETRA, the act of choosing a first serving cell to register in. The initial cell selection
is performed by procedures located in MLE and in the MAC. When the cell selection
is made and possible registration is performed, the Mobile Station (MS) is said to be
attached to the cell.

INM Integrated Network Management

Integrated Lights
Out (ILO)

An autonomous management processor that resides on the system board of a host server.

Integrated Lights
Out Manager
(ILOM)

Integrated Lights Out Manager (ILOM) is a system management tool that enables you to
remotely manage and monitor the server. ILOM provides a web interface, which enables
you to monitor and control the server over the network. The system that controls the
features in ILOM enables you to monitor the health of your system and to detect errors.

Interconnect This option provides independent telephone call capability for mobiles and portables.
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Internal calls A call where both the source (the calling party) and the destination (the called party) both

lie in a TETRA network domain.

Internet Protocol
(IP)

A protocol used for carrying packets of data primarily in Ethernet based systems.

Internet Protocol
Packet Delay
Variation (IPDV)

The IPDV of a pair of packets within a stream of packets is defined for a selected pair of
packets in the stream going from measurement point MP1 to measurement point MP2.

Interrupt Mode A mode of operation for multigroup calls that can be programmed so that the system
immediately terminates all currently active talkgroup calls of all talkgroups within the
multigroup.

Inter-TETRA call A call where source and destination are in different TETRA networks.

InterVening
Network (IVN)

IVN is the network which is used to interconnect two TETRA SwMIs at the ISI. The
network may be of the following types:
- dedicated transmission system for example PCM;
- permanent circuit switched for example PSTN and ISDN;
- on-demand circuit switched for example PSTN and ISDN.
The IVN is also used to connect remote service terminal to Zone LAN switch.

Interzone (IZ) General term that refers to call processing that involves more than one zone in the system.

Interzone Audio
Card (IZAC) (R4.0)

plugs into an Ambassador Electronics Bank (AEB). The card has modified AMB
firmware to support interzone audio. The hardware is the same as an AMB board that
interfaces Central Electronics Banks (CEBs) or sites to the AEB.

Interzone Audio Slot
(IZAS) (R4.0)

64 kbps channel on OmniLink Ambassador card that carries audio DS0 level between
two Ambassador Electronics Banks (AEBs) in different zones.

Interzone Trunking A trunking state between two zones in which the Ambassador Electronics Bank (AEB)
and Zone Controller can communicate, and talkgroup-to-controlling zone mapping tables
exist in both zones.

Intra-TETRA call A call where both source and destination are in the same TETRA network subdomain.

Intrusion Detection
System Sensor
(IDSS)

The IDSS contacts the Authentication Server for user authentication when a user attempts
to establish a connection to the IDSS via for example telnet. Access via the IDSS's
console port will also initiate the authentication process.

Intrusion Detection
System Sensor
Manager (IDSS
Manager)

The IDSS Manager is used for configuration of the IDSS located at the Network Interface
Barrier (NIB). Furthermore the IDSS Manager provides event notification and local
logging when the IDSS reports about potential attacks or abnormal behavior.

IOP Interoperability

IP See Internet Protocol

IP in IP IP in IP is a way to alter the normal routing of an IP packetby encapsulating it within
another IP header.

IP Packet Loss Ratio
(IPLR)

The ratio of total lost IP packet outcomes to total transmitted IP packets in a population
of interest

IP Packet Transfer
Delay (IPTD)

Time necessary for the packet to reach its destination

IPDV See Internet Protocol Packet Delay Variation
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IPLR See IP Packet Loss Ratio

IPTD See IP Packet Transfer Delay

IPsec See IP Security

IP Security (IPsec) IPsec provides interoperable, high quality and cryptographically based security services
for traffic at the IP layer, such as authenticity, integrity, confidentiality and access control
to each IP packet. An abbreviation for IP Security, it is a set of protocols developed by
the Internet Engineering Task Force (IETF) to support secure exchange of packets at the
IP layer. IPsec has been deployed widely to implement Virtual Private Networks (VPNs).

ISA Industry Standard Architecture

ISDN Integrated Services Digital Network

ISI Inter System Interface

ISSI Individual Short Subscriber Identity. TETRA term, in Dimetra called Individual ID, a
subset of ITSI.

ITC Inter TETRA Connection.

ITSI Individual TETRA Subscriber Identity, consists of ISSI plus Country and Network codes

ITU International Telecommunications Union.

ITU Conference Conference Europene des Postes et Telecommunications. An association of the 26
European PTTs that recommends communication specifications to the International
Telecommunications Union (ITU).

ITU-T International Telecommunications Union - Telecommunications Sector.

IV&D Integrated Voice and Data

IVN InterVening Network

IZ See Interzone

IZAC 1. See Interzone Audio Card
2. Interzone Audio Channel

IZAS (R4.0) See Interzone Audio Slot

IZCP Interzone Control Path

IZNM Interzone Network Manager

K See Authentication Key

K-REF A pair of parameters that identify a mobile station (MS) to the Authentication Centre
(AuC). A K-REF pair is needed by the AuC to create authentication material (KS and
KS') for a MS.

KAG Key Association Group

Kbps Kilobits (1024 bits) per second.

KEK See Key Encryption Key

Key Encryption Key
(KEK)

The KEK is also known as a shadow key. An encryption key used solely to encrypt
traffic keys.
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Key Management
Facility (KMF)

The KMF manages, distributes, and tracks the various types of key material used in the
MS for the end-to-end encryption feature. The KMF distributes keys to the MS using the
short data service as a transport.

Key Variable Also known as an encryption key. A set of 1s and 0s that is used to encrypt and decrypt
information.

Key Variable
Loader (KVL)

A portable device used to load encryption keys to a secure entity.

Ki Authentication (Infrastructure) Key. A secret key used to encrypt and decrypt system
and zone key encryption keys (KEKm and KEKz) transported over the infrastructure of
the radio network system. Each zone controller, TETRA site controller, and base radio
controller in the system is assigned a unique infrastructure key. An infrastructure key is
generated and sent from the Authentication Centre (AuC) to the system entities using
the Key Variable Loader (KVL) device.

KID Key Identification

KMF See Key Management Facility

KMM Key Management Message

KMT Key Message Transport protocol. Protocol used to transfer keys between the AuC and
ZC, TSC, and BRC

KS, KS' Session Authentication Keys. See Authentication Material.

KSG Key Stream Generator

KSS Key Stream Segments

KVL See Key Variable Loader

KVM Keyboard Video Mouse

LA Location Area

LAN Local Area Network

Land Use Land
Cover (LULC)

Also known as "clutter data". Computer readable data base with information about the
surface of the earth, for example wood, urban areas.

LAPD Link Access Procedure for D channel. A data transmission procedure used in ISDN
systems on the D channel.

LC Log Collector

LDAP Lightweight Directory Access Protocol

LED Light Emitting Diode

LGC Local Group Call

License Key A unique set of numbers used to enable the Zone Manager/Radio Dispatch Management
core software and purchasable options.

LMI Link Management Interface

Local Site Trunking
(LST)

When a system fails or many of the sites lose connection to the CNE, the sites are
designed to go into a fall back situation known as Local Site Trunking (LST). When the
sites are forced to go into LST, the radios (users) are randomly distributed across all the
sites and communication between radios is dependant on at which site they are registered.
Only radios registered at a particular site can communicate to each other.
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Location Area (LA) The area within radio coverage of a base station or group of base stations within which a

Mobile Station (MS) is allowed to operate.

Logging Operator
Multiplex Interface
(LOMI)

A Central Electronics Bank (CEB) module responsible for demultiplexing audio routed
to a recording device.

Logging Recorder
Interface (LORI)

This Central Electronics Bank (CEB) module interfaces with a recording device to
provide audio from the LOMI through the AEI.

LOMI See Logging Operator Multiplex Interface

LORI See Logging Recorder Interface

LLR Local Logging Recorder

LS LAN Shared

LS-MSO A LAN Shared MSO (LS-MSO) is a collection of one and up to three zone cores,
which are physically colocated and share one LAN switch. All zones in a LS-MSO are
connected to a single TLAN pair.

LST See Local Site Trunking

LULC See Land Use Land Cover

MAC See Media Access Control

MACE Motorola Advanced Crypto Engine

Main Control
Channel (MCCH)

The main control channel at a site. The channel is used by Mobile Stations to register on
the system and to request and setup speech calls with other Mobile Stations.

Managed Resource
(MR)

Any Network Element managed by the Network Management System.

Management
Information Base
(MIB)

A management information base (MIB) stems from the OSI/ISO Network management
model and is a type of database used to manage the devices in a communications network.
It comprises a collection of objects in a (virtual) database used to manage entities (such
as routers and switches) in a network.

Manager of
Managers (MoM)

A high-level network management system (NMS) that gathers and correlates alarms and
alerts from multiple element management systems (EMSs)

Master Key An encryption key stored in the PrC Encryption Device used to encrypt/decrypt data
stored in the PrC database. The master key is loaded into the PrC Crypto Card using a
Key Variable Loader (KVL) at the request of the PrC.
The Master Key is also used in the AUC encryption device.

Master Site A physical location in a Dimetra system containing one or more sets of zone control
equipment, including a Network Manager, Zone Controller, Ambassador Electronics
Bank (AEB), Dispatch Console, Transcoder, Telephone Interconnect Gateway, and Site
Link Multiplexer.

Mbps Megabits (1,000,000 bits) per second.

MBTS See Mini Base Transceiver System

MCC See Mobile Country Code

MCC 7500 A software based radio dispatch console working under Microsoft Windows® operating
system
RoHS and WEEE compliant.
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MCCH See Main Control Channel

MDEG Mobile Data Encryption Gateway

MDG IPL Mobile Data Gateway Initial Program Load

MDM See Preside Multiservice Data Manager

MDMWeb A Web interface provided with Preside MDM that allows you to perform fault
management tasks from the web browser.

Media Access
Control (MAC)

An address that is hardware coded into every Ethernet controller and is unique and cannot
be changed. It is also the lower part of the second layer of the OSI Reference Model.

MER See Message Error Rate

Message Error Rate
(MER)

Similar to Bit Error Rate (BER), but related to whole messages instead of single bits.

Message number The number of a selectable message corresponding to a predefined text for radio to
dispatcher communications.

Message Trunking A feature that allows radios in the same talkgroup call to continue utilizing a hang time to
allow responding users to respond on the same channel assignment.

MG Multigroup

MGCK Modified Group Cipher key

MGEG See Motorola Gold Elite Gateway

MIB See Management Information Base

MiBAS Motorola Integrated Billing and Administration System

Migration The act of changing to a new Location Area in a network (either with different MNC
and/or MCC) where the user does not have subscription (ITSI) for that network.

Mini Base
Transceiver System
(MBTS)

The Mini Base Transceiver System connects to the MSO through an X.21 or fractional
E1 link. Contains up to 4 base radios, TETRA Site Controller, RF Distribution System,
remote GPS receiver and power supply.The MBTS uses a hybrid combiner and is only
available in dual diversity.

MLE See Mobile Link Entity

MLS Motorola Location Server

MMI Man Machine Interface

MMC Microsoft Management Console

MNC See Mobile Network Code

MND Motorola Networks Division

MNR Motorola Network Router

MO Mobile Originated

Mobile Country
Code (MCC)

The Mobile Country Code is as defined in CCITT recommendation X.121 and is normally
the same as used for GSM systems in that country. The MCC and MNC together form
a unique TETRA system identifier that is broadcast by a Dimetra system over the air
interface.
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Mobile Link Entity
(MLE)

TETRA air interface term, see Announced Cell Reselection

Mobile Network
Code (MNC)

The Mobile Network Code should be allocated by the national authority that allocates
frequency assignments in a country and should be requested from that authority at the
same time as frequency allocations are requested. The MCC and MNC together form
a unique TETRA system identifier that is broadcast by a Dimetra system over the air
interface.

Mobile Network
Identity (MNI)

The identity that is broadcast by all TETRA base stations to uniquely identify the network.

Mobile Station (MS) A two-way voice and data communications device used by Dimetra IP system
subscribers. For the Dimetra IP system, the MS stores and utilizes an authentication key
(K) for explicit authentication purposes and a static cipher key- trunked mode operation
key (SCK-TMO) for implicit authentication and air interface encryption purposes.

Mobile Switching
Office (MSO)

MSO is a collection of zone cores that coincides on a physical location and that may
consist of several Local Area Networks (LANs) connecting various servers and clients
into the network and one or more Wide Area Network (WAN) switches providing the
Frame Relay (FR) for the Base Sites and Asynchronous Transfer Mode (ATM) for the
Inter-MSO. An MSO may consist of one or more and up to seven Zone Cores connected
via LANs and WAN links.

MoCa Motorola California

Modulation Types Methods used to modify the radio frequency carrier signal to carry speech and/or data
information over the carrier signal.

MoM See Manager of Managers

Motorola Gold Elite
Gateway (MGEG)

The MGEG is the interface between the IP packet switched transport of a Dimetra IP
System and the circuit switched transport of the Gold Series system and the telephone
interconnect system.

Motorola Telephone
Interconnect
Gateway (MTIG)

The MTIG acts as a gateway in the TI architecture and provides transcoding of voice
between the external PBX and the Dimetra IP network.

Motorola
Transceiver Station
(MTS)

A site connected to a Dimetra master site via a site link. A Dimetra MTS site consists of
1 (MTS1), 2 (MTS2) or 4 (MTS4) base radios and a site controller.
RoHS and WEEE compliant.

MoU Memorandum of Understanding

MR See Managed Resource

MS TETRA Mobile Station (portable and mobile radios). See Mobile Station

MSEL See Multiselect

MSFC Multilayer Switch Feature Card

MSI Microsoft Installer

MSK Minimum Shift Keying. A smooth transition form of PSK.

MSMQ Microsoft Message Queues

MSO See Mobile Switching Office

MSO CSMS A CSMS that operates on MSO level.
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MT Mobile Terminal

MTBF Mean Time Between Failures

MTIG See Motorola Telephone Interconnect Gateway

MTS See Motorola Transceiver Station

MTU Maximum Transmission Unit

MultiCADI Multi CADI provides an expansion of the CADI allowing multiple CADI clients and inter
zone/cluster routing of commands and events.

Multilink Frame
Relay

This feature provides a cost-effective way to increase bandwidth for particular
applications by enabling multiple serial links to be aggregated into a single bundle of
bandwidth. Multilink Frame Relay is supported on User-to-Network Interfaces (UNI)
and Network-to-Network Interfaces (NNI) in Frame Relay networks.

Multizone COAM Multizone COAM is a multiple zone Dimetra IP system that is customer-owned and
operated. The customer has purchased the perimeter protection (NIB) option but is
self-maintaining.

Multicast Traffic IP Multicast traffic is more efficient than normal unicast transmissions because the source
can send a message to many recipients simultaneously. One-to-one communication for
each source destination pair is not required. IP Multicasting allows many recipients to
share the same source. This means that just one set of packets is transmitted to send the
same information to many destinations.

Multicluster System System configuration with up to 16 clusters and a maximum number of 56 zone cores
in total. The clusters are individually configured and managed. Multicluster network
management capabilities also allow integrated configuration and management across
clusters. Through proper configuration, mobile stations can operate and communicate
with other mobile stations in other clusters.

Multigroup A talkgroup composed of other talkgroups.

Multiselect (MSEL) Dispatchers can select several talkgroups at once for dispatching, using a single channel
resource.

Multi-slot Packet
Data Channel

Multi-slot Packet Data Channels (PDCHs) comprise between 2 and 4 timeslots configured
to form a single logical channel. A multi slot PDCH can provide higher data throughput
than a single slot PDCH.

Mute A control signal used by the repeater to quiet audio and break the in-cabinet repeat.

MUX Multiplex/Multiplexer

MZC 5000 Zone Controller equipped with a Netra 240 server.

MZS Multizone System

NACK Negative status acknowledgment

NAM Network Analyser Module which is part of the Ethernet LAN Switch

NAT Network Address Translation

Nationwide See Multicluster System

NBI See North Bound Interface

NE Network Element. See Managed Resource (MR)

NETIP Network IP (IP Network)
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Network
Configuration Tool
(NCT)

An engineering tool for managing and configuring network devices in a Dimetra IP
Compact system. NCT is installed on an NM Client PC

Network
Information Service
(NIS)

A system that allows files such as hosts passwords, and so on, to be updated in only
one place and shared across multiple hosts

Network Interface
Barrier (NIB)

The Network Interface Barrier (NIB) is the barrier between the RNI and the CEN that
makes up the secure boundary and therefore contains the network security functions
such as Firewalls

Network
Management (NM)

Network Management consists of a set of software tools that supports the management of
a complex radio communications system and its component parts, which include radios,
computers, and internetworking components.

Network
Management Client

The Network Management Client is a Windows based PC running the various network
management client applications accessing the network management servers

Network SAP
Address (NSAP
Address)

Addresses that belong to other (non-TETRA) addressing domains. These other domains
include ISDN, PSTN and PDN domains.

Network Time
Protocol (NTP)

A protocol used to provide a time and date reference to all IP connected system elements
(NTP clients) that support the NTP protocol.

Network Time
Server (NTS)

The NTS is a server that acts both as an NTP server and as clock reference for the CNE
equipment.

Network Transport
Management Server
(NTMS)

NTMS provides the backup and restore management for the HP 5308XL LAN switch,
Cisco Catalyst 6509 LAN switch, and the Nortel 7480 WAN switch.

NI Network Interface

NIB See Network Interface Barrier

NIC 1. Network Interface Card (Ethernet Card).
2. Network Interface Controller.

NICE Various equipment used for call logging purposes at a Console Site office.

NIS See Network Information Service

NLB Network Load Balancing

NM See Network Management

NMC Network Management Centre

NMS Network Management System. See Manager of Managers (MoM)

NMT Network Management Terminal

NNM Network Node Manager

Nominal radio
coverage area

The nominal radio coverage area is the geographical area over which the radio
transmission performance exceeds a defined level. Note: The boundary of the nominal
radio coverage area is defined by a Bit Error Ratio (BER) contour as defined in ETS
300 392-2 [17], clause 6.
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North Bound
Interface (NBI)

North Bound Interface (NBI) describes an interface offered by many NMS products, such
as the UEM. NBI allows for NMS features, functions, and data to be accessible for an
OSS (MoM).

NS Network Security

NSC Normal Synchronization Configuration

NSM Juniper NetScreen-Security Manager

NSMS Network Security Management Subsystem

NT 1. New Technologies. A Microsoft Windows® environment
2. Network Termination

NTM Network Transport Management (Replaces TNM)

NTMS See Network Transport Management Server

NTP Network Time Protocol.

NTS See Network Time Server

OAM Operational Administration and Management

Object A term referring to a system resource manipulated through the Dimetra Manager.

On/off hook
signalling

A signalling procedure which includes an alerting process to the called user. The calling
user should wait for an explicit response from the called user that he has answered before
the call can be set-up.

Open Systems
Interconnect (OSI)

The OSI model is an international standard layered reference model that defines a
generalized communication system. It shows how the functions in a communication
system can be divided into seven functional layers

OS Operating System

OSI See Open Systems Interconnect

OSI Model An international standard layered reference model that defines a generalized
communication system. It shows how the functions in a communication system can
be divided into seven functional layers.

OSPF Open Shortest Path First

OSS Operations Support Subsystem. See Manager of Managers (MoM)

OTAK Over-The-Air-Key management

OTEK Over-The-Ethernet-Key management

OTAR Over-The-Air-Rekeying protocol.
Used in connection with Air Interface Encryption

Outbound Function initiated by RCM user and sent from the RCM to a target radio

P-ISSI Permanent ISSI

P25 APCO's Project 25

PA Power Amplifier

PAP Push Access Protocol

PABX Private Automatic Branch Exchange, also called PBX
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Packet Data
Gateway (PDG)

One PDG is made up of one PDR and one RNG. A Packet Data Gateway (PDG) provides
IP connectivity between host applications connected to Dimetra Mobile Stations or
between a host application connected to a Dimetra Mobile Station and a host application
connected through the Dimetra Master Site.

Packet Data Mode
(PDM)

A data mode selected from the radio. It offers the possibility of transferring data in
the packet data format.

Packet Data
Prioritization

Delivers downlink data according to priority set by the end-user application rather than
determined by order of arrival. This allows high priority data to be delivered prior to
any lower priority data in queue.

Packet Data Router
(PDR)

The Packet Data Router is one of the two software packages in the Packet Data Gateway.
The PDR handles the IP functionality. See also RNG. The two software packages, PDR
and RNG, cannot function as stand alone applications, that is both must be in operation
before PDG functionality is available.

Packet Data Service
(PDS)

Packet Data Service is a TETRA bearer service that allows IP hosts to communicate
using the Internet Protocol.

Participating Zone For a particular talkgroup call, is a zone that has talkgroup members A zone ‘participating'
in a particular talkgroup call, but is NOT the Controlling Zone.

Participating Zone
Controller

A Zone Controller that is active in a call or busy but that is not in overall control of the
call.

PatchingTalkgroups By selecting two of more talkgroups, dispatchers can join members of talkgroups for
normal message trunking operations.

Patch Panel Switches all the links on the interface to one of the routers connected to it.

PB (R3.x & R4.0) PathBuilder

PBX Private Branch Exchange

PCI Peripheral Component Interconnect

PCM See Pulse Code Modulation

PD Packet Data

PDCH Packet Data Channel

PDCIA Personal Computer Memory Card International Association:
A standard that defines I/O interface and software specification for 68 pin connector
interface cards (memory, modem, and so on).

PDEG Packet Data Encryption Gateway

PDG See Packet Data Gateway

PDN Packet Data Network

PDR See Packet Data Router

PDR/RNG/SDR -
Active

The device that currently is delivering service (packet data service or short data service)

PDR/RNG/SDR -
Standby

The device that is standby for the active device.that is the standby does not currently
deliver service (packet data service or short data service)

PDS See Packet Data Service

PDU Protocol Data Unit
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PEI Peripheral Equipment Interface

Peripheral Network
Router

The Peripheral Network Routers allow communication between DeMilitarized Zone
(DMZ) subnets.

Performance
Management

Pertains to monitoring, controlling, and optimizing the utilization of system resources.

Performance
Reports

These applications allow you to capture system wide and zone wide activity data.

Permanent Virtual
Circuit

A virtual circuit that is permanently available. The only difference between a PVC and
a switched virtual circuit is that an SVC must be re-established each time data is to be
sent. Once the data has been sent, the SVC disappears. PVCs are more efficient for
connections between hosts that communicate frequently.

PIM-SM Protocol Independent Multicast-Sparse Mode

PIN Personal Identification Number

PKI Public Key Infrastructure

PN Peripheral Network

PN Router Peripheral Network Router

Point-to-MultiPoint
EVC

A layer 2 or layer 3 connection that associates two or more UNIs between one core router
and multiple BTSes over Ethernet GBN. In this deployment multiple IP tunnels are
configured over one EVC.

Point-to-Point EVC A layer 2 or layer 3 connection that associates two UNIs between one core router and one
BTS over Ethernet GBN. Each IP tunnel is configured over dedicated EVC.

Positive subscriber
list

A feature enabling radios to use the system until they are deleted from the database.

PPC See Pre-emptive Priority Call

PPP Point to Point Protocol

PrC See Provisioning Centre

PRC Primary Reference Clock

Pre-emptive Priority
Call (PPC)

The Pre-emptive Priority Call (PPC) feature allows enabled talkgroups, multigroups and
radio users to be given higher priority for the allocation of traffic resources.

Preside Multiservice
Data Manager
(MDM) (R5.0 &
R5.1)

A network management application that manages the WAN switch. Preside MDM resides
on the WAN Switch Management Server (WSMS).

Primary Ethernet
link

IP tunnel encapsulating all Dimetra traffic transported over GBN network and assigned
higher routing metric than the secondary Ethernet link associated with the same
deployment. It may also refer to physical Ethernet link over which the primary IP tunnel
is transported.

Primary Rate ISDN ISDN channels delivered on a 2Mbit/s line.

Primary Talkgroup Talkgroup configured for a radio user determining which RCM(s) should receive the
corresponding radio events.

Private Call An "individual" call between two radios or between a radio and a console operator.
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Private Radio
Network
Managment
Suite Application
Launcher

The Private Radio Network Management Suite Application Launcher is the single entry
to all the management applications on a Dimetra system.

PRNM Private Radio Network Management

PRNMS Application
Launcher

See Private Radio Network Management Suite Application Launcher

PROM Programmable Read Only Memory

Provisioned Data Provisioned Data give users access to data repositories or grant authorization to systems,
networks applications and databases based on a unique user identity

Provisioned Unique
Radio User

A Radio User is considered provisioned unique at the UCS level when its ISSI value falls
into the Individual Subscriber Map range (of the last submitted Home Zone Map) of a
local zone which belongs to a home cluster.

Provisioned Unique
Talkgroup (or
Multigroup)

A Talkgroup (or Multigroup) is considered provisioned unique at the UCS level when
the ID of a Talkgroup or Multigroup falls into a Group Map range (of the last submitted
Home Zone Map) of a local zone which belongs to a home cluster.

Provisioning Centre
(PrC)

The PrC consists of a Client/Server and database application. The PrC SW will generate,
store, and track the delivery of the K and the SCK TMO from the PrC to the MS. The
PrC interfaces with the KVL to transport and confirm delivery of keys to the MS. Once
keys are provisioned, the PrC will provide derived key material through an electronic
file. This file will be written to a CD and be provided to the Dimetra AuC, or other
non-Dimetra network key management application.

PS Presence Server

PSK Phase Shift Keying

PSM Public Safety Microphone

PSTN Public Switched Telephone Network

PSU Power Supply Unit

PTT See Push-to-Talk

PTT message The indication when a call begins informing the dispatcher of the type of call, current
talkgroup or multigroup, and the time of the call request.

Pulse Code
Modulation (PCM)

The type of modulation used over T1 and E1 communication facilities.

Push-to-Talk (PTT) Button on a Mobile Station radio unit that allows the subscriber to transmit.

PVC See Permanent Virtual Circuit

QAM Quadrature Amplitude Modulation

QoS See Quality of Service

QSIG Q-reference point Signalling

Quality of Service
(QoS)

Refers to certain characteristics of a Network Connection (NC) as observed between the
NC end points which are attributable solely to the Network Service (NS) provider.

R-CEN Red CEN (trusted)
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R-ISSI Radio ISSI

Radio A two-way communication device used for voice and data. Referred to as Mobile Station
in the TETRA standard.

Radio activated
deregistration

A radio function to send in a deregistration signal when turning off power or going to
another trunked or conventional personality.

Radio Control
Manager (RCM)

RCM is a software application which runs at the System Manager and is primarily used
by certain Console dispatchers, typically supervisors.

Radio Frequency
(RF)

General term for the range of frequencies used in radio communication systems.

Radio Network
Gateway (RNG)

The Radio Network Gateway is one of the two software packages in the Packet Data
Gateway. The RNG handles the BTS interface. See also PDR. The two software
packages, PDR and RNG, cannot function as stand alone applications, that is both must
be in operation before PDG functionality is available.

Radio Network
Infrastructure
(RNI)

The Radio Network Infrastructure is a term for the Dimetra specific infrastructure, that is
the system excluding the DMZ and the CEN.

Radio Query Tasks A set of dispatcher commands to obtain information on radio users in the Dimetra system.

Radiocheck A Radio Query Task command the dispatcher uses to verify registered radio users.

RADIUS Remote Authentication Dial-in User Service

RAG Resource Allocation Group

RAID See Redundant Array of Independent Disks

RAIM Receiver Autonomous Integrity Monitoring. This feature is provided to handle a specific
GPS satellite which is known to provide a low quality signal.

RAM Random Access Memory

Random Access The method by which a Mobile Station transmits unsolicited requests to the BTS. This
might occur in the case of specific periods where Mobile Stations are permitted to
transmit requests.

Ranking A procedural method of listing cells in descending order from the most suitable for
communication to the least suitable for communication. The method comprises multiple
calculations of C4 parameters and C3 parameters, defined in ETS 300 392-2 [17],
clause 10. As inputs to the ranking procedure are: - outputs from the monitor process
(for example C2 parameters); - outputs from the scanning process (for example C1
parameters); - network parameters received in the MLE broadcast.

RAPI Radio Applications Programming Interface

RAS Remote Access Server

RCM See Radio Control Manager

RDBMS Relational Database Management System

RDP Remote Desktop Protocol.

Recent System User
(RSU)

A radio user recently active on the system receives a higher priority for service requests
before new users who have not been assigned channel resources.

Red Key An encryption key that is not encrypted by another key.
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Redundant Array of
Independent Disks
(RAID))

A technology which is a combination of hardware and software functionality that
improves data availability on drives by using a portion of the array to store redundancy
information.

Redundant
Switchover Module
(RSOM)

The Redundant Switchover Module (RSOM) in a call processing hardware configuration
is the mechanism used to switch manually from the active zone controller to the standby
zone controller (and vice versa) to maximize system availability and to maximize system
performance during hardware or software upgrade procedures.

Registration The act of becoming an active and recognised TETRA user by exchange of ITSI with
the Switching and Management Infrastructure (SwMI).

Relay Panel See Patch Panel

Remote Console A console located off the master site through remote access equipment.

Remote Monitor The instruction sent to a radio that causes the radio to key its transmitter and open its
microphone.

Remote Operator
Console Interface
(ROCI)

An interface board used in a remote operator position to provide connections between
the Console Interface Electronics and telecom lines to a Central Electronics Bank at
another location.

Remote Site See Enhanced Base Transceiver System or Control Site

Requesting Zone The actual Zone the radio is registered with at that moment if it is not the selected home
Zone of the talkgroup

Resource Manager
Essentials (RME)

A suite of Web-based applications that manage the LAN switches and the MSFC router
cards on the LAN switch.

Resources A general term for network infrastructure and radio channels.

RF See Radio Frequency

RF Distribution
System (RFDS)

Remote Base Transceiver System (BTS) site component that combines inputs from the
base radios and combines them to feed one or more antennas.

RFDS See RF Distribution System

RIP Routing Information Protocol

RM 1. Resource Manager
2. Radio Manager

RMC Receiver Multicoupler

RJ45 A serial connector similar to a standard telephone connector, except it houses eight wires
instead of four

RME See Resource Manager Essentials

RNG See Radio Network Gateway

RNI See Radio Network Infrastructure

Roaming The movement of a radio user from one site to another site. The radio registers and
affiliates on each site as the user moves from one coverage area to another.

ROCI See Remote Operator Console Interface

RoHS Reduction of Hazardous Substances
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Router Manager
User Interface (UI)

A configuration management application that enables you to group routers so you can
backup, restore, and reboot more than one router at a time. You can also use Router
Manager to maintain router configuration and software files on the FullVision® server and
view router information, perform tasks, and launch WebLink sessions. Router Manager
UI resides on the FullVision® INM server.

RP Rendezvous Point

RSM Remote Speaker Microphone (for a Mobile Station).

RSOM (R5.0 &
R5.1)

See Redundant Switchover Module

RSSI Radio Signal Strength Indicator

RSS Radio Service Software. See CPS

RSU See Recent System User

RTC Real Time Clock

RTP 1. Real-time Transport Protocol
2. Real Time Processor

RUA Radio User Assignment

RUI Radio User Identity

RUN Radio User Number

Ruthless Pre-
emption

A method of acquiring a channel for an emergency call in a busy condition. A call with a
lower priority is terminated to release a channel for assignment to the emergency call.

RX Receiver

S&F Store and Forward feature

SAC Subscriber Access Control

SAI Session Authentication Information

SACCH Slow Associated Control Channel.

SAS Symantec AntiVirus™ Server. Serial Attached SCSI

SATA Serial ATA

SAV Symantec AntiVirus™ Client

SAVCE Symantec AntiVirus™ Corporate Edition.

SC See Site Controller

SCCH Secondary Control Channel

SCI Serial Communications Interface.

SCK See Static Cipher Key

SCKN Static Cipher Key Number.

SCK-TMO See Static Cipher Key-Trunked Mode Operation Key

SCO See Site Capacity Option
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Screened Network The screened network design is seen as a framework or a template for how to make

RNI provided services available to non RNI users without having the non RNI users
contacting the core of the RNI directly.
The purpose of a screened network is:
1. to protect the feature devices it is hosting
2. to protect the RNI
3. to enable the RNI to manage the feature devices

SD Short Data

SDEG Short Data Encryption Gateway

SDK See Software Development Kit

SDR See Short Data Router

SDS See Short Data Service

SDS - TL Short Data Service Transport Layer

SDTS Short Data Transport Service

Secondary Ethernet
link

IP tunnel encapsulating all Dimetra traffic transported over GBN network and assigned
lower routing metric than the primary Ethernet link associated with the same deployment.
It may also refer to physical Ethernet link over which the secondary IP tunnel is
transported.

SEI Service Endpoint Interface

SEK See Signalling Encryption Key

Secure Database A database in encryption mode which holds all of the encryption keys.

Services The TETRA standard offers a range of services.

Serving cell The cell that is currently providing service to the Mobile Station (MS).

Session Initiation
Protocol

A signalling protocol used by MTIG.

SFS Store and Forward Server

SGSN Serving GPRS Support Node. The PDG acts as SGSN.

Shared TLAN An optional feature in Dimetra that lets seven zones share three HP LAN switches.

Short Data Router
(SDR)

A Short Data Router (SDR) provides TETRA short data services between host
applications connected to Dimetra Mobile Stations or between a host application
connected to a Dimetra Mobile Station and a host application connected through the
Dimetra Master Site. Furthermore the SDR provides TETRA short data services directly
between two Dimetra Mobile Stations or directly between a Dimetra Mobile Station and
a host application connected through the Dimetra Master Site.

Short Data Service
(SDS)

A flexible bearer service that transfers information from one interface to another.

Short Subscriber
Identity (SSI)

The network specific portion of a TSI. An SSI is only unique within one TETRA
subdomain (one TETRA network).
Note: There are four different types of SSI (see subclause 7.2.3):
a) Individual SSI (ISSI);
b) Group SSI (GSSI);
c) Alias SSI (ASSI);
d) Unexchanged SSI (USSI).
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SIB Service Interface Barrier is the barrier between the RNI and the infrastructure of the

service organization.

Signalling
Encryption Key
(SEK)

The SEK is used for encrypting and decrypting KMMs.

Signalling System 7
(SS7)

A signalling protocol used in the Integrated Services Digital Network (ISDN) that
controls how the ISDN network is managed.

SIM Subscriber Identity Module

SIMM Single In-Line Memory Module

Simple Network
Management
Protocol (SNMP)

The Simple Network Management Protocol (SNMP) is a set of protocols used for
managing complex networks. It is an application layer protocol that facilitates the
exchange of management information between network devices. It is also a part of the
Transmission Control Protocol/Internet Protocol (TCP/IP) suite.
A means to monitor and set network configuration and runtime parameters.

SIP See Session Initiation Protocol

Site This normally refers to a remote base station site.

SiteCapacityOption
(SCO)

The Dimetra SCO System is a downsized version of theDimetra IP Multizone system.
The Dimetra SCO System consists of one zone only.

Site Controller (SC) The Site Controller is capable of controlling up to 8 BRs (32 logical channels) and
contains the SRI (Site Reference ISA) time and frequency reference module. The
function of the module is to provide a precise timing reference and a highly stable
frequency reference for the BTS. An optional second Site Controller can be added to an
EBTS, but not to an MBTS, for redundancy.

Site Handover When a roaming Mobile Station in handing over within the same zone or to a new zone.

Site Link Wide area network (WAN) communication link that connects a Dimetra master site to
a remote site.

Site Link
Multiplexer (SLM)
(R3.x & R4.0)

The Site Link Multiplexer combines all the necessary control, management, IP data, and
voice/data traffic into one n * 64 kbit Frame Relay formatted link between the master and
remote sites. This allows efficient use of the links between the remote and master site
which are often expensive leased links. The SLM also ensures system synchronization to
the network, that is the provider of the leased synchronous lines.

Site Registration
and Affiliation

Automatic radio transmission of talkgroup affiliation and radio ID when powering up
or entering a new site. This site registration information enables the Zone Controller to
locate all active radio users and talkgroup members.

Site switch activated
deregistration

When a radio registers on a new site, the Zone Controller deregisters the radio from its
previous trunking site and registers it on the new site.

Site Switch
Deaffiliation

When a radio changes sites and affiliates on the new site, the Zone Controller
automatically deaffiliates the radio from its previous trunking site.

Site trunking mode Local trunking operations after remote site and audio link failures. The site controller
performs all call processing. No communication links exist to other sites.

Site Wide Call
(SWC)

This feature is similar to system wide call in SMARTNET II. A site wide call goes out to
all radio users and talkgroups registered on the sites selected for the call.

SLG Self Learning Group
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SLM (R3.x & R4.0) See Site Link Multiplexer.

SmartCenter Checkpoint's Firewall / Security management console suite.

Smart Phone
Interface (SPI)

One of the telephone interconnect interfaces for the CENTRACOM consoles.

SMS Secure Manager Subsystem

SMSO Shared MSO

SNDCP Sub Network Dependent Convergence Protocol

SNMP See Simple Network Management Protocol.

Software
Development Kit

Also know as API, an interface implemented by a software program which enables it
to interact with other software.

Software Download A SystemManager application that allows remote software upgrades on the EBTS/MBTS.

SONET See Synchronous Optical Network.

Source Site The site where a radio user initiates any of the call types.

SQL Structured Query Language

SPAS System Parent AntiVirus Server

SPI See Smart Phone Interface

SRAM Static Random Access Memory.

SRI Site Reference ISA

SS7 See Signalling System 7

SSC Symantec System Center™

SSI Short Subscriber Identity

SSL Secure Socket Layer

SSS See System Statistics Server

Standard IP Plan Configuration of the system, where zone octet is equal to zone ID for all 56 zones and the
cluster octet is equal to the cluster ID for all 16 clusters.

Static Cipher Key
(SCK)

Key used for encryption between subscribers and BTS base radio.

Static Cipher
Key-Trunked Mode
Operation Key
(SCK-TMO)

A key used to provide over-the-air encryption services for mobile stations operating
in a trunking mode. All MSs and BTS site equipment within the radio system share a
unique SCK-TMO key. A static cipher key is imported or typed into the Authentication
Center (AuC) and is distributed to all base radio controllers using its zone key encryption
key (KEKz).

STM See System Timer Module

Storm Plan An RCM optional function to regroup talkgroups for special situations, such as
disasters or crowd control. The feature allows preset procedures for quick and efficient
manipulation of emergencies and planned events.

Subnetwork A collection of equipment and physical media which forms an autonomous whole and
which can be used to interconnect real systems for purpose of communication.

Subscriber A Mobile Station, with Dimetra software installed.
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Supplementary
service

A service which modifies or supplements a bearer service or a teleservice. A
supplementary service cannot be offered to a customer as a stand alone service. It should
be offered in combination with a bearer service or a teleservice.

SVC Switched Virtual Circuit. See PVC

SWC See Site Wide Call

Switching and
Management
Infrastructure
(SwMI)

The TETRA term for FNE. See FNE

SWDL Software Download feature

SWDLM Software Download Manager

SwMI See Switching and Management Infrastructure

SWTG Site Wide Talkgroup

Symmetricom S200 The SyncServer Network Time Server offering protocols for synchronizing equipment
over a network

Synchronous
Optical Network
(SONET)

A synchronous optical hierarchical time division multiplexing system that operates at
speeds referenced to 51.84 Mbps, commonly referred to as OC1. OCn data speeds are
multiples of the basic data rate transfer of OC1.

System CSMS A CSMS that operates on system level.

System A System is a collection of Clusters where the maximum number of zones in all the
clusters cannot exceed 56.

System ID A unique identification used as a reference for the system licence keys and for CCMS.The
system ID is required when ordering additional licences or upgrading to ensure the
original licence credits are retained. The system ID is not broadcast by the Dimetra
system.This ID should not be confused with the Mobile Network Code (MNC) that is
broadcast by a Dimetra system over the air interface.

System Statistics
Server (SSS)

The SSS is a UNIX based server that provides data storage for statistics data. It allows
for system wide reporting functions to be stored.

System Timer
Module (STM)

This CEB module controls the timing signals for data and audio processing.

T1 Digital carrier facility used for transmission of data through the telephone hierarchy. T1
links are mostly used in the US and Japan. E1 links are used in most other countries.
Both T1 and E1 are composed of DS0s, the basic 64 Kbps path that makes up these links.

Talkgroup A group of radio users that can share calls and messages as a group. Normally a talkgroup
is comprised of users who normally have a need to communicate with each other.

Talkgroup Scan A feature that allows a Mobile Station to scan those talkgroups that have an affiliated
member at the site of the scanning radio. The Talkgroup Scan list(s) must be programmed
in the radio.

Talkgroup site
access

The Zone Manager can limit access by talkgroups to specific sites and the controller
rejects call requests on non-designated sites. Emergency calls can access any site.

Target talkgroup Talkgroup assignment made by a dispatcher for communications between regrouped
radio users.

Task A dynamic function command directing radios and talkgroups to execute an action.
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Task indicator A screen indicator to inform dispatchers that a task requires service.

Task work window An interactive window that allows dispatchers to enter information into the RCM
database.

TCH Traffic Channel

TCP/IP Transmission Control Protocol / Internet Protocol

TDMA See Time Division Multiple Access

TE Terminal Equipment

TEA1/TEA2/TEA3
(R5.2)

TETRA Encryption Algorithms.

TEDS TETRA Enhanced Data Services

TEI TETRA Equipment Identity

TEK See Traffic Encryption Key

Telephone
Interconnect

A call feature that provides subscriber access to the Public Switched Telephone
Network (PSTN). Telephone interconnect can be used for both land-to-mobile calls
and mobile-to-land calls.

Telephone
Interconnect
Gateway (TIG)

Dimetra master site equipment providing a computer telephony-based Telephone
Interconnect Gateway function providing easy adaptation of current and new analogue
and digital line interfaces. The Telephone Interconnect Gateway connects to a PBX
via QSIG.

Teleservice End to end application that allows for example group calls, emergency calls and private
calls.

Telsis An infrastructure and services vendor.

TESS TETRA EBTS Service Software. See EBTS Service Software

TETRA TErrestrial Trunked RAdio. The digital trunked radio standard produced by ETSI
providing detailed telecommunications specifications to which Base Stations and Mobile
Stations should adhere.

TETRA Equipment
Identity (TEI)

An electronic serial number that is permanently embedded in the TETRA equipment. A
TEI is embedded in both Mobile Stations (MSs) (in the MT) and in LSs (in the NT).

TETRA site
controller (TSC)

The TETRA Site Controller is capable of controlling up to 8 BRs (32 logical channels)
and contains the SRI (Site Reference ISA) time and frequency reference module. The
function of the module is to provide a precise timing reference and a highly stable
frequency reference for the BTS. An optional second Site Controller can be added to an
EBTS, but not to an MBTS, for redundancy

TFTP Trivial File Transfer Protocol

TG See Talkgroup

TI See Telephone Interconnect

TIA Telecommunications Industries Association

TIG See Telephone Interconnect Gateway
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Time Division
Multiple Access
(TDMA)

A method that divides a single communications channel into a number of separate
channels by dividing a fixed time period into time slots. Multiplexing scheme used over
T1 and E1 and other transmission media for transferring multiple streams of voice and
data over the same physical transmission medium.

Time slot Element of the TETRA frame structure corresponding to one traffic channel.

TIP TETRA Interoperability Profile

TLAN Transitional Local Area Network.

TM-SCK Trunked Mode Static Cipher Key

TMI TETRA Management Identity

TMO Trunked Mode Operation

TMSS Transmit Mode Selector Switch

TNCT Transport Network Configuration Tool

TNM Transport Network Management, replaced by NTM

TNP1 TETRA Network Protocol 1

TNPS See Transport Network Performance Server (TNPS)

Top of queue A method of acquiring a channel for an emergency call by transmission trunking calls
with the lowest priority. When a call ends, the controller assigns the available channel to
the emergency call.

TPI Talking Party Identification

Traffic Channel Traffic channels are logical channels used to carry user data over the air interface. Traffic
channels may be assigned to carry speech or packet data. Each Base radio in a BTS
supports up to 4 traffic channels.

Traffic Encryption
Key (TEK)

The TEK is also known as a traffic key. An encryption key used for voice and data.

Traffic Packet Term used to describe the voice signal sent between the BTS and a Mobile Station.

Trak 9100 A system providing ultrastable frequency time and reference signals, referenced to the
GPS satellite system.

Transcoder (XCDR)
(R3.x & R4.0)

Dimetra master site equipment that converts audio streams between TETRA ACELP
compressed voice and 64 Kbps PCM voice. Pulse Code Modulation voice is used for the
Dispatch Consoles and the Telephone Interconnect Gateway.

Transmission Delay Transmission of circuit mode voice or data in a digital communications network is subject
to delay. The transmission delay is defined as the time from the voice or data input at the
transmitting end to the time at which the data is received at the receiving end. In the case
of audio, for example, this is the time from microphone input to speaker output.

Transmission
Trunking

Trunking application that requires radios in a talkgroup to return to the control channel
and receive a new channel assignment after each Push-To-Talk (PTT).

Transport Network
Performance Server
(TNPS)

The HP NetServer server where the InfoVista application resides.

Truncate To shorten or cut off. For example, if a voice transmission is truncated, the receiving
radios do not hear part of the message.
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Trunking The automatic and dynamic sharing of a small number of communication channels

between a large number of radio users.

TSC See TETRA Site Controller

TSI TETRA Subscriber Identity

TTR TETRA Association Technical Report

TRS TETRA Requirements Specification

TX Transmitter

TXI Transmit Inhibit

UCL User Configuration of Logging interfaces

UCM 1. See User Configuration Manager
2. Universal Crypto Module

UCS See User Configuration Server.
(R3.x) See User Configuration Subsystem

UCS
Synchronisation
Tool

The User Configuration Server (UCS) Synchronisation Tool provides automated
intercluster configuration of some of the UCS objects that require to be registered in all
clusters in a multicluster system.

UDP User Data Protocol

UEM See Unified Event Manager

UI 1. User Interface.
2. See Router Manager User Interface (UI)

UKEK See Unique Key Encryption Key

Unannounced Cell
Reselection

This type of cell reselection occurs during a call when the Mobile Station (MS) suddenly
loses cell coverage before it has found an alternative cell. The MS has no time to inform
the serving cell that it is about to change cell and so simply scans for an alternative cell,
registers with the new cell, if necessary, and attempts to reconnect the call. This results in
a break in communication which can be several seconds.

UNC Universal Naming Convention (specifies a common syntax to describe the location of a
network resource, such as a shared file).

Undeclared Cell
Reselection

This type of cell reselection occurs when the Mobile Station (MS) is not in a call and is
idle. When an MS then decides that a better cell is available and hence wants to change
cell, it will then switch to the new cell and register itself. The changeover will be very
fast (less than 500 milliseconds) as the MS need not to synchronize or search for any new
cell as this already has been done while still on the ‘old' cell.

Unicast Traffic IP traffic that requires one-to-one communication for each source destination pair. This
means that multiple identical packets must be transmitted to send the same information to
many destinations.

Unified Event
Manager (UEM)

Unified Event Manager (UEM) is an application that provides reliable fault management
services for Dimetra IP Systems.

Unique Key
Encryption Key
(UKEK)

A key used by the key variable loader (KVL) device to communicate with other secure
devices. This UKEK key is used for secure communications between the PrC and KVL.
An encryption key used solely to encrypt traffic keys targeted for an individual secure
entity.
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Uplink The radio frequency communications path from the Mobile Station to the BTS. Also

referred to as the BTS receive path.

UPS Uninterruptable Power Supply. Highly recommended to supplement the standard battery
backup in the fault tolerant Zone Controller and for network management computer
devices.

User There are three types of users in a Dimetra system: individual radio users, console
operators, and network manager users (administrators and maintainers of the system).

User Configuration
Manager (UCM)

The User Configuration Manager (UCM) is a Windows based management application
used to enter and maintain provisioning information and cluster level configuration data
stored in the database on the UCS.

User Configuration
Server (UCS) (R5.x)
onwards

The User Configuration Server holds the database containing provisioning information
and cluster level configuration data.

User Configuration
Subsystem
(UCS)(R3.x)

The User Configuration Subsystem consists of the User Configuration Subsystem
Database Server and the User Configuration Subsystem User Server.

User Configuration
Subsystem Database
Server (R3.x)

The UCS Database Server is part of the User Configuration Subsystem and holds the
database containing provisioning information and cluster level configuration data

User Configuration
Subsystem User
Server (R3.x)

The UCS User Server runs the applications accessing the User Configuration Server

User ID User ID is sent to receiving Mobile Stations (MSs) at start of transmission. Also called
Radio ID

User station
(terminal)

A terminal with a monitor, keyboard, and mouse. Provides a user interface to the Dimetra
applications and database via the Ethernet network

User Network
Interface (UNI)

The physical demarcation point between the responsibility of the Service Provider and
the responsibility of the Subscriber.

User-Based Security
Model (USM)

The security model related to SNMPv3. Security is based on users who are assigned
specific names, credentials, and privileges.

USM See User-Based Security Model

UST See UCS Synchronisation tool

UTC Universal Time Coordinated. Indication of time, that is h:m:s

UTP Unshielded Twisted Pair. Category 5 UTP is used in Dimetra systems for some Ethernet
connections

V+D Voice and data

VDTM Virus Definition Transport Method

VICP Very Intelligent Communications Processor

Virtual Local Area
Network (VLAN)

A technology that allows the formation of Virtual Ethernet segments and subnets
according to business needs, not cabling needs

Virtual Private
Network (VPN)

A private communications network often used within a company, or by several companies
or organizations, to communicate confidentially over a publicly accessible network.
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Visited network A network where a subscriber has an indirect subscription. This means that a valid

subscriber identity is only allocated as part of the first network access.

Visitor Location
Register (VLR)

The entity that is used to manage a local copy of zone specific information for individuals
and Talkgroups. This includes subscriber database information as well as site location
information for both the individual and the Talkgroup. There is a VLR associated with
each zone in the system.

VistaPortal A Web interface provided with InfoVista that is used to view reports from the web.

VLAMS Voice, Location and Messaging Services

VLAN See Virtual Local Area Network.

VLR See Visitor Location Register.

VM Virtual Machine

Voice Channel When a call request is made by Mobile Stations the system will assign a voice channel
for the call. Mobile Stations are informed of the assigned channel and are then permitted
to transmit and receive speech on that channel.

VOIP Voice over IP

VOX Voice Operated Control

VPN See Virtual Private Network

VPN-1 Checkpoint's VPN implementation

VPN-1 PRO Checkpoint's combined VPN-1 and Firewall-1 software.

VRRP Virtual Router Redundancy Protocol.

VU Voice Unit.

WAN See Wide Area Network.

WAN Switch
Management Server
(WSMS) (R5.0 &
R5.1)

The Compact PCI server where the Preside MDM application resides.

WEBLink A Web-based network management application for management of the routers. Router
Manager provides a launch point for WEBLink.

WEEE Waste Electrical and Electronic Equipment

Wide area call A call using a channel resource at all sites in a wide area system.

Wide Area Network
(WAN)

A transport network that delivers communication between two geographically separated
areas.

Windows Terminal
Service

Windows remote desktop.

WS-MSO A WAN Shared MSO is a collection of LS-MSOs of four and up to 7 zones, which are
physically colocated, where the Exit routers from each LS-MSO share one WAN switch
for interzone connectivity.

WSMS (R5.0 &
R5.1)

See WAN Switch Management Server (WSMS).

XEG PDEG, SDEG or MDEG
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Item Description
XCDR (R3.x &
R4.0)

Transcoder, See Transcoder

XML Extensible Markup Language

X-Press Update An update that contains only security content updates (protocol updates, new signatures,
and security content bug fixes).

ZAMBI 1. See Zone Ambassador Interface Board
2. Zone Controller Ambassador Multiplex Interface

ZC See Zone Controller

ZCM See Zone Configuration Manager

ZDS See Zone Database Server

Zeroize To erase information, specifically, to write 0s to memory.

ZLM See Zone Link Multiplexer

ZM See Zone Manager

ZMS See Zone Manager Subsystem

Zone 1) A geographical region covered by a Dimetra system. The zone design comprises sites
to allow intrazone communications and roaming between sites/subsystems within a zone.
2) The equipment (Network Management, Data Management, Networking,
Switching, Infrastructure, that is SwMi) that forms the central part of a Dimetra radio
communications system with interfaces to air, telephone and other zones/radio systems.

Zone Ambassador
Interface Board
(ZAMBI)

Interfaces Embassy Switch with Zone Controller. A Board that acts as an interface
between the Ambassador Electronics Bank (AEB) and the Zone Controller.

Zone Chooser The Zone Manager window through which all Dimetra applications are opened.

Zone Configuration
Manager

A Motorola software application that is used to configure zone parameters.

Zone Controller
(ZC)

Dimetra master site equipment providing very fast call control for group communication
in a wide area network. The Zone Controller supports Status.

Zone Core Zone Core is a one ZC system, which is the central point for all the equipment necessary
to control and manage the sites in a zone. BTS and control site equipment are not part of
the zone core.

Zone Database
Server (ZDS)

The Zone Database Server holds the database containing zone level configuration data.

Zone Level
Trunking

Trunking operation is limited to the coverage area of one single Dimetra system.

Zone Link
Multiplexer (R4.0)

Zone SLM. The ZLM ensures interzone connectivity. The ZLM is based upon the Zhone
(Premisys) IMACS platform.

Zone Manager (ZM) A network management product allowing configuration of the Dimetra system and
system management activities. The Zone Manager interfaces the Zone Controller for
software functions and database access.

Zone Manager
Subsystem (R3.x)

The Zone Manager Subsystem consists of the Zone Database Server and one or more
Zone User Server(s).
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Item Description
Zone Master Site A Master Site containing a set of zone control equipment (for example Zone Controller,

AEB, and so on) comprising a single zone.

Zone Statistics
Server (ZSS)

The ZSS is a UNIX based server that provides data storage for statistics data. Each zone
contains one ZSS for statistics that should be stored locally.

Zone User Server
(R3.x)

The Zone User Server runs the applications accessing the Zone Database Server.

ZoneWatch A Motorola software application that allows system managers to monitor activity within
a zone.

ZSS See Zone Statistics Server
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Active document or file— The document in which you are working.

ADD— Audio Device Descriptors. A structure which provides hardware information about a particular audio
accessory (for both IMPRESS and core accessories). Files with ADD have an extension .add.

AIE— Air Interface Encryption provides confidentiality on the radio link over the air.

APAC — Asia Pacific region.

ASSI — Alias Short Subscriber Identity.

Audio Profile— represents radios audio characteristics that fit to a specific operating environment, for example
Indoor for an office or Outdoor for high traffic noise. It is not recommended to edit it.

Audio Template— a baseline file for creating audio profiles. Audio experts prepare and modify audio templates.

BUP — Backup.

Calibration values— a set of important and unique, factory-defined values (such as frequency tuning) assigned
to radios. Also known as Sensitive data.

Call— There are two types of calls: individual call or group call. An individual call is a complete sequence of
related call transactions between two radios in DMO. There are always two participants in an individual call. A group
call is a complete sequence of related call transactions involving two or more DM-MSs. The number of participants
in a group call is not fixed, but it is at least two. Participants may join (late entry) and leave an on-going group call.

CCK— Common Cipher Key. The infrastructure generates this key to protect a group address signaling and traffic.
Also used to protect SSI identities (ESI).

Class — Also called the security class.

Class 1— no encryption, may use authentication.

Class 2— SCK encryption, ESI with SCK, may use authentication.

Class 3— DCK encryption, ESI with CCK, authentication.

Clear— An application without encryption support.

CP— Codeplug. Repository of personality data for a radio. It includes features (also the selling features) and
adjustable parameters.

Compatibility field— Codeplug fields that include identity information such as Model Type, Codeplug Structure
Version, and Codeplug Default Version.

CPS— Customer Programming Software used to program Tetra radios.

CPV— Codeplug Value, clear-text file format that contains codeplug paths and values in lines; <fullpath,
value>. It is not recommended to export and import CPV files, unless you have a thorough knowledge about
the codeplug structure.

DCE — Data Communication Equipment.

DCK— Derived Cipher Key generated during authentication for protection of individually addressed signaling
and traffic.

DCK — Digital Car Kit

DGNA— Dynamic Group Number Assignment allows a network operator or an authorized user to dynamically
allocate talkgroups to selected radios over the air interface. Using supplementary services messages (SS-DGNA) the
network operator can command the radio to add talkgroups to the radios talkgroup list, to attach or select these
talkgroups, to delete talkgroups from the list, or modify parameters of existing talkgroups. A special feature
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of the radio, if provisioned, causes a new group that is assigned by the SwMI to be automatically attached as
the selected group, whether an attachment was received with the assignment. In order for an MS to be allowed
to participate in communication of a given group, the MS must request and receive permission from the SwMI.
This is called group attachment.

DMO — Direct Mode Operation a mode of simplex operation where radios may communicate using radio
frequencies that may be monitored by, but which are outside the control of, the TETRA V+D network. DM is
performed without the intervention of a base.

DMO Gateway—Direct Mode Operation Gateway: A device that provides gateway connectivity between DM-MS
and the TETRA V+D network. The gateway provides the interface between the TETRA DMO and TETRA V+D
modes. A gateway may provide only the gateway function (DM-GATE) or may provide the functions of both a DM
repeater and a DM gateway during a call (DM-REP/GATE).

Dongle— USB stick with licenses for radio features.

Downgrade— to replace radio firmware with an older version and preserve User and Sensitive Data..

DTE — Data Radio Equipment.

DTMF— Dual Tone Multi-Frequency. Tone-based signaling scheme which combines two of a set of standard
frequencies. The result is a third or beat frequency (signal) which is the desired or usable signal. DTMF signaling is
used as tone-dialing in the common telephone.

EMEA— Europe, the Middle East and Africa regions.

Encryption— Secure communications systems are designed to provide coded (“encrypted ”) signals between
some or all links in the system. In order to do this, each device involved in secure communications is loaded
with a multi-digit encryption variable (called a key). This key is used by an encryption algorithm built into the
device to encrypt voice or data as needed. Only devices in the system with the same algorithm and encryption key
can decode the encrypted signals.

ESI — Encrypted Short Identity.

ESSC — EMEA System Support Center

Firmware— computer instructions that reside as read-only software on a radio's flash memory.

Flash— a storage chip integrated in to radio hardware, that can be erased and reprogrammed.

Flashing—Writing a software image file to a radio.

Fly-out GUI element or menu— a popup menu that extends from other visual element. In CPS Plus, it is a
right-side bar that can auto hide or 'fly out' to display connected radios.

GCK— Group Cipher Key. Predetermined cipher key used to provide confidentiality in Class 3 system with
corresponding algorithm.

GCK KAR— Group Cipher Key Key Association Range

GPIO— General Programmable Input Output pins.

Group Call— an instant communication between users that belong to the same talkgroup.

GSSI — Group Short Subscriber Identity.

Home Location Address—Area within radio coverage of a base station or group of base stations within which a
radio is allowed to operate.

Hotfix— a special purpose file, used by service or support teams, that allows to apply a set of predefined settings
to codeplugs. Hotfixes are similar to profiles but allow to modify not only user data but also calibration values,
which are not available to a regular CPS Plus user.

ISSI — Individual Short Subscriber Identity.

ITSI— Individual TETRA Subscriber Identity.
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Key— Each device involved in secure communications is loaded with a multi-digit encryption variable — an
encryption key. An encryption algorithm built into the device uses this key to encrypt voice or data as needed. Only
devices in the system with the same algorithm and encryption key can decode the encrypted signals.

LIP — Location Information Protocol.

Local Site Trunking— allows radio subscribers of the same cell site to communicate when the link between the
site and network central controller fails. Entering and exiting Local Site Trunking (that is, returning to Site Wide
Trunking) is done automatically — the display shows the “Local Area Service” message Any call in progress is
dropped upon entering Local Site Trunking mode. Registration, Group Call, and Emergency Call are available
in Local Site Trunking.

LRPP— Location Request/Response Protocol. This protocol allows for a single and efficient format of passing
location information (requests and responses).

MACE— Motorola Advanced Crypto Engine

MCCH—Main Control Channel. The principal common control channel transmitted by the infrastructure to
control the radios in a cell.

MLE — Mobile Link Entity.

MMI—Man Machine Interface, relates to the CPS Plus and radios user interface.

NGCH — Next Generation Control Head.

OTAK — Over the Air Keying.

OTAR — Over the Air Rekeying.

PABX— Private Automatic Branch Exchange, allows to call local (office) extension numbers.

PABX Gateway— A device that provides connectivity from a TETRA user to a PABX subscriber and the other
way around.

PDV2— Permanent Disable Version 2; you can restore a disabled radio using CPS Plus.

PEI — Peripheral Equipment Interface.

PHF— Personal Hands-Free kit, in other words an earpiece or a handset.

Private Call— call between two and only individuals. Apart from the two interlocutors, no one else can participate
or listen to the call.

Private Duplex Call— a private call between two radios that resembles a telephone conversation. The two
individuals can talk and listen at the same time without pressing PTT.

Private Number — also called Private ID.

PSTN— Public Switched Telephone Network.

PSTN Gateway— a device that provides connectivity from a TETRA user to a PSTN subscriber and the other way
around. Additionally, for the duration of the call, the PSTN gateway allows TETRA signaling information to be
passed from TETRA Switching and Management Infrastructure to the external network user and from the external
network user to the TETRA SwMI in accordance with the TETRA Call Control (CC) procedures.

PTPC— Point-to-Point Call also known as Private Call.

PTT Button— Push To Talk button that initiates a group call.

RCU—Remote Control Unit, a small device attached to a covert radio over a thin wire, used for operating the radio.

Remote flashing— programming the transceiver via the control head.

RSM — Remote Speaker Microphone.

RSSI — Receiver Signal Strength Indication.
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RUA — Radio User Assignment.

RUI — Radio User Identity.

SCK— Static Cipher Key, used to provide confidentiality in Class 2 system with corresponding algorithm.

SDS — Short Data Services.

SDMO KAG— Secure Direct Mode Operation Key Association Group.

Selling Feature— requires a USB dongle with purchased licenses.

Semi-Duplex Private Call— Also called Private Call or Express Connect Call. In this type of one-way call, the
user presses and holds the PTT while talking, and releases the PTT while listening.

Sensitive data— a set of important and unique, factory-defined values (such as frequency tuning) assigned to radios.

SIM— Subscriber Identity Module a smart card that holds subscriber information (including the authentication key)
and is inserted into the radio to grant its personality.

Software image— a collection of files distinguished by individual releases. It contains firmware, codeplug, and
audio template files dedicated to specific radio models.

Status ID—A feature that makes it possible for a subscriber to send status messages to other subscribers. The user
can enter a status message for each ID in a Status ID list. When a subscriber sends a status message, the ID of the
subscriber’s unit is sent along with the status message.

SwMI— Switching and Management Infrastructure. The TETRA term for Fixed Network Equipment (FNE). It
consists of the system components, that is, the Central Network Equipment located at the Master Site (or Mobile
switching Office) and all the remote site equipment, but excludes the mobile equipment.

TEI— TETRA Equipment Identity, an electronic serial number that is permanently embedded in the TETRA
equipment.

Talkgroup— A group of subscribers enabled to initiate and participate in a Group Call.

Telephone Interconnect— also knows as Phone Call.

TETRA— TErrestrial Trunked Radio. The digital trunked radio standard produced by ETSI providing detailed
telecommunications specifications to which Base Stations and Mobile Stations should adhere.

TMO — Trunking Mode Operation.

Trunked— Trunked Radio Communications - A computer controlled communications system that allocates speech
channels on demand selecting on a random basis from the group of channels available.

Upgrade— to replace radio firmware with a newer version and preserve User and Sensitive Data.

User Data— a set of codeplug nodes and values, that can be edited and replicated to other codeplugs or radios.

VASSI— Visitor Alias Short Subscriber Identity.
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